


Pricing towards perfection

■■ editorial

Every new computer owner is confronted with a familiar problem.
Where do I get the software that puts the hardware to work? The choice
usually lies between purchasing the licensed version of, say, Adobe's
Publishing collection for a whopping amount from an official vendor, or just
asking your friendly neighbourhood computer-walla to give you a copy for 
Rs 200. The price we Indians pay for software has always been a touchy topic.
Computer users could actually end up paying more for the software than for
the entire PC itself if they were to buy licensed copies of each piece of
software. Requesting someone else to make a copy is clearly the easier and
more frequently exercised option. 

Unlike hardware, games and even music CDs, which have become
considerably cheaper over the years, software seems only to have grown more
expensive. The latest version of Microsoft Office, for instance, costs a lot more
than its predecessor. But most software vendors claim that the pricing for their
software is fair and complain about the enormous loss of revenue they suffer
due to piracy. While software companies look for ways to protect their
software from being copied, they need to be aware that as long as prices are
beyond the reach of the average computer user, piracy will continue to exist. 

Major software vendors such as Microsoft and Adobe need to find a way
to make software more affordable. One approach that might work in the
Indian market—both for them and for computer users—is to make an older or
basic version of the software available at a lower price for individuals. Most of
us don't utilise a large number of the features that software such as Microsoft
Office XP offers and can easily make do with the features available in
Microsoft Office 2000. If this were made available at a lower price, more
consumers would consider paying for licensed software. 

However, most software vendors are sceptical about adopting this kind of
a strategy because it is at odds with the industry's philosophy of charging a
premium for every version update.

But without a change in approach, most professional application software
will remain exorbitantly priced. Continuing to adopt this kind of short-
sighted strategy will restrict the use of licensed software to a few commercial
organisations and the majority of users will continue to look towards pirated
copies as a solution.

karan_manral@jasubhai.com

“As long as most
of the popular
application
software packages
are priced way
beyond the reach
of the average
computer user,
piracy will
continue to pose
a problem”

Karan Manral
Assistant Editor
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Man is the only crea-
ture that
blushes,

or needs to, said
Mark Twain. If
blushing can be
taken as an
index of lying,
then liars are
in trouble
indeed.
Researchers at
Mayo clinic in
Minnesota in the
US have developed
a high-definition ther-
mal imaging camera which
scans the face of the person
who’s being interrogated. 

It has been proved that
when people lie, blood tends
to rush to the eye area. This
movement is caught by the
camera and often proves deci-
sive in nabbing criminals at
check-in counters at airports,
in courtrooms, and so on. 

The test results are pretty
impressive—up to 75 per
cent of the guilty people
were caught red-handed.
This camera is much more
faster and easier to use than
other methods like Poly-
graph tests which are used
nowadays. How will the liars
(and criminals) avoid this
one?

pulse ■
■ news

HomeStation
■ What is it?
HomeStation is a multifunc-
tion consumer appliance
rumoured to be from
Microsoft. It is believed to be
based on the Xbox design.
Microsoft is yet to confirm
this.

■ What does it offer?
This home device is said to
handle almost everything
that a typical PC user needs.
It will have features such as  
e-mail and Web browsing
capabilities. HomeStation
boasts of digital video record-
ing, DVD capability, etc.

■ When will it see the
light of day?
Rumour has it that HomeSta-
tion will hit the market by
the middle of 2002.

Blush and you’re caught!

hypethesis

■ Intel names Paul Otellini as president & COO ■ Experts predict mass-mailing viruses in 2002 ■ KaZaA suspends downloads pending Dutch court ruling 

snapshot

Source: www.cyberatlas.com

Apple recently unveiled their
latest flat-panel equipped

iMac desktops. The Power-
Macs had already made

the move to LCD dis-
plays earlier in 2001.

From Apple’s perspec-
tive this marks the
death of the CRT 

display.
The new iMac

will be offered in
700 MHz and 800 MHz Pow-
erPC G4 processor based ver-
sions. All the new variants

have 32 MB nVidia GeForce2
MX graphics cards, five USB
ports and a couple of
FireWire ports. The drives on
these are either a DVD-
recorder, a combo CD-
RW/DVD-player, or a regular
CD-RW drive. The top end
version is really impressive,
with an 800 MHz G4 proces-
sor, 256 MB of RAM, a 60 GB
hard drive and a DVD-
recording drive. 

Looks like innovation still
lives at Apple.

iMacs go flat

Distributed
computing
fights anthrax
Does your PC have spare
processing power? If so,
donate some of it for an
anthrax cure. 

That’s what Intel and
Microsoft’s new distributed
computing initiative is all
about. It will help British
researchers analyse 3.5 bil-
lion molecules for a cure to
protect anthrax patients
from late-stage toxins.
Antibiotics have no effect
against these toxins.  

Distributed computing
uses a worldwide volunteer
network of computers to do
work that would otherwise
require supercomputers. The
user downloads a program,
which allots unused process-
ing power for data crunch-
ing. Results are then sent to
the project sponsor. 

ILLUSTRATIONS: Mahesh Benkar

➜
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If you think all that music
you’ve been download-
ing from the Web is

absolutely free with no
strings attached,
think again! It
has been discov-
ered that things
are not so hunky-
dory with file
sharing pro-
grams. These file-sharing
programs open your PC to
anyone on the Net, specially
making it vulnerable due to
the spyware used in them. 

Experts have found that
popular
fire shar-
ing pro-
grams

such as Limewire and
Grokster carry spyware.
Spyware in advertising soft-
ware such as ‘Clicktilluwin’

has programs such as
W32.DIDer, which is classi-
fied by Symantec as a
Trojan horse. Trojan horses

allow other people
to take over your
PC and do whatever
they want to. There
are reports of simi-
lar problems with
the KaZaA Media

Desktop as well. 
Limewire and Grokster

have removed or provided
fixes to remove the pro-
grams. But it remains to be
seen as to what they will
come up with next to get
hold of your PC again. As
for now, trust a good anti
virus program to protect
you while using all these
file-sharing programs. After
all, there’s no such thing as
a free lunch, right?

Suffer this 
Trojan
This Trojan’s sure going to
make you suffer if you get it.
If you run this Trojan, it dis-
plays a black box with the
word ‘suffer...’ flashing in it.
Each time it flashes, your
PC’s CD-ROM drive will open
and close. Placing the mouse
pointer over the window
gives a message saying,
‘you've been caught slippin’.
It also swaps mouse buttons,
changes your PC’s name to a
rude one, disables the [Ctrl]
+ [Alt] + [Del] combination,
etc. The Trojan degrades sys-
tem performance. And you
will most probably require a
cold reboot, since the system
will stop responding. 

Trojan Tux
RST.b is a remote shell Trojan
(RST) which attacks Linux
machines. This is a variant of
the RST Trojan, discovered
last September. 

RST.b creates a backdoor
on the computers it infects.
Remote attackers can get full
control of the computer
through this backdoor. It
also connects to the remote
server and tries to retrieve a
fil located there. This file has
the message, ‘This account
has been terminated for virus
abuse. We are a free Web
hosting company and any-
one may post or create PHP
files. This machine has NOT
been compromised.’

The Trojan’s code con-
tains self-replicating capabili-
ties. This allows the Trojan to
replicate itself to other bina-
ry files on the PC like a virus.
However, there is lesser risk
than on other OSs since
Linux has defined access
privileges for each user and it
can only infect that particu-
lar user’s access areas.

redalert

■ eBay raises auction fees ■ India next big market: Qualcomm chief ■ Botched update puts Windows XP updates on hold ■ USB 2 arrives in Linux 

Backdoor man

Do robots really need
computers inside
them? Mark Tilden of

Los Alamos says no. He has
just created a bunch of brainy
‘bugs’ which are controlled by
a combination of transistors.
By changing the transistor
combinations, the
behaviour of the bugs
can be changed as
the user wants it to
behave. 

The speciality of
Tilden’s bugs is that
they can be trained.
A technique called
biomorphic robotics is
used inside the bugs,
making them interact
and learn with the
environment they are in. 

The toy giant Hasbro
attracted by this feature,
developed a toy
line called
B.I.O.-

Bugs, which is inspired by
Tilden’s work. The USP
behind this range of toys is
that kids can actually inter-
act with them. The bugs can
interact with each other too,

and what’s more, if a kid
gets bored with the

robots’ behaviour,
all he or she needs
to do is change
the combina-
tions to make
the bug behave
in the desired
manner. 

If you think
this is neat, just

wait till Tilden
comes out with his

line of robotic vacuum 
cleaners! 

A bug’s life?

Science has always sought
inspiration from the mas-
ter of design—nature.

The University of Colorado is
also taking the same route in
an attempt to develop teams
of ‘sniffer’ robots to sniff out
mines. Lobsters have  an
exceptional ability to analyse
odours.

The research is aimed at
developing a team of sniffer
robots to be used on land and
sea to detect mines. These
robots will have artificial
snouts based on the lobster’s
skills. Odours are carried
downstream or along the wind
by chemical plumes. Lobsters
are wizards at tracing these
plumes to the source, even in
troubled waters. 

Mass produced mines leak
TNT. This leakage can be used
to trace the mines. 

A lobster’s
sniff 

➜
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“Approaching
unknown terri-
tory. Switch on

universal translators.” No,
this is not a message from
Star Trek. If the UT-103
(Universal
Translator)

delivers what it promises,
this just might be reality—
sooner than you expected it
to be!  

Ectaco, a leading compa-
ny which specialises in
translation devices, is
behind the Universal
Translator. This 2.5-inch by
4.4-inch handheld can

take phrases in English
and convert it into

French, German or Span-
ish as the user wants. All
that the user has do is to
first select one from the

14 available categories of
speech. Categories available
are everyday conversation,
travel, local transportation,

health, sports, etc. UT-103
uses these categories to pro-
vide the appropriate transla-
tion of a phrase. It will then
display the English phrases
you give it and its transla-
tions on an LCD screen. In
case the translations are
somewhat confusing or
seem wrong, the user just
needs to change the catego-
ry of speech to another sim-
ilar category. Ectaco typical-
ly recognises 9 out of 10
phrases. Not bad, huh?

It has a Toshiba 75 MHz
processor with 36 hours of
operation on two AA batter-
ies. Is this the way we will
communicate with ETs?

Cyber yogi
I want to do yoga, but where
is the class—or the time? If
you face similar problems, it’s
time you utilised the Inter-
net. It’s quite possible to
practice yoga with your guru
who’s in New York and the
rest of your class scattered all
over the world. Video and
audio are streamed live from
the classes right to your
computer. You need to have
a high-speed connection like
cable or DSL though.

New York Yoga from Man-
hattan is offering this service;
the first and only live online
yoga class according to them.
You need to shell out approxi-
mately Rs 300 for getting the
service. Meditative?
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A universal translator

heroes
GPRS
■ BPL launches its GPRS
service in Mumbai. The first
Indian GPRS network to
allow wireless Net access.
GTA III 
■ The very popular and
much hated Grand Theft
Auto III game available only
for PlayStation 2 is getting
the PC flavour finally in April.
VIA 
■ Intel wins court case filed
against it. Expect DDR-based
motherboard chipsets for

Pentium 4.

Jeff Mallett
■ President and Chief
Operating Officer, Yahoo!
has announced plans to
resign.
Pen-tablet PCs
■ Sony seems to have
finally given up on these
miniatures.

zeroes

➜

test version ■ The Net's new domain: your .name ■ Beijing clamps down on Internet use ■ CD creator burns copy-protection efforts ■ VCR sales Fall, DVDs
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Almost everyone’s been
talking of the day
when cars can hook

up to the Net, the day when
we can check our e-mail or
chat seated inside a car. That
day is coming closer. A com-
pany called
MobileAria has

installed a computer and an
Internet connection in a car
with a voice-powered soft-

ware that provides hands-
free computing. You’ll need
a laptop, a microphone,
speakers, GPS, and a Blue-
tooth-enabled phone. All
that you need to use then
are voice commands and a
small thumb controller con-
nected to the steering. 

MobileAria
plans to make
this service
available
throughout
the US by
partnering
with Cingular
wireless and
Verizon some-
where in the
first quarter of

2002. Mobile Internet is
poised to take on a whole
new meaning.

Wired cars
Imagine a cell phone
which you can throw away
when the card runs out.
This is not a new concept.
The difference is that this
phone uses your local
phone line’s number for
making and receiving
calls. It can be recycled
when you are done with
the air time—another big
difference from other dis-
posables. Club in a ‘travel
fun kit’ with the phone
and a disposable camera
and you have the perfect
mobile phone recipe called
‘Cyclone’.  

Develped by a Florida-
based start-up called New
Horizons Technology and
launched in the US, this
phone will give 60 min-
utes of nationwide airtime

to US citizens. Users can
either buy airtime or
return the phone for recy-
cling to get a rebate. 

The best part of the
phone is that there are no
roaming or long distance
charges. Indians will surely
love to see the end of
Orange and BPL’s exorbi-
tant “roaming”
charges! 

Combined
with the
eco-
friend-
ly disposable
nature of the
phone, this is
a gadget all
environment
lovers will defi-
nitely place their
bet on. 

Disposable technology gets hot

Source: www.cyberatlas.com

PDA owners usually keep matters
close to their hearts.
This may be true

in more ways than one.
Palm owners can actual-
ly  monitor the health of
their heart using
ActiveECG.

ActiveECG from Active
Corporation is a Palm-
controlled heart-mon-
itoring device. It can
be connected to a Palm
PDA through a serial cable. 

The device is capable of
recording, displaying and review-
ing ECG signals. These readings
can be used to analyse the
heart’s condition, either by the
patient himself or by a doctor. The patient

can even e-mail record-
ed data to a doctor
for analysis. 

The small device
has features for
monitoring pace-
makers. This will be

of great use to
patients who have pacemakers

on them. Doctors will be able
to accurately track each and
every beat of the heart.

It costs $500 and can be
ordered from the company’s
Web site www.activecompany.com. 

A version for Windows
PCs is also in the offing.
Whosoever thinks PDAs

are playthings needs to
take a serious look at this.

PDA—Portable Diagnostic
Assistant?

Hic! One more beer
This is one watch that all party
hoppers are going to love. Its
speciality lies in guiding the
wearer to the nearest pub. 
Geeks at Bristol University are
the ones who are working on
this pub finder. It is basically a
wearable computer which
guides the user to the nearest
pub using global positioning. It
even provides a description of
the pub. If you don’t like it, you
can always get the watch to
guide you to another one! 
Pub hopping is sure going
places, isn’t it?

surge in 2001 ■ MS credits XP, Xbox for record sales ■ U.K. considers opt-in cookie rule ■ Macromedia updates Director 8.5, Shockwave ■ Studios nearing 

➜
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Blowin’ with
the teens
MTV’s focus goes where the
teen winds blow. The music
channel is planning to capi-
talise on the teenage fascina-
tion with music and com-
puters by launching two
products—an MP3 player
which can hold up to 11
hours of music and a PC
packed with all the goodies
that teenagers could possibly
need. The MP3 player, which
can also record and store
music, is developed by MTV
with DataPlay. It makes use
of a new kind of disc drive
developed by DataPlay—it
can hold up to 500 MB of
music.

MTV’s teen PC is on a
grander scale though. The
Athlon-powered PC will
have a flat-panel display,
boast ‘essential’ tools such
as CD-RW and DVD burners,
and will come with a built-
in radio, TV tuners, etc.
MTV plans to position it in
the $1,800 segment, which
is comparable to an AMD-
powered high-end PC from
Compaq. No teenybopper
tune this.

The recording industry wants
you to stop sharing music so
badly, that it hopes to physi-
cally prevent computer users
from ripping audio CDs. A
new breed of CDs has dawned,
making them impossible to be
read by PC-based CD drives. 

This new controversial
technology introduces small,
physically minute errors in
CDs. Though such errors can
be corrected and compensat-

ed for in conventional CD
players, unforgiving PC drives
will have problems reading
the media. Because of the
sheer variety of installed CD
players around the world,
incompatibility issues are
already cropping up.

Natalie Imbruglia’s ‘White
Lilies Island’ is already facing
a number of returns on the
grounds of CD players not
being able to read it. 

Philips, the co-creator of
the CD is refusing to play
along. The company has
advised record labels to
inform consumers that copy-
protected CDs are in fact, not
CDs at all and to issue suit-
able warnings. Since Philips
owns the CD trademark,
music labels would be barred
from stamping the logo on
each protected CD they
make.

anti-copying tech for TV ■ Netscape sues Microsoft ■ Faster mobile chips from ■ Intel, Duron from AMD ■ Demand for H-1B visas rises in 2001 

How many people have had
enough of GeForce3? Well,
just in case you happen to be
one of those ambitious folks,
nVidia is announcing its lat-
est graphics chip on February
5, 2002—the GeForce4. 

The GPU (Graphics Pro-
cessing Unit) code-named
NV25 is closer to the proces-
sor that nVidia made for use
in the Microsoft Xbox. 

A desktop version of the
chip, code-named NV17,

which was available only in
the mobile version earlier,
will also accompany the
NV25. It sure is something to
look forward to.

It is rumoured that the
NV25 was originally sched-
uled to be out at the Con-
sumer Electronics Show
(CES) at Las Vegas in January,
2002. But nVidia apparently
could not make it on sched-
ule and pushed the date to
February. Not surprising,

considering that nVidia aims
at making the GF4 a lot more

powerful than the GF3.
It is said to have six
pixel lines as compared
to GF3’s four pipelines.
Other goodies available
in the NV25 are higher
clock speeds, faster
memory interfaces and
improved antialiasing
capabilities. So still in
love your GeForce3? A
pity that you have to

upgrade it even before you
could get to use it fully!

The fourth force
tomorrow’stechnology

If SMS has given you
sprained fingers, don’t
worry. A new fabric key-

board will help you out. This
lightweight keyboard can be
folded or stuffed into a pock-
et like a handkerchief, crum-
pled and, guess what, even
washed like a fabric. 

UK-based ElekSen is the
company behind these fabric
keyboards which are meant
for use with mobile devices
such as handhelds and cell

phones. A fabric keyboard
designed specifically for
PDAs is about to be
launched in spring
2002. Plans are also afoot
to release a lightweight
mobile handset. 

Bendable screens and key-
boards are not a new con-
cept, especially for mobile
devices. Royal Philips Elec-
tronics is working on an
‘electronic paper’ for mobile
phones and PDAs. This 

rollable
paper uses flexi-
ble energy-efficient
polymer-based electronics. 

Experts say these devices
will be mass-produced in as
soon as five years.

FFaabbrriicc  kkeeyybbooaarrddss

Philips refuses to play along

➜
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Fantasising about Segway’s
self-balancing
scooter, Ginger,
that we covered
in the January
issue? It is not so
smooth sailing
for Ginger aka
‘Segway Human
Transporter’. The
speed breaker in
Ginger’s path
comes from
Japan. 

Kazuo Yamafuji, a robotics
professor from
Tokyo’s University
of Telecommuni-
cations claims
that he developed
an almost identi-
cal machine 15
years ago. He even
got a patent for it
in 1996. It may
not be a major
problem for Dean
Kamen to sell the

scooter, but he may have
problems selling it in Japan.
That’s missing out on a very
lucrative market for Segway. 

Yamaguchi claims that
the basic principles in his
‘parallel bicycle’ and Segway
are the same. Both use a
microprocessor to detect
minute shifts in balance. This
keeps the scooter upright on
two wheels. He also holds a
patent for a similar four-
wheeled version.

That innocent looking Windows
Media Player (WMP) on your
PC might be allowing Web sites
to keep track of your habits.
The bug preys on users of Inter-
net Explorer 6 and older ver-
sions of Netscape that use the
WMP plug in. Web site operators
can actually pull off a default
serial number generated by
WMP using a client-ID request.
This serial number remains the
same for every browser session
that you have. It can be sent
back to the site to track your
habits. All this can done using a
simple block of code from the
Web site operator’s end. Termed
‘SuperCookie’ by security
experts, it can be disabled by
turning off Javascript or by
removing WMP. An updated
WMP has also been launched by
Microsoft, which allows this fea-
ture to be turned off.

BUGGEDPLAYERS

AOL, the media giant, is plan-
ning to acquire Red Hat Inc,
the distributor of the popular
Linux OS. With a mighty 
33 million Internet subscriber
base, AOL is planning to
package its AOL Internet soft-
ware with Red Hat’s operating
system to fight against the
Redmond Giant. 

With the acquisition of
Red Hat, AOL plans to make
disruptive inroads into the

Microsoft OS business. AOL
has been counteracting
Microsoft’s plans in many
ways including enhancing
their Netscape browser to
fight MS’s Internet Explorer.
Netscape technology was also
implemented in the tabletop
Internet terminal from Gate-
way Inc and Sony’s PlaySta-
tion 2. Linux has a fairly bad
desktop user market due to
the high technical skill level

it requires for setup, but it is
immensely popular among
the ‘techie’ crowd. The merg-
er plans to strike at the roots
of Microsoft’s dominance in
the desktop OS market. AOL
is planning to achieve a rea-
sonable OS market share by
providing simpler, easier and
cheaper versions of the OS to
its consumers bundled with 
the famous AOL Internet 
software. 

AOL-Time Warner eyeing Red Hat

Linux and Windows are at it
again. The two adversaries
have fought many battles in
the past with the first frontier
being servers, an area where
Linux has stayed ahead. The
next clash was for supremacy
for the desktop. But here
Microsoft reigns supreme
despite several challenges
from Linux over the past sev-
eral years.

That makes the scoreboard
stand at 1-1 (arguably) if you
are keeping a watch on that.

With the introduction of

handheld computers that
use a stripped down ver-
sion of Linux, Microsoft
now faces a new chal-
lenge to that platform
in addition to the
already strong com-
petition from Palm.
If it’s as good as it
sounds, Pocket
PC is going to be
sweating bullets.
Like its rival,
the Linux PDA
is capable of
running feature-rich applica-

tions in
colour. If you

have ever felt
the Linux plat-

form to be
obscure, the

mobile version
might very well
make you think oth-

erwise.
So the million

dollar question now
is: who will score next?

Linux hits the road

“Software makers
should be pun-
ished for products
with bad security”

National Academy of Sci-
ences (NAS) panel suggest-
ing that the US Congress
should make it easier to pun-
ish companies making inse-
cure software 

Microsoft got the hint: 

“Our new design
approaches the
need to dramati-
cally reduce the
number of such
(security) issues”

Bill Gates in a memo to his
employees

realitybites

followup
Ginger—original or copied?

■ Yahoo to launch pay-per-search ■ Web services draw new interest ■ Need for wireless security grows ■ MS buys major 3D patents from SGI



Shifting OSs
Dear Sir,

Thanks for the comprehensive article on Windows XP.

The article was quite detailed and touched almost

every aspect of the new OS. However you missed out

on the most essential part—the installation of Win-

dows XP—that is, the hardware device drivers’ com-

patibility issues of XP. You seemed to have written the

article only for people buying new branded comput-

ers which will come with Windows XP preloaded.

There was no mention of the scenarios that a person

may encounter if he decides to switch from an exist-

ing Windows 98/Me installation to XP.

I hope that my suggestions will be incorporated in

future issues of Digit.

ANURAG JAITLY

Via e-mail

Dear Anurag,
The reason that we haven’t dis-
cussed any driver compatibility
issues when it comes to XP is
because we haven’t yet faced any
major problems due to it.  During
the fresh installations of Win-
dows XP on our test machines, all
the hardware was detected easily
and without any glitches what-
soever. Most mainstream hard-
ware manufacturers have already
made Windows XP drivers avail-
able, which should ensure that
problems will occur only with
older hardware for which driver
updates are no longer available.

The unfriendly penguin?Dear Karan
I find your editorial in the January issue quite shocking. Please allow me to

explain. You have mentioned that Linux is not user-friendly! While this might

be true for certain distributions, this definitely does not apply to Mandrake,

SuSE and others. There are several other things that need to be considered,

such as all the bundled applications—office suites, develop-
ment tools and even games—that accompany these
flavours. Even Windows XP doesn’t give you many
of these applications. And Linux is friendlier when it
comes to working on other OSes. While XP might be
an improvement compared to earlier versions of Win-
dows, it comes with its own baggage of bugs and
service packs. My point is that you shouldn’t scare
away newcomers from Linux by describing it as an
unfriendly OS. Linux is something that they can find
interesting and useful if they give it some time. And
you guys would do both Linux and the common man
a favour by carrying a Linux distribution on your CD like
you have done in the past. DINKAR
Via e-mail

Calling Agent 001Dear Karan,
You guys have done a great job. The Jan-
uary issue was smashing and Iknow that I’m not the firstor only one to say so.I liked every-thing—the articleson games, proces-sors test and even thegraphics and illustra-tions. Digit would benicer if we could contactAgent 001 via e-mail.JAYANTA KUMAR DEYVia e-mail

Dear Jayanta,
You can ask Agent 001 your questions by 
visiting our Smart Buyer’s Form at
www.thinkdigit .com/forums. Just register
at the site and you will get the buying
advice you need.

Is Microsoft really the bad guy?
Hey Karan,
Perhaps the title of your editorial ‘Is Microsoft’s domination really unjust?’ should

be  ‘Doesn’t Linux need another chance?’. We have the choice to say no to

Microsoft. The fact is the same people who ridicule Microsoft and call it a dictator

go back to their desktops and boot up MS Windows. Besides, is Linux giving devel-

opers what they need? Does Linux give us a ‘Visual Basic’ to write easy-code and

create GUIs in a snap? Does it give us the customisation of VBA to customise our

applications? As for ‘not-many-applications’—the real developers in the world know

what’s better and that’s why they’re not making Linux versions of their software

even when they’re creating Mac editions! Hiding behind ‘excuses’ is not going to

get you guys through.DAX PANDHIVia e-mail
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Dinkar,
If Linux wants to become popular, it has to
become easier to use for the majority of com-
puter users. The statement, if you really love
Linux you will learn how to use the command
prompt, just doesn’t wash. People use what
they are comfortable with, and Windows is
still the easiest OS to get comfortable with.
Windows 95 was an improvement over Win-
dows 3.11 when it came to usability. While

installation and configuration is considerably
simpler now, there is still much that needs to
be done. Windows XP is a step ahead in usabil-
ity and none of the Linux distributions
approach that level yet. The advantage Linux
has over Windows in features will, hopefully,
be matched by innovations in the area of user
interface. The sooner this happens, the greater
the chances of Linux being of wider appeal to
desktop computer users.

Dear Dax,
While the popularity of operating systems with developers is important, develop-
ers build products on a platform for which there exists some demand from end-
users. Consumers who pay for the products developed determine the popularity
of an OS. But your observation that Microsoft provides a better set of develop-
ment tools than Linux are right.  As far as our criticism of Microsoft is concerned,
we think that aiming for domination is quite all right. We do not count ourselves
amongst the Anti-Microsoft brigade and criticism is restricted to areas where the
quality of their products falls short. I am sure that is fair.



Short Bytes

Guns and Roses
Wow! What an interesting
and gripping January 2002
issue of Digit. The software
collection on the CD was
excellent, as was the Hands-
On tutorial on ‘Speeding up
and upgrading your PC’.
I could easily spend a couple
of months, nay a full year
even, trying to digest all the
information in the magazine.
My heartiest congratulations,
and at the same time apolo-
gies for using so many
superlatives but there was no
other way to describe your
mammoth effort.
ANIL SARWAL
Via e-mail

Hi,
First of all, congratulations on
another superb issue of Digit.
How do you manage this
guys? I barely manage to get
our college magazine out on
time, and quality is another
thing. What motivates you
people?
Could you include Counter-
strike v1.3 on your next CD?
KRISHNA KUMAR
Via e-mail

■■ Software missing in
action! The CD cover of
the January 2002 issue of
Digit mentions Ulead
Cool 3D 3.5 as one of the
software in the multime-
dia section. But we failed
to actually carry it. Our
apologies for the incon-
venience caused. Thanks
Vijay Samuel, for point-
ing this out to us. 

■■ Our apologies. In the
Zero1 awards featured in
the December 2001 issue
of Digit, we printed the
price of the Maxtor
D540X 80 GB hard disk
as Rs 4,490. It stands at
Rs 11,500.

Notice any goof-ups? Write
to goof@jasubhai.com

Send your letters marked ‘Readers Letters’ to the Digit office: 
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706, 

Phone: 022-7629191/9200;  Fax: 022-7629224 
E-mail: readersletters@jasubhai.com 

Don’t like no Quake!Dear Digit,
Your January issue was great, except for one article—‘15 essentials for a

diehard gamer’. In this article you’ve named only a bunch of violent games

(with the exception of Need For Speed 4 and Tetris). There are many

gamers like me who prefer sports or simulations. Any such list you make in

the future should include games that can be played by all age groups.

ANIRBAN CHATTOPADHYAYVia e-mail

Dear Anirban,
The games that we included were the ones
that we found relevant to our time and age.
While every genre has its own set of follow-
ers, action games are favoured by the major-
ity of PC gamers. If you were to try and list
the most innovative titles today, they would
largely be 3D accelerated action games. The
most anticipated PC titles in 2002 are Unre-
al II and DOOM III.  The simulation and

sports genres on the other hand have been
stagnating in both numbers and innovation
for the last few years. They offer little beyond
minimal cosmetic upgrades and updated
team rosters (in the case of sports games). 
Yes, we didn’t have too many sports titles,
simulations or adventure games in our list-
ing. Perhaps, if we had a Top 30 games list,
you would have seen some of your favourite
titles.

Dear Karan, 

The January 2002 issue of Digit was extreme-

ly interesting and useful. But, what caught

my eye was Varun’s letter in the Letters sec-

tion and your response to it. I am still not

convinced by your reply. 

The remedy you suggested (of using

open-source software) is not that simple to

implement. Why would I want to use

Gnome-editor to make my resume, when my

potential employer runs MS-Office XP? Sure,

there is conversion software etc, but he

would first open my competitor’s CV, which

has been developed in MS Office 2000. So I

lose the race in the first step itself! Any user,

when he chooses software, not only has to

consider his requirements and capability, but

also external entities and compatibility relat-

ed issues that may crop up.

Don’t get me wrong. I am not at all in

favour of piracy. I am against the attitude of

software giants, who initially create world-

wide standards by being pro-user, then use

these to dictate their own terms. This is as

unrealistic in a cost-conscious society as

petrol being costlier than the car it runs.

S. BALGURU

Via e-mail

Hi,
When you say that application software that are
sold today are overpriced, you are right. Forking
out Rs 20,000 for the latest version of Microsoft
Office might make little sense for a person who
only occasionally needs to type out a few docu-
ments at home.
But when you claim that piracy is the only option
available to you because no reasonable alterna-
tive exists you are mistaken.

Other office suites from Lotus and Corel have
been around for years and offer a comparable fea-
ture set at a fraction of the price. You can get a
license for Lotus Smart Suite Millennium edition
for about Rs 6,000.

In addition to these ‘commercial’ products,
you also have the choice of using WordPad (free
with windows) which can be used to create a
pretty spiffy resume.

And each of the free/commercial alternatives
(like Star Office) also allow you to save your
resume as an RTF (Rich Text) document which is
a long established standard supported by every
word processor that I can remember, including
Microsoft Word.

The point is that alternatives do exist. They
might not be exactly what you want, and might
lack some features that you want, but they are
out there.

Goof Ups
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Mouthshut.com—an Indian community site—has survived the dotcom doldrums with
the support of a loyal community. Faisal Farooqui tells us how 

Telling Tales 

Astrong and active online community
that supports your Web site during the
best of times and the worst is a CEO’s
dream come true. That’s precisely

what Faisal Farooqui, CEO of Mouthshut.com,
is experiencing. 

Mouthshut, a popular consumer reviews
site, made a quiet debut in September 2000
without the usual fanfare that accompanied dot-
com launches. Slowly but steadily it gained in
populaity. But even more popular was its
scheme of awarding MS (Mouthshut) points for
every interaction on the site, from writing
reviews to reading, commenting and rating
reviews written by other members. These points
could be redeemed for cash. This party howev-
er had to come to an end. “We had to make a
decision in the best interests of the business that
we would not be able to redeem MS points after
December 31, 2001,” says Farooqui. Following

the announcement in December, he expected
traffic to drop and user activity on the site to be
badly hit.

Surprisingly enough, that wasn’t the case.
Traffic increased and people continued to post
reviews, with the quality of the reviews begin-
ning to improve. “We’ve even had new regis-
trations on Mouthshut and support has emerged
not just from users but other dotcoms such as
Shubhyatra.com and prizes2b1.com who have
offered to pitch in by running contests for us on
their site,” adds Farooqui.

So what was Farooqui and his team’s special
touch? Nothing spectacular, actually. They did
not spend large amounts of money on high pro-
file marketing and hiring a huge staff like several
other sites. They focused on creating good visu-
al appeal and building a robust technology plat-
form in-house. Although this took time to get
up and running, it finally worked to their advan-

tage as they had complete control over the 
system as compared to if they had outsourced
the technology and then spent a lot on fixes and
upgrades. 

Farooqui believes Mouthshut meets the
expectations of people because it concentrates on
building a product that is “less frills, more value”.
One instance is, every reviewer can create a pro-
file and interact with other users through the
community centre. The ‘Trusted Circle’ system
(which Farooqui plans to patent) allows users to
either trust or distrust a review. So if a person has
been consistently sending in negative reviews,
other users can decide to distrust them and the
system filters his reviews out. This ensures that no
one can simply log on to Mouthshut and write
just about anything about a product.

This CEO reckons that another reason for
the strong support for the site is the complete
transparency in the way they function, and in
their communication with their users. Review-
ers at Mouthshut are free to write reviews with-
out editorial intervention except in cases where
there is usage of foul language or if the review
breaks the terms of agreement of the site.
There’s also an ‘MS Site Status’ that informs
surfers if the internal e-mail systems are slow on
a particular day or if a particular section isn’t
functioning properly. 

His ‘Dial the CEO’ is an exercise where he
takes calls from users who can give their opin-
ion about and advice for improving this dot-
com. Farooqui believes this is why people
respect the reviews at Mouthshut and keep com-
ing back to it. “Consumers understand that for
a good product to stay around it’s important for
it to stay afloat and earn money, hence it’s not
possible for us to keep paying.” 

Farooqui is optimistic that things will look
up in another six months and plans to introduce
online surveys and complaint modules that will
enable users to communicate complaints about a
product or a service. He would like to position
Mouthshut as the voice of the consumer.
“Mouthshut will remain free as long as the Inter-
net is around. That is a commitment we’ve made
to our consumers—they will not have to pay to
read reviews.” Going by its track record, we can
safely assume Mouthshut will keep its word. 

AVINA LOBO

Faisal Farooqui
CEO, MOUTHSHUT.COM

Both the traffic and the quality of eviews
increased—this was despite our 
decision to stop paying reviewers”“
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I
n less than 50 years, drastic improvements
have been made in the area of stor-
age. Perhaps not drastic but radi-
cal, for today information flows
smoothly in gigabytes across

computers and networks. Thanks
to space-hogging applications,
music, movies, and immense
data, today we are embarrassed
to own up a 10 GB hard drive in
a conversation. Enough just isn’t
enough anymore. 

The most popular means to
store data outside the hard disk is still the trusty old CD-ROM,
which is packed with all of 650 MB of storage space. However,
technology is relative—what’s good enough for me might not
be good enough for you. Yet, we are all users of technology,
sharers, an audience that spends countless waking hours in
front of computers. And in spite of the apparent informa-
tion overload, we have learned to gather what’s best
from the digital jungle. So one thing becomes clear: the
need for a safer place to store all that information. As
the digital world turns its audience hungrier for infor-
mation, data sees itself spilling over to a totally differ-
ent format—a format which is more versatile than the
CD-ROM and which stores much more. Enter DVD,
with all its versatility and definitions. 

Sure, DVD in itself isn’t exactly new. Actually,
the word DVD doesn’t correlate to something tan-
gible. Instead, it is a term representing a set of
industry standards that describe how data is
accessed and alternatively, how data is written
onto a particular medium. In the case of DVD, the
medium is the Digital Versatile Disk.

The store age
The fact that you may currently have at least 
650 MB of digital canvas at your fingertips is great,

but quite honestly, storage isn’t what it used to
be. Anyone who’s been compelled to back

up their data on CD stacks that reach the
roof knows what we’re talking about.

Not to mention the pain of manag-
ing such a collection. 

When the CD-Writer made its
debut in 1997, it seemed as though
the entire world could be backed
up on just a couple of discs. A 
2.1 GB hard disk was considered
spacious by anyone’s standard and
aside from the prohibitive cost of

CD-Writers at that time, 650 MB
really made a lot of sense. 

But now with hard drives going
beyond the 100 GB barrier, not only

does a 40 GB drive look like an old timer,
but the backup solution, the CD-Writer,

begins to show its wrinkles too. While CD-
RW media delivers a standard 650 MB of stor-

age space, some discs push it to 800 MB. A DVD
disc holds a payload of 4.7 GB on a single side. If

you have a double DVD media, it can dispense a
peak of 9.4 GB! That’s over 14 times the capacity of

regular CD-R media. Do things sound better now?
CD-RW is expected to dominate the consumer

removable storage market for at least three years
before it finally runs out of steam, yielding to the
much more promising DVD format. We can only
guess what’s going to happen to all those 20x CD
burners in all those houses in all those places! 

It’s all a mosh pit
Though moving towards DVD as a storage medium
seems inevitable, consumers are faced with a standards
problem. Just as CD-R and CD-RW have become syn-
onymous with CD-based storage, DVD too has its own

D i v i d e D
DVD writers are going to define the future of storage. But is the confusion with

standards going to get in the way?

DVD is the next
wave in

storage—if it can
overcome its

identity
crisis
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monikers. The problem is there are just too
many of them. In fact, one of the biggest
misdeeds the industry regularly perpetrates
is its inability to get together and finalise a
set of standards for the consumers. This
slows down the adoption of the technology
as a whole, and at the same time it also iso-
lates users from one another.

Instead of one or two simple choices,
consumers are now faced with a deluge of
five competing formats, all of which come
with confusingly similar names. You have
DVD-RAM, DVD-RW, DVD+RW, DVD-R
and finally, DVD+R. Each format has its own group of support-
ing manufacturers, and all of them are extremely busy telling
you that theirs will be the de facto standard in the end. In the
computing world, usually only one format from many sur-
vives—the others, after some noise, silently pass away.

DVD-RAM was the first recordable DVD format to hit the
scene. If you’ve ever used a floppy disk, you’ll get the idea of
how DVD-RAM works. Though storing data on a DVD-RAM
drive is a totally different process from, say, a hard disk or 

floppy disk, the computer logically treats it as such. But where
this format shoots itself in the foot is in the domain of accept-
ance. Thanks to its proprietary cartridge casing, compatibility of
DVD-RAM has taken a nosedive. The exodus has already begun.
Apple and Sony, once strong advocates of DVD-RAM, have
stopped promoting it even though they still sell it. We spoke to
vendors who sell DVD-RAM drives. A large share of them pre-
dict a short shelf life for the format in the face of DVD-R, DVD-
RW, and its next iteration, DVD+RW.

Looking at it broadly, both DVD-R and DVD-RW closely
resemble the workings of the CD-R and CD-RW formats before
them, only that they store a lot more. The maximum holding
capacity of these formats is 9.4 GB and 4.7 GB for DVD-R and
DVD-RW respectively, while each can boast of 80 to 90 per cent
compatibility with DVD players.

For the time being,
DVD-R/RW will enjoy
widespread accept-
ance. But now with
DVD+R and DVD+RW
on the market, that
scenario is certain to
change.

Two positive 
reasons to shift
DVD+RW has
emerged as the alter-
native for DVD-RW as

it has some pretty strong voices to back it up. Dell, Compaq
and Philips are just a few of the heavyweights. When you
take a look at what DVD+RW can do, it makes you wonder
why and how DVD-RW left these features out in the first
place. For instance, DVD+RW has the ability to write to
media similar to how DVD-RAM and floppy disks do. Also,
you can use the same disc on your PC to read data files and
on a standalone player to playback any video on that disc.
Drag-and-drop support is another plus point of this format.

But perhaps one of the most impressive features of DVD+RW
is its ability to resume an interrupted writing session from
where it left off.

DVD+RW even writes faster than DVD-RW—2.4 times as fast
on rewritable media. On the single write types, it still outruns
DVD-RW by operating at 2.4x as opposed to 2x for DVD-RW. As
for DVD+R, it is more of a single-write extension of the
DVD+RW format. At best, DVD+R could simply be a more cost-
effective media for those who want DVD+RW drives but really
don’t have a need to rewrite any discs.

Room for only one
Wading through this crowd of formats, it’s pretty clear that this
battle boils down to two sides, the ‘minuses’ versus the ‘pluses’.
The DVD-R/RW formats, though widely accepted today, are fac-
ing the heat from two new and improved formats, DVD+R and
DVD+RW. The latter combines the best features of earlier for-
mats such as random access writing, compatibility with various
DVD players, and more importantly, it is easier to use. Since
DVD+RW is the newest format to emerge in this already crowd-
ed field, the drives and media may cost slightly more than other
formats for the time being. But once a critical mass of con-
sumers has been reached, prices will plummet resulting in a
boon for storage-savvy consumers.

Till then, we’ll have to wait with our CD-Rs. But not for long
as the storage revolution has begun. All we have to do now is
hasten the adoption process. With a little help from companies,
of course.

PRASHANT MASRANI

A DVD disc packs 4.7 GB on a single
side, burns four times as fast as
CD-RW, and is very versatile“ ”

Comparing Features: DVD and CD Writers
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Digital writing
Advances in technology are bridging the gap between the digital
and traditional communication worlds. Ericsson’s Chatpen
stands poised to revolutionise the concept of mobile technology.
A deceptively normal looking pen at first glance. But observe
closely and you see state-of-the-art electronics and impressive
aesthetics. The Chatpen looks and writes like a normal pen, but
houses a sophisticated array of technology deep inside, which
includes an infrared camera, an image processor and a wireless
Bluetooth transceiver. Appearances are always deceptive. 
Web site: www.ericsson.com

Ericsson Chatpen

Your home, your theatre
Relax and enjoy the enthralling music as it envelops
you. Just connect Sony’s Dream System to a TV and
you have a full-fledged DVD entertainment centre, a
trendy yet powerful home entertainment solution.
The system boasts of mini-tower speakers in a power-
ful 5.1 surround sound system with multi-channel
Super Audio CD-playback capability and a fully digi-
tal audio-video receiver. It gracefully combines ster-
ling performance with plug ‘n’ play setup and use.
The system’s handsome silver finish is an ideal match
for Sony’s popular Wega series television sets. Just
don’t ask the price!

Web site: www.sony.com

Sony Dream System DAV-C 900▲
▲

A dose of funky gizmos to satisfy those
hungry for the latest in digital devices

Danger Hiptop
Small, smart and hip!

The Hiptop is a device through which
you can exchange IMs, send and receive

e-mail without networking glitches, use a
built-in phone and PIM, as well as enter-
tain yourself and send/edit pictures. The

Hiptop is user-friendly, affordable and
mobile. It uses programs written in Java
and embodies an eight-voice MIDI syn-

thesiser. It has irDA and USB interfaces to
connect to other devices. In short, the

Hiptop is raring to go for a Web ride. 
Web site: www.danger.com

▲
▲

▲
▲
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Rest those tired fingers
Mouse weary? Try the new Trac Mouse
which resembles a video game controller,
and you won’t need a smooth surface for
your mouse ever again. The Micro Trac
Mouse nests 
lightly in your Palm as you glide through
your desktop space with effortless ease.
Looking more like a redesigned pistol, the
Trac Mouse has a ring on which you can
slide your index finger and start clicking.
More than anything else, the Trac Mouse
is fun to use. It comes with both USB
and PS2 adapters and is the best
bet for those who suffer from
arm stress. 
Web site: www.ibuyer.net

Fellowes Micro Trac Mouse

Wireless advantage
Weighing a mere 18 grams, the Bluetooth Handsfree
uses a radio link to communicate with your mobile
phone. Without any wired connection, this headset
gives you mobility within a 10-metre range. You can
use the Handsfree to make and receive phone calls
without touching your mobile device. The size of a
credit card, the Bluetooth unit, which can be worn
around the neck like a pendant, seems more like a
designer wear accessory. It also comes with inter-
changeable covers, making it more ornamental than
any other ordinary handsfree unit. Wearing it?
Web site: www.ericsson.com

CD player for the tough
Shockwave Metal CD Player is tough, goodlooking and compact.
It’s water and heat resistant, has a one-touch lock and release sys-
tem which keeps the top cover firmly attached even under rugged
conditions, and uses a digital synthesiser tuner for easy tuning
into radio stations. It has a 30-station preset memory for instant
access at the push of a button. Using the Brain Shaker Extreme
feature VMSS (Virtual Motion Sound System), the unit transforms
bass signals into vibrations, letting you feel the music. 
Web site: www.panasonic.com

Panasonic SL-SW899V

Bluetooth Handsfree HBH-20

▲▲

▲
▲

▲
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T
hat little beige box which sits
quietly in your home can do
more than you think. You
probably use it for fun stuff,
games and chat, and maybe to

type mail and use the ubiquitous
Microsoft Word. You might also be using
it to learn new programs, run applica-
tions, and to get to know the finer ele-
ments. But no matter what you do, the
chances of you not utilising your PC fully
are very high—your PC is not paying for
itself.

We know what the cost of a PC in the
market currently is and what with the
Internet accounts, phone bills, software
and other purchases, the cost turns out to
be quite high. So how do you get some of
that hard-earned money back? By using
your PC and the devices you bought
along with it (printers, scanners, CD-
Writers, etc) smartly.

What you need to turn your PC into
a money making machine is, of course,
a PC, loads of time, some essential skill-
sets, and 10 really feasible ideas. You’ve
got to have the first three. We’re here
with the ideas.

1 Communications 
centre@home
People need to communicate the world
over. Cheaper, faster, and more trouble-
free the communication, the better.
What’s better than an e-mail and chat in
this sense? For the average Indian without
a PC, cyber cafés are always around, but
not always the first choice. This is where
you step in—not by opening a cyber café
but by letting a few customers send/receive
mail, surf, chat and take printouts at min-
imal charges. You will keep your machine
clean, healthy and virus-free, teach your
customers to do the same, and give some
general tips. Afterwards, when your repu-
tation is established, you need not spend
all your time there—a younger sibling

could take over.
Start off by getting Webmail, buying

a ream of paper, and cleaning up your
room.
How much can you earn?
You could charge Rs 10 to 15 for the printout
of each e-mail received or sent. With Just a
handful of customers you could earn yourself
good money.

2 Data entry
There’s a lot of demand in the market for
getting data typed accurately. If you have
a good typing speed, proficiency with the
English language, time, and tonnes of
patience, then this might just be the
thing for you.

A lot of companies prefer to out-
source data entry tasks rather than
employ people for the purpose. This data,
which is to be keyed in manually, may be
numeric and/or alphabetic as well as in a
standard format with specific fields or in
free form. You’ll need your trustworthy
PC, a spreadsheet or a word processor,
backups, and an ability to meet deadlines.

There’s plenty of work available with
companies like Datamatics and there are
lots of other companies which outsource
data entry on a regular basis. Data entry
can get a bit monotonous though, but if
you devote a couple of hours to it every
day—just like an exercise which you have
to finish—then it’s possible to earn a decent
amount of money over a period of time.
How much can you earn?
The money you earn depends on the field you
enter. It usually ranges from 60 to 80 paisa per
data field. You’ll need a few good hours of
work everyday to earn you a substantial
amount.

3 DTP and word processing
Are you a whiz at Microsoft Word? You
along with your PC could be in business
typing letters, documents, college 
projects, etc for anyone who needs 
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Ten feasible ideas to make your home computer pay for itself



documents formatted and printed. You
could even make simple presentations in 
PowerPoint.

Further, you can do this on a regular
basis for small companies which don’t
have computers and need to outsource
their word processing requirements.
You’ll need a word processor, a spread-
sheet and presentation software and
some hard disk space to store documents
and templates. You will also need a 
printer.

The skillsets you need are: an ability
to format documents and slides, a good
typing speed, and a fair amount of profi-
ciency in the language you’re supposed
to work in.

You can also layout and format
brochures, posters, business cards and
magazines. However, you’ll need to know
desktop processing (DTP) software such
as Adobe Pagemaker or QuarkXPress.
Simple posters or layouts can be laid out
in Microsoft Word.
How much can you earn?
Typing and formatting a single page of a doc-
ument in say Word can get you about Rs 25
to 30. DTP with software like Quark or Page-
maker can get you a marginally higher
amount.

4  Affiliate marketing
‘Get a FREE Radio and the Shopper’s
Edge!’ How many times have you
received a message like this in your
inbox? If you happen to be among those
whose inbox gets flooded, you’ll know
exactly what we mean. However, all of
this is not spam—some marketing is pret-
ty targeted actually and there are many
new Web sites and products coming up,
all of them wanting to target more and
more customers. This is accomplished
through a network of people online.
These people make money by promoting
other Web sites and products (known as
affiliate marketing) through different
ways. 

You can do this from your home with
a PC and an Internet connection. There
are different types of programs that you
can join. If you have a Web site, you can
host banners on your site and direct traf-
fic to a site via clicks on the banner; alter-
nately, you can send out e-mail contain-
ing links to people whose e-mail address-
es you know, or obtain databases of 
e-mail addresses to send mail to.

Affiliate tracking software keeps a tab
on how many people have visited a Web
site through you, and you get paid

accordingly. There are several pro-
grammes that you can join. The trick is
to wisely choose the right combination
of programs. It’s all about time in the end.
How much can you earn?
In the best situation you could make Rs 5000
per month. 

5  Web designing
With more individuals and organisations
wanting an online presence, the demand
for good designers who can create and

design Web
sites, whether

huge sites with complex navigation or
simple Web pages, is increasing.

You don’t need to be an artist or have
any formal qualifications in art to be a
Web designer. What you need is a good
design sense, an understanding of the
visual element, and creativity. 

You’ll need software such as Photo-
shop or Paintshop Pro for image editing,
Dreamweaver for page creation and other
software such as 3D Studio MAX, Corel
Draw, Flash and CuteFTP in your toolkit.
You should have a databank of images,
possess a working knowledge of HTML
and FTP, and be adept at increasing the

scope of your visual imagination.
How much can you earn?
This varies according to skill, the size of the
Web site to be developed and technologies
used, for example Flash, PHP, etc. A few Web
pages could bring in Rs 5,000 to 6,000 while
a fairly large Web site could earn you upward
of Rs 15,000.

6  Writing
Though writing or the ability to write
doesn’t have anything to do with own-
ing a PC, it’s pretty much crucial that
every writer has a PC. For starters, word

processors such as Word or Star Writer
make editing text easier. Then you need
to have a ‘soft copy’ of the data as the lay-
out of text for either printing or Web pub-
lishing is done on a computer.

Magazines, newspapers, journals,
Web sites, advertising agencies, software
companies—they all need people to write
articles, manuals, brochures, etc on top-
ics as diverse as gardening and green-
house warming. Of course, the style of
writing and the flair will vary, depending
more on who you are writing for. Use the
power that you have with the Web, get in
touch with people who can help and
guide you and get you in touch with
publications worldwide. In other words,
use your PC as a tool to write your way to
success.
How much can you earn?
This varies according to experience. It starts
from Re 1 per word to about Rs 3 a word if
you’re really good.

7 Computer training
If you are a techie, or happen to know
enough about technology to teach oth-
ers, try opening a small training institute
of your own. If you have attributes such
as patience, tolerance and the desire to
teach, you will discover that teaching and
training is a very rewarding way of mak-
ing money. 
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Web design is not just about laying
out text and images. It’s also about
finding a balance between utility
and aesthetics, creativity and 
structure 

Andre Rodrigues, 
FREELANCE DESIGNER,
MUMBAI

“
”

Some more ways to get rich!
There are several schemes online that
can make you some money. Though the
halcyon dotcom days when you could
make money off virtually anything have
come to an end, sites still exist which
offer you points or credits that can be
redeemed for money. For example, filling
out online surveys, contests, registering
for a service, and so on. However, you
can’t make much money out of this since
most of these programmes are located
overseas and  redeeming points for cash
is a major problem.

TThhaatt’’ss  nnoott  aallll……
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The success of your venture would
depend on the knowledge that you have.
You could start from basic familiarisation
courses with the PC and go on to training
in different programs such as Web design-
ing, multimedia, and perhaps even pro-
gramming.

All you need is a computer and 
a desire to teach—you could even end
up owning a computer training 
conglomerate!
How much can you earn?
This would differ according to what you are
teaching, whether it’s basic computer skills or
programming. You could charge by the hour
or one amount for a certain number of 
sessions.

8   Using gadgets/software
Do you have a CD-Writer or a scanner
that’s underutilised? Why not use it to
recover the investment which you made
while buying them? You could do this for
people who need to back up data on CDs
but don’t have CD-Writers, or for people
who need images scanned and burned
on to a CD. And there are many such

people.
Along with

scanning pictures for others, you can
offer to clean and spruce up the image
too, maybe resize and add effects for CD
covers and such like (you’ll need a com-
fortable knowledge of image editing
software for this), and charge a little
extra money for all the services 
rendered.

You could even burn freeware or
shareware but make sure it’s not protect-
ed by copyright as in the case of music or
software. Taking back ups of data from a
hard disk on to a CD is another option.
You’ll need to be a little hardware savvy
to be able to plug in another hard disk
into your computer and back up the data
onto a CD. 
How much can you earn?
You could charge anything between 

Rs 80-100 to burn a single CD. As for 
scanning, Rs 10-20 is more like it.

9  Programming and tech-
nical services
If you have programming skills and want
to work from home either full time or
part time, you’ll find lots of companies
willing to outsource you work. The kind
of programming that you’ll be doing will
depend on your skillsets, languages
known, level of expertise, and experience.

Plenty of small to medium-sized com-
panies outsource technical work at 

different levels. You may be required to
do just part of a project, develop small
applications, or work with others on a
project that requires a high level of skill.
There are other options like taking up
debugging or working as a ‘tester’ with a
software company. You could work with
a game development company too,
depending on your interests. 

The best way to get work would be to
set up your profile detailing the skillset,
experience, and projects completed at sites
meant for programmers— www.adspro-
gramming.com and www.scriptlance.com are
two examples. You can post an advertise-
ment about your services at programmer
newsgroups and other forums.
How much can you earn?
For a four-day Web/Java/HTML project you

could earn between Rs 2,000-4,000, while for
application programming projects of similar
length, you could make between Rs 4,000-
8,000.

10  Medical transcription
If you have a background in medicine
and are well-versed with medical termi-
nology, medical transcription is a lucra-
tive option that you could pursue. This is
the process of translating digitised audio
medical records and dictation by physi-
cians into accurate text records. 

You also need to have the ability to
understand different types of accents.
Excellent English language skills, good
hearing acuity and listening ability, rea-
sonable keyboard skills and ability to
work for long hours with a high level of
concentration are some of the key 
attributes.

Transcription at home isn’t for every-
one. Apart from your PC and a word
processor, you’ll need to invest in refer-
ence material such as a good medical dic-
tionary or a physicians’ desk reference.
You’ll also need audio equipment for
transcription. It’s best to start working
with a company and after gaining expe-
rience, move on to the next step of work-
ing from home.
How much can you earn?
These jobs are usually handed out by insti-
tutes handling medical transcription. You
could earn between Rs 8,000-10,000 per
month.

AVINA LOBO

Copywriting using my PC is really easy. I
can work with different fonts and find out
which font works best and has the best
impact. The art director too can just layout
the copy after I’ve written itPrajakta Patankar,

ACCOUNT EXECUTIVE
TURNED FREELANCE
COPYWRITER

“
”

Once you’ve decided what to do, the next
step is looking for work and getting cus-
tomers.
■ The best way to find work is through
word of mouth. Spread the word among
your friends and people you know about
the services you’re offering and you’ll be
surprised at how effectively it works.
■ Take your work online. You could have
your portfolio or work samples displayed
on a Web site. If you’re a writer, sending
out newsletters to a few people you know

containing useful articles or links to your
work could get people acquainted with
your work and help you get clients.
■ Use the Net or search engines to ferret
out forums and Web sites specific to what
you want to do such as sites for designers,
programmers, data entry or DTP operators.
You could post your advertisement or find
people who need work done.
www.workathome15.homestead.com and
www.homebiznews.com are sites where
you could post an ad or get ideas on how
you can make money off the Net.

Where do I look for work?
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True happiness is a brand new multimedia PC sitting in your
bedroom, waiting to take you on a journey of colour, an
extravaganza of sound, to a dreamland—akin to Alice in

Wonderland. But in order to exploit your PC’s true potential, you
need the best software. We have handpicked 10 essential software,
each of which tops the features’ list in its category. So put the hus-
tle behind your PC’s muscle with these freely downloadable, must-
have utilities. 

VIDYARAMANAN S.

AVG 6.0 Free

Code red
Viruses spread either through file sharing media or through
the Internet. Never to be taken lightly, it’s always wise to
protect your PC from these dreadful pieces of code. AVG
6.0 from Grisoft is the best free anti-virus software around.
The powerful scanning engine, Virus Stalker, provides solid
protection against file and e-mail viruses with its heuristic
abilities. Whether your PC is already infected and requires a
thorough cleaning, or you wish to prevent any possibilities
of an infection, AVG should give you that much needed 
Z-class security. With regular engine and database updates
and the ability to scan zipped files and remote network
folders, this anti-virus solution comes with its own doctor.
Freeware; www.grisoft.com 

IrfanView 3.61

Software with a view
Images speak louder than words. If you own a PC, you would
have definitely gone on a hunt for a J-Lo wallpaper at some
point in time. And, of course, you don’t have to wait till the
next family reunion to check out the photographs from the last
bash. The varieties of image formats available today make an
image viewer an absolute necessity. The ideal image viewer
ought to be light, provide support for a wide range of image
formats, and also give you basic image editing features. Irfan-
View is a beautiful piece of software that accomplishes all this
and more. Whether you need to do batch processing or scan
an image and apply Photoshop filter effects, or even play MP3
and video files—IrfanView has all the answers.
Freeware; www.irfanview.com

Winamp 2.78

Turntable for your PC
Music brings the world together and MP3s are the most
popular standard for music lovers worldwide. Just add a
soundcard and speakers and the PC is transformed into a
modern jukebox. Winamp from Nullsoft has been synony-
mous with MP3s for as long as anyone can remember. The
most popular MP3 player around is a free download and
offers a set of intuitive controls, a skinnable interface (you
can find scores of skins online), and also lets you create
your own playlists. Features such as low memory footprint
and plugins that do everything—from optimising sound
output for headphones to gripping visualisations—set
Winamp apart. Simply the best free player available.
Freeware; www.winamp.com

01 02

03
04

So you’ve got a new PC? Great, but what
will your PC do without the best
downloads? Get these absolutely free
software now!

WinZip 8.1

Packed to perfection
Archival/compression utilities are essential in every PC user’s
arsenal. You need them every time you have to transfer large
files over the Internet or to another computer. WinZip is the
most popular compression utility available for download and
with good reason. Not only does it satisfy the standard for
ease-of-use, but also includes other neat features like per-
forming a virus scan (using your default anti-virus software)
without actually extracting the files, password protection,
splitting large archives into smaller chunks, and so on. It is a
great archival tool. The only real downside is the nagging
splash screen, which pops up every time you try to zip or
unzip a file with the evaluation copy. 
Shareware; www.winzip.com

10
user

for every

PC
Free Downloads
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Copernic 2001
Basic

Scour the Web
Searching the Net for relevant information can sometimes
be frustrating. Enter Copernic, a powerful search suite which
combines the power of the best search engines. The Basic
edition of Copernic 2001 is a free download that lets you
locate information across seven search categories (Web,
newsgroups, e-mail, etc) and 80 information resources,
which is more than enough for most of us. It also keeps
track of all your searches in the recent past, which can be
useful for reference purposes. Browser integration allows
you to highlight a term and search it with Copernic’s search
engine. So the next time you need to round up a Web trip,
take a ride on Copernic. 
Shareware; www.copernic.com

Acrobat 
Reader 5.0

Document reader
A lot of useful information such as manuals, documents and
whitepapers are created primarily for print. Adobe’s PDF
(Portable Document Format) is the most popular format for
distributing print documents electronically. To read docu-
ments prepared using Adobe’s Acrobat software, you will
need the free Acrobat Reader software. The latest release,
version 5.0, will integrate smoothly with your browser and
allow you to view PDF documents online without down-
loading them to your machine, or save it locally if you
choose to. With the ability to zoom documents, navigate
using previously created bookmarks, and select text and
graphics, this is clearly the best PDF viewer so far.
Freeware; www.adobe.com

MusicMatch 
Jukebox 7.0

Music maker
If you have a passion for music and love creating, editing,
converting and playing music, then obviously you need a
tool that integrates all these needs. MusicMatch Jukebox is
an all-in-one music management tool which would satisfy all
your ripping, encoding, playing and editing needs. It has an
ID3 tag editor, and gives you access to a streaming radio
service. The MusicMatch guide informs you about all free
music downloads while the super tagging feature helps you
tag your files with additional information. MusicMatch Juke-
box allows you to record tracks at the bit rate of your choice
(up to a whopping 320 Kbps), and you can also customise
the looks. 
Freeware; www.musicmatch.com

PowerDivX 
NextGen 3.12

Video gaga
Looking for the ultimate video experience? If yes, then
PowerDivX is the player for you. Multiple custom aspect
ratios allow you to increase or decrease the video viewing
area, built-in DivX Codec wipes out the need for additional
Codec installations, AC3 Dolby digital and THX is supported
for awesome audio reproduction, and, hold on, it even
allows you to set CPU utilisation limits—you can control its
impact on overall system performance! It also gives you an
option to disable screensavers while watching videos while
the PowerDivX NextGen features the DiviDivX, which can
reproduce DVD menus. This player is waiting to get you
experienced. Grab it.  
Freeware; www.powerdivx.com

Trillian 0.71

Chat one, chat all
Chatting was meant to be fun, and it shouldn’t be other-
wise. But with friends scattered all over Yahoo!, MSN, ICQ,
IRC and AIM, you should get a cross-platform messaging
client that can help you manage all your accounts from a
single chat application. With Trillian, importing your existing
contacts from the other messaging services is child’s play.
Once you’ve done this, you’ll find that it offers access to the
most useful features from each of the top IMs—without
making it too confusing to configure. Add to this features
such as proxy and firewall support and auto archiving of
chat conversations, and Trillian makes the top of the charts
in the multi-platform messenger category. All this for free. 
Freeware; www.ceruleanstudios.com

FEBRUARY 2002

FlashGet 1.0

Downloads, uninterrupted
If you’re on the Net, you must be spending lot of time
downloading utilities and software. Downloading is ranked
right up there along with e-mail and chat as the most pop-
ular online function. Keeping in mind the frustrations faced
by every 56k dial-up user, download managers such as
FlashGet are here to make things easier, for example, by
continuing downloads even if the user gets disconnected.
FlashGet—with features such as drop-zone, to which you
can drag-and-drop a link to be downloaded—increases
download speeds by segmenting large files into smaller
chunks and downloading them from different Internet mir-
rors. That being said, this write up need not be any longer!
Freeware; www.amazesoft.com
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The DMTRC: An information 
centre 
When it comes to insights into digital
products and technology, you should be

able to bank upon the
best. That’s where

the Digital
Media Test &
Research Centre

(DMTRC) comes
in. The DMTRC is

the central testing
resource for Digit, the place where we
evaluate the latest in hardware, software
and technology, as seen in the following
sections. These tests and reviews are in
accordance with the most cutting-edge
evaluation processes and methodologies
used around the world. All this is done to
help you make a more calculated and
informed choice on which product or
technology to adopt. 

Demystifying the ratings 
The DMTRC brings you hardware and
software product reviews in the Test Drive
section of the magazine—as standalone
product reviews as well as comparison
tests. We test an assortment of hardware
and software products from the Indian

market, and the evaluation processes
involve parameters such as sheer per-
formance, build quality, value for money
and the features of the product. A set of
weightages are applied to these evalua-
tion parameters to arrive at an overall
score. The table given below is used in
applying the overall grades to these prod-
ucts based upon the overall scores.

In the case of the comparison tests,
the weightages are applied to the vari-
ous test parameters according to their
importance. This is explained in the
magazine articles and in the Test Process
section of the CD, where the bench-
marking methodology is explained in
detail.

About our Awards
Digit rewards exceptional performance in
each comparison test by picking a Best
Performance winner. This award goes to
the product that outshines the competi-
tion in our performance benchmarks. The
Best Value award, on the other hand, is
awarded to the product that we feel has
the best combination of price and 
performance. Consider this your yard-
stick if you are looking for more value for
your money.

How we Test
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VERDICTS

Excellent: a brilliant combination of price, performance and 
features, far beyond expectations
Good: a good buy, better than most products in its category
Average: reasonably competent but nothing spectacular about the
product
Mediocre: does not live up to expectations, needs improvement in
many areas
Poor: contains serious drawbacks and needs improvement before it
can be used for the target application

RATINGS

This month, we put 18 of the newest
CD-Writers in the market through
their paces – with interfaces ranging
from USB to SCSI to FireWire to even
the new USB 2.0 standard. The drives
were tested using real-world situa-
tions such as CD copying, assorted
file copying and burning over a
variety of CD for-
mats. Three bench-
marking software,
six cartons of test
CDs written and over
54 hours of continuous
burning! This month also
sees the test of six of the
coolest new e-mail clients with newer
features and applications that are
guaranteed to make your e-mailing
life simpler and more fun.

What’s new?
This month sees a slew of interest-
ing products like the Logitech Cord-
less Freedom keyboard and mouse
combination. This cool-looking
input device combination gives you
the best in wireless technology with
a host of programmable shortcut
keys for you to save time as you go
about your daily work. Another
mammoth piece of hardware (in
specification at least) is the Maxtor
D540X 160GB hard disk drive. Now
it’ll take you much longer to fill this
drive with movies!

In Test this Month

There’s More on the CD 
Due to space limitations, we

carry full reviews of only
the top few products in the
magazine. You can find

reviews of more products in
the Test Drive section of our

Mindware CD. This is accompanied 
by the detailed test and evaluation pro-
cedures used in the processor compari-
son test. 
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T
he amount of data that
we’re subjected to nowa-
days is truly enormous.
Over the past couple of
years, we’ve seen the size of
applications and especially

that of operating systems grow by orders
of magnitude. The latest iteration of
Windows, Windows XP, has an install size
close to 1 GB! Even the type of files we
use on a day-to-day basis have changed.
Data types such as MP3 and DivX movies
have become common, and most people

wouldn’t even bat an eyelid if you were to
say to them that you have over 3 GB of
songs and movies on your hard disks.

Given all that, most users face a very
real paucity of storage space and for most
people, buying a new hard disk drive is
not a very economical alternative. One of
the best solutions to this situation was
writeable CDs—an inexpensive backup
solution with decent reliability. You could
burn your important data on it and sim-
ply forget about it. Then came the CD-
RW, which gave users the added func-

tionality of rewriting the same disc over
and over again. The reliability of the
media is more than proven. Unless you
manhandle it, your data will remain safe
for years to come. Furthermore, the CD-
RW media is becoming cheaper and now
comes with increased capacity and varia-
tions in media quality.  

Sadly, the CD-Writer has been out of
reach for most users and even the tech-
nology was pretty intimidating. But in
the past couple of years several inexpen-
sive internal IDE writers have made their

PHOTOGRAPH:Jiten Gandhi, IMAGING: Ashwin Boricha
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debut and especially in the last year, the
market has seen an influx of low-cost IDE
writers from different manufacturers. Con-
sequently the price of CD-RW drives has
fallen to the extent that it’s now well with-
in the budget of even home users—entry
level CD-RW drives cost just under Rs
6,000. Coupled with very cheap record-
able media, this is truly the most cost-
effective solution for freeing up that long-
needed space on your hard disk. There are
a plethora of speeds, interfaces and fea-

tures available that give
users the choice of a
very wide array of
devices to suit your
application and budget.
For standalone applica-
tions, there are IDE and
SCSI drives while for
people on the move,
there are external drives
sporting newer and
high-speed interfaces
such as USB 2.0, FireWire and SCSI.

The rise of the CD writer
CD-Writers too were getting faster. Earlier
the rate of increase in speeds was by 2x or
4x every year or so, while now it seems
that the speed is increasing by 8x every
six months! The fastest available in the
world today is a 32x CD-Writer. This may
seem impressive, but the trouble with CD-
RW drives getting faster is that comput-
ers have a hard time keeping it supplied
with data. When the computer can’t sup-
ply enough data in the right amount of
time, you get a buffer underrun and the
result is a coaster. In the past the solution
for this was to put a larger buffer on the
drive and hope for the best! But this 

problem is now taken
care of with the inclu-
sion of buffer underrun
protection technolo-
gies—all major manu-
facturers today employ
this technology in some
form or the other.

Racing for speed 
This isn’t F1 where even
micro seconds count—a

delay of a couple of seconds wouldn’t
really hurt anyone but 10 to 20 seconds
is something that is discernible and if you
plan to write a truck load of that software
you developed in your garage then every
second counts! 

Also, how many single large files do
you think you are going to burn? Well if
you plan to do a lot of video capturing,
VHS to VCD conversion and the likes
then writing speed is what you must con-
sider in your purchasing decision.

The first batch of tests consisted of
burning ISO images onto a CD-R. What is
immediately obvious is that the time
taken to burn a 700 MB CD-R is not a big
deal anymore. Most CD-Writers will man-
age this test in less than 5 minutes. But

Floppies are more
expensive than some 
CD-Rs. A box full of CDs,
numbering 25 would cost
you about Rs 500. This box
alone is worth 17 GB of
data. All this data is stored
reliably and can be
retrieved as and when you
want.

ISO Write Speed

IN TEST

18
CD-WRITERS

Make room! The right CD-Writers to burn data onto CDs so you
have all the space you need on your hard disk
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the really fast ones can even manage to
touch the magical 4-minute barrier.

In this rather intensive test (primari-
ly because the system reads and writes a
relatively large file in one continuous
sequence) the ASUS CRW-2410S turned
out to be a scorcher, scoring a speedy 241
seconds flat! Yes, a 700 MB ISO image was
burnt in 4.01 minutes. Tough competi-
tion was to follow soon. The Yamaha
CRW 3200E-VK blazed in just 3 seconds
later, followed by the Plextor PX-
W2410TA which completed the writing
in 247 seconds (4.07 minutes). A differ-
ence of less than 10 seconds separated the
top three drives, showing all too clearly
that all of them were top-notch perform-
ers worthy of being in the big league. 

All the 24x drives showed some real
performance here and the difference
between them can only be attributed to
better access and beam assembly move-
ment times. 

Assorted hurdle
A bunch of files with a bunch of folders
with long file names—try as you might,
organising your files with proper names
and folder structures is simply asking for
too much isn’t it? But that should not
give a CD-Writer enough excuse to write
a coaster. 

Assorted files have always been a big
problem to deal with. You will on the odd
occasion find a few corrupt files written
or that odd zipped file that simply refus-
es to extract. So we made the weirdest
combination of assorted files, bunched up
in a maze of folders with long file names.
An exact 650 MB was accumulated (a

We chose Windows 98 SE as the default
OS for the test. The latest drivers for the
motherboard chipset and the ATA/100
controller on the motherboard were
loaded, as were the drivers for the USB
ports for testing the external USB drives.
All the CD-Writers were tested with DMA
enabled for all IDE channels. A ghost
image of the current install was backed up
and reinstated after testing each writer to
ensure minimum drive fragmentation.

The CD-Writers under test were bench-
marked for their performance as CD writ-
ers and for their CD reading capability. The
latter consisted of a blend of synthetic
tests that logged low-level parameters

such as data transfer rates and access times
of the drive, while the former tested the
time taken to write CDs at various speeds. 

The media used was the HP CD-R 700
MB, specified for a maximum of 24x (Cya-
nine, Type 1). The CD-RW media used was
the 650 MB HP CD-RW, specified for a
maximum of 10x (Cyanine, Type 3).
Write Tests: Here we tested for ISO write
speed, audio write speeds, RAW write
speeds, RW-assorted speeds and other
assorted write speeds wherein a combina-
tion of file sizes ranging from 1 KB to 100
MB were burnt. We checked whether the
drive performed these operations reliably
and if there were buffer underruns or other

errors during the CD creation process.
Read Tests: The read tests comprised the
audio extraction test, Nero CD speed test
and an assorted read test in which a com-
bination of file sizes ranging from 1 KB to
100 MB were read from the writer and
copied to the hard drive.
Features and Package Contents: We also
checked for buffer size, burn formats sup-
ported, the ability to read/write RAW data,
etc. Finally, we examined whether the
writers came with comprehensive instruc-
tion manuals, quick reference cards, soft-
ware CDs, free blank media and other
accessories. We also tested the bundled
free CD writing software for ease of use. 

Digit Test Process

Buffer underruns occur when the com-
puter fails to provide the data to the CD-
Writer in a continuous stream. As a result,
the recording fails and the media
becomes unusable. This can happen
when attempting to burn a CD-R whilst

performing other tasks, or when record-
ing from a relatively ‘slow’ source to a
‘fast’ target.  

In the past, you needed to shut down
all the other activities running on your PC
and wait till the CD-Writer finished writing

the CD. With the advent of Burn
Proof technology you no longer
need to continuously monitor the
buffer bar. Introduced first by
Sanyo, CD-Writers featuring this
technology have become intelli-
gent enough to synchronise, wait
and then burn the data. 

Using this technology, record-
ing is paused at a specific loca-
tion when an impending buffer-
underrun condition is detected.
The writing process resumes only
when the buffer has been suffi-
ciently replenished and after
repositioning the CD-Writer’s
optical pickup mechanism to the
appropriate sector. (See diagram,
‘Streaming Data’.)

Most major drive manufac-
tures either license similar tech-
nology or have developed their
own variants. Mitsumi and LG
Electronics use OAK Technology’s
ExacLink system, Yamaha does
the same but under the brand
name SafeBurn. Acer Communi-
cations refers to their technology
as Seamless Link and Ricoh calls
theirs JustLink.

Burn Proof Technology

Streaming Data

➜
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combination of file sizes ranging from 1
KB to 100 MB arranged in random order
in multiple nested folders) and written
onto the CD-R. Speed with absolute qual-
ity was the ultimate goal.

Notice how the scores change radi-
cally once the writers are submitted to
this torture! The rather finicky Asus
CRW-2410S suddenly got displaced from
its top spot, to be supplanted by the
Yamaha CRW 3200E-VK (24/10/40). This
writer wrote the entire CD in 226 sec-
onds (3 minutes 46 seconds)! Close on
its heels came the Plextor PX-W2410TA,
completing the test in a neat 232 sec-
onds (3 minutes 52 seconds). Not far
behind was the Iomega CDRW9600INT-
B, clocking 238 seconds (3 minutes 58
seconds). 

The LG GCE-8160B proved to be the
fastest amongst the 16x writers, taking 5
minutes 9 seconds to complete the test,
with the Asus CRW 1610A finishing the
test in 5 minutes 13 seconds. 

Nero’s very own file verification test
was used to check the data integrity for all
the tests. All writers proved to be quite
successful in this department and we did
not face any data corruption issues while

writing at high speed and with an assort-
ment of files.

Cut your own audio CD!
So you want to cut your own audio CD
and give it to your friend for his birth-
day? Not enough time to burn 100 
odd CDs at 4x? Well it’s not at all a diffi-
cult task.

We burnt an audio CD with 14 tracks
totalling 64 minutes 2 seconds in DAO
(Disk At Once) mode in less than 4 min-
utes. Also the stakes become a little high-
er with this test as we checked for jitter,
skips and other unwanted noise that may
creep into the tracks. 

The Yamaha CRW 3200-VK showed
its absolute burning prowess by writing

CD-Writer speeds are touching over 24x
but is your system capable of sustaining
those data transfer rates? Does buying a
fast CD-Writer make sense when you have

a slow performing system? Well, don’t be
fooled into upgrading just because you
bought a fast CD Writer. 

For your ‘fast’ CD-Writer to give you
optimal performance, it is suffi-
cient to have a PC with a 500
MHz processor with 128 MB
RAM (256 MB is recommended).
Though the data transfer rate to
the writer is already touching
speeds of around 4 MBps it still is
much lower than the data
throughput a hard drive can
achieve. Hence, any 5,400-rpm
hard drive should suffice. 

Is my CD-Writer too Fast for my PC?

Write Speed Time required to burn a 
650 MB CD-R (optimal)

1x 76 minutes
4x20 minutes
8x 10 minutes
16x 5 minutes
24x 3 minutes

BURN GUIDE

CD Writer Technology: How does it Work?

The fundamentals of CD Writing technology
are pretty complex. Just consider the num-
ber of factors that come into play when
recording a disc: the rate of spin, the formu-

la of the dye, the ambient temperature, the
internal temperature, the age of the media,
the power and wavelength of the laser, and
the spacing and size of the marks on the

media relative to
the speed of the
disc, to name but a
very few. Neverthe-
less, despite all the
variables and com-
patibility issues,
CD-Writing has
become extremely
reliable. 

A CD-Writer in
essence is quite
simple in construc-
tion. It has a motor
mounted internally
which rotates the
media. The laser
assembly is mount-
ed on the rack
which moves out-
ward from the cen-
tre of the media as
the media spins.

This assembly is moved precisely to the
desired location by a stepper motor. 

The construction is very similar to that of
a CD-ROM, with the only radical difference
being in the laser assembly.  

Light is used to create the marks (pits
and shadows, signifying 0 and 1) on the
CD-R discs. These marks represent data, and
are read using light beams. So a CD-Writer
basically has a laser beam which is much
more powerful in intensity, except that dur-
ing the reading process the intensity is
much lesser. 

The logic board which is mounted at the
lower surface of the writer, controls the
change in light intensity, moves the laser
head assembly, controls flow of data, writes
at the speed selected and performs all other
tasks. 

The media stores the information in the
form of 0s and 1s. This is done by burning
pits which represent 0 and the flat surfaces
represent 1. The photoresist material on the
media where the pits are formed using high
intensity laser beam is actually melted for an
extremely small amount of time by the laser
beam to form the pits.

➜
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all 14 tracks onto the CD in just 200 sec-
onds (3 minutes 20 seconds). It was fol-
lowed closely by the Plextor PX-
W2410TA which clocked 207 seconds 
(3 minutes 27 seconds). The drive was
over 100 seconds faster than all the other
16x drives. To reinforce the Yamaha dom-
ination here, the Yamaha CRW 2200
(20/10/40) took a neat 238 seconds (3
minutes 58 seconds) to do the same.
Compare this with the scores of other 20x
and 24x drives and you will be truly
amazed. Nevertheless, the Plextor PX-
W2410TA has stuck closely with the
Yamaha through the tests and on all occa-
sions has only lost by a hair’s breadth. 

A score of around 280 seconds is
respectable for any 16x drive and you will
find that all 16x specified CD writers were
more or less in the same league with  the
fastest being the LG GCE-8160B
(16/10/40) which burnt the audio CD in
276 seconds (4 minutes 36 seconds). 

Also, all the drives that came in for
the test were pretty much adept at han-
dling audio CD writing and none regis-
tered any of the quality issues we spoke
about earlier.

RAW Write
This benchmark tests the CD-Writer’s
dexterity in creating coasters. A 700 MB

test drive ■
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Step 1: Get the bootable CD or the flop-
py of the operating system to make the
bootable CD.
Step 2: Start Nero v5.5 and select the
CD-ROM (boot) in the main window. You
will be greeted with a new window with
an option where you can select the drive
in which the bootable floppy/CD is locat-
ed. Here make sure the bootable floppy is

in the drive, otherwise the drive letter will
not be highlighted. 
Step 3: Put the blank media in the writer

and leave the ISO and Misc tab as it is.
Give the appropriate name in the label
section for the bootable CD. Select the
Burn tab and check the write and Finalize
the CD. Select the Disc-at-Once write
method and click on the New tab.
Step 4: Since the bootable CD will be left
with lots of unsued space, it can be
utilise the burning drivers and updates
for your PC. 

Step 5: Select the Write tab and in the
window which opens, select the safe writ-
ing speed according to the configuration
of your machine.
Step 6: Now you are ready to write the
CD. The typical size of the bootable CD
for windows 98SE should come around
125 MB and it will take around 4-5 min-
utes to complete the process.
Step 7: Check by booting the system
with the CD you burned.

How to Make a Bootable CD using Nero v5.5

■■ Enable ASPI. ASPI (Advanced SCSI
Protocol Interface) drivers mainly con-
sist of the following four files: apix.vxd,
apienum.vxd, winaspi.dll, and
wnaspi32.dll. These drivers are neces-
sary for the CD writing software to
access the CD-Writer.
■■  Keep your hard drive in top condition
by regularly running disk tools like
Scandisk and Disk Defragmenter. 
■■  Disable programs running in the
background (screensavers, alerts, anti-
virus programs, etc) to free up system
resources. 
■■  For a CD-to-CD copy, always create
an image before writing.  
■■  Keep the firmware versions up to
date. Check the manufacturer’s Web
site for latest updates.
■■  If you use an ATAPI (IDE) CD-RW
drive, make sure it’s on a different IDE
channel than the hard drive. PCs come
with at least two IDE channels (primary
and secondary) built into the mother-
board. Each channel supports two IDE
devices on a single cable: a master and
a slave. Hard drives should always be on
the primary channel, and ATAPI devices
(if any) should be on the secondary
channel. Preferably keep your CD writer
as the secondary master device.
■■  Disable auto insert notification from
Start > Setting > Control Panel > Sys-
tem > Device Manager > CD ROM >
Device Name > Settings
■■  Windows 98 users can increase the
disk cache for frequently used hard-disk
data. Select Start > Settings > Control
Panel, double-click the System icon,
choose the Performance tab, select File
System, click the Hard Disk tab, and
under ‘Typical role of this computer’,
change ‘Desktop computer’ to ‘Network
server’.
■■  If you need to burn a CD while you
are still on the network, disable File and
Print Sharing under Network Properties
so as to prevent other users from
accessing your hard drive.  
■■  Enable DMA (direct memory access)
from Start > Setting > Control Panel >
System > Device Manager > CD ROM >
Device Name > Setting > DMA. This
helps the device to directly talk to the
hard drive rather than going through
the CPU and then accessing the drive.  

10 Tips for Maximising CD
Writer Performance

Audio Write Speed

Select CD-ROM boot in the main Window

Select Write and click ok

Drag your files into the new window



bootable CD image was written to the
media at maximum capable speed of the
writer with SAO+SUBS (Section at once +
Subchannel code) using Clone CD
3.3.1.1. The Yamaha CRW 3200-VK per-
formed its magic here once again. Edging
ahead of the competition ever so slight-
ly, it burned this image in 225 seconds (3
minutes 45 seconds). This time the Sony
CRX-175A1 (24/10/40) edged into the
second position (at 231 seconds, or 3
minutes 51 seconds), followed by the
Plextor PX-W2410TA (232 seconds) and
the IOMEGA CDRW9600INT-B
(24/10/40) out by just 1 second.

True to its pedigree, the Yamaha
CRW-2200 (20/10/40) beat the rest by a
fair degree here too, burning the CD in a
remarkable 285 seconds (4 minute 45
seconds). Compare this with scores over

320 seconds (5 minute 20 seconds) for
the rest of the 16x and 20x specified writ-
ers and you will surely realise that the
Yamaha writers are built to perform. 

Write and rewrite, over and over
again
If you just want to burn a bunch of MP3s
ripped from an audio CD to be trans-
ferred to your new MP3 CD player and
then rewrite the CD with new songs, or if
you want to take incremental backups on
that RW that you’ve been using as your
office data warehouse, then the results in
this test will interest you. 

With all the CD Writers now coming
with at least 10x rewrite speeds, you can
burn that RW to the brim in less than 8
minutes. 

Writing RWs sometimes brings out the
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A lot depends on these sometimes unlisted
components of the package. What is a CD-
Writer without CD writing software or with
one that can’t do half of what the Writer
promises? CDs often get damaged due to
problems with the writing software rather
than the CD-Writer—its inability to proper-
ly recognise the writer or the operating
system’s file system and/or other intrica-
cies. Also, support for the wide array of
formats is critical. Providing the best com-
patibility when it comes to operating sys-
tems and the ability to recognise a wide
variety of CD Writers is critical. Some soft-
ware like Nero and Easy CD Creator have
made a name for themselves in this arena. 

The package contents also are a meas-
ure of the total value offered by the com-
pany. Since no software comes for free,
bundling high-quality software along with
the Writer is definitely an advantage.
Nero 5.5.5.1: This is probably the most
popular CD-Writing software. The latest
version is now equipped with new features
such as speed selection for erasing the CD-
RW media. Some new features that attract

immediate attention are the CD cover
designer. Backing up your hard disk is also
made easy. The Wave Editor tool extends
the functionality of the software by allow-
ing you to load the music files and edit the
files. Reducing noise in tracks, increasing
volume and giving other such effects is
now very much possible. This version has
features even for Mac users. It has support
for Hybrid CD and HFS partition. You also
have an integrated tool that basically adds
support for virus scanning over the Inter-
net. 

The latest version of Nero has two
additional diagnostic tools, Nero CD
Speed and Nero Drive Speed. The installa-
tion size is not very big and this is without
doubt the most easy-to-use CD-Writing
software. 

Nero comes bundled with Yamaha,
Plextor, Samsung, Asus and Iomega. The
popularity of this software amongst the
top echelon of the CD-Writer manufactur-
ers is reason enough for it to be the most
widely recommended CD-Writing software
suite.

Verdict: It has probably the best wizards
designed for CD-Writing, making the process
child’s play. It also has a really large CD-
Writer database, ensuring high compatibility.
NTI Professional v. 5: This software came
bundled with the Krypton CD Writer. NTI
professional has an interface that appears
almost like Nero. It comes bundled with a
simple CD label creator. Apart from the
normal CD creating modes that it supports
it has one very interesting feature: Live
Audio Writing. This basically allows voice
recording directly onto a CD. NTI also has
an inbuilt ISO and file comparing tool and
supports ISO and RAW mode, which
allows recording voice directly onto the
CD. It also has an inbuilt ISO and file com-
paring tool. Another advantage with this
CD burning software is that it is very light
on the system and eats up fewer system
resources.
Verdict: It’s easy to use and detects all major
CD Writers, but there’s nothing special about
it.
Easy CD Creator 5 Platinum: This is one
of the biggest software as far as install size

Software Bundles and Package Contents

Choosing between an external and an
internal drive depends primarily upon
your requirements. 
■ Internal drives are usually cheaper.
You can choose these if you are a home
user and not always on the move.
■ Till now external writers were slower
compared to internal writers due to
their interface but with FireWire and
USB 2.0 coming along, this is no longer
a problem. Also, drives based on the
SCSI interface were traditionally the
fastest.
■ The greatest advantage of an exter-
nal USB CD-Writer is the fact that it can
be hot plugged (without shutting
down the PC) to the PC.
■ External writers come with the added
baggage of the SCSI/FireWire/USB 2.0
cards. This adds to the budget.
■ Internal CD-Writers hog a great deal
more of the system’s resources. 
■ Buffer underruns used to be a big
problem with internal drives but that
has been solved with the advent of
buffer underrun protection technology.

External vs Internal 
Writers

RW-Assorted Speed



best and the worst in a CD-Writer. Take for
example the Acer CRW 1610A and the
Krypton CD-Writer, both of which failed
this test. Also, the Acer CRW 2010A took
over 2 minutes extra to burn the CD-RW.

Apart from these glitches, the usual
suspects were at it again, fighting neck
and neck for the top spot. This time
around, the 20x sibling of the Yamaha
writers took the top spot, completing the
test in a record 471 seconds (7 minutes
51 seconds), followed closely by big
brother, Yamaha CRW 3200E-VK which
burnt the RW in a nifty 473 seconds (7
minutes 53 seconds). 

Using it like a CD-ROM drive
There are some things that you can’t
ignore when it comes to a drive’s per-
formance. True, these drives were not

built to read and transfer data as fast as
possible. What they were built to do was
to write data onto a media as fast as pos-
sible. But the fundamentals of the basic
drive mechanism remain the same and
these aspects of a drive cannot be sepa-
rated whether it is a CD-ROM drive or a
CD-Writer. A drive performing excep-
tionally when it comes to reading data
but failing to perform in the writing tests
would be rare. Nevertheless, this batch of
tests will give you a fair idea of the build
quality and drive performance. 

We used an audio CD with 14 tracks
totalling 64 minutes 2 seconds for the
audio extraction test. The LG GCE-8160B
ripped the CD in only 138 seconds (2
minutes 18 seconds), beating the formi-
dable Yamaha CRW 3200E-VK by over 7
seconds. 
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is concerned but it is worth it given the
extensive feature list. The software sports
one of the neatest interfaces, making it
easy to access different features. The
access to the submenu is through the
main menu and it’s very difficult to make
mistakes with this software. The software
comes bundled with Direct CD, which
allows you to drag and drop files from
any Windows Explorer. To increase audio
and video quality, Easy CD has built-in fil-
tering software. 

Creating an audio CD or video CD
takes just one click. Copying a CD using
the CD Copier option is an easy task to
perform with the Easy Creator 5. For those
who regularly take backups on CDs will be
pleased with Take Two backup tool which
takes backup and even looks up for the
update on your drive. Like other CD burn-
ing software, Easy CD Creator has an
online Web Check Tool and a CD label
creator.
Verdict: This is one of the best designed and
feature-rich CD burning software available.
Prassi PrimoCD Plus: This one has a rela-
tively simple interface. It has an install size

of just 2.23 MB and no memory-hogging
tray icons. Instead, it has very small but-
tons that take just a few attempts to get
accustomed to. 

The software took very little time to
install. Burning a data or audio and video
CD is very easy as there are buttons for
them on the main interface. This speeds
up the process by eliminating the scroll-
ing time. A box at the bottom of the Pri-
moCD Plus starter displays appropriate
messages to guide the user. 

Clicking on the graphical representa-
tion of the media in the recorder brings
up Disc Explorer and the Properties menu
displaying information regarding the
media. It also has a help file in HTML for-
mat which guides you through each step.
Plus there is a list of supported formats
and a comprehensive error message list.
The software has good support on the
Net and is a good choice for those look-
ing for a stable and hassle-free CD writing
software.
Verdict: This is a well developed CD burning
software but the interface could do with a
facelift.

Cross-talk: A measure of the amount of
interference coming from neighbouring
pit tracks on a CD. As track pitch is tight-
ened (when tracks are packed closer
together to put more data on a disc),
cross-talk increases. A maximum value of
50 per cent is allowed by Red Book spec-
ifications. 
Mastering: The process of creating a
stamper or set of stampers to be used in
the injection moulding stage of manufac-
turing compact discs. During this process
a digital signal from a computer is used to
guide a laser beam which etches a pattern
of ‘pits and lands’ (in the case of CDs) or
a continuous groove (for CD-Rs) onto a
highly polished glass disc coated with
photoresist. This ‘glass master’ is then
cured (developed) with ultraviolet light
and rinsed off, and a metal (nickel or sil-
ver) mould is electroformed on top of it.
This mould is removed and then electro-
plated with a nickle alloy to create one or
more stampers to be used in the injection
moulding machine to press the data into
the polycarbonate substrate of CDs, or
the guiding groove into the substrate of
CD-Rs.
Media or ‘blanks’: CD-Recordable
media are the discs used to record digital
information with a special recorder and
premastering software on a computer.
These discs are made of a polycarbonate
substrate, a layer of organic dye, a met-
alised reflective layer, and a protective
lacquer coating. Some discs also have an
additional protective coating over the
metalised layer, while others have a
printable surface silkscreened on them. 
Organic dye: The data layer of CD-R
discs is made from either cyanine or
phthalocyanine dye which is melted dur-
ing the recording process. Where the
dye is melted, it becomes opaque or
refractive, scattering the reading laser
beam so it is not reflected back into the
reader’s sensors. The difference between
reflected and non-reflected light is inter-
preted by the player as a binary signal. 
Pits and lands: In a ‘pressed’ or mass-
replicated CD, the bumps and grooves
that represent the binary data on a disc’s
substrate are pressed into it during man-
ufacture. CD-R discs do not have true
pits and lands, but the un-melted, clear
areas and melted, opaque places in the
dye layer fulfil the same function as pits
and lands on a pressed disc. 

Glossary

Audio Extraction Full Test
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Internal CD-Writers
Write Tests (seconds)

ISO Write Speed
Assorted Write Speeds
Audio Write Speeds
RAW Write Speeds
RW-Assorted Speed
Read Tests
Audio Extraction Full Test
Assorted Read Speeds 
Nero CD Speed- Read Test
Average Read Speed (x)
Random Seek Time (in mil-
lisecond)
Onboard Buffer Size
Package Contents
Includes bundled applications,
blank CD-R and CD-RW media

Final Rating
Contact Details
Vendor Name
Phone
E-mail

Price (Rs)

Acer CRW 1610A
(16/10/40)
346
324
288
322
Failed

291
204

31.49
96

2 MB

PrimoCD Plus, Acer
650 MB CD-RW,
Acer 20x 700 MB
CD-R

C

Benq
022-5705230
pankajpamani@
benq.com
5,750

Acer CRW 2010A
(20/10/40)
335
319
288
373
603

286
203

29.23
136

2 MB

PrimoCD Plus, 8x 
650 MB CD-RW, 20x
700 MB CD-R

B-

Benq
022-5705230
pankajpamani@
benq.com
5,999

Asus CRW-1610A
(16/10/40)
339
313
277
323
481

174
156

31.49
104

2 MB

Nero 5.5, ASUS 16x 700
MB, ASUS 10x 650 MB
CD-RW

B-

Rashi Peripherals
022-8260258
ho@rptechindia.com

9,000

Asus CRW-2410S
(24/10/40)
241
253
230
258
502

582
164

30.15
124

2 MB

Nero 5 Burning ROM 
v5.5.4.9, 10x, 650 MB
CD-RW, 700 MB CD-R

B

Aditya Infotech
022-6338555-59
sunil_zarekar@aditya-
group.com
11,499

Iomega CDRW9600INT-
B (24/10/40)
254
238
215
232
483

231
219

30.39
89

2 MB

Nero 5 Burning ROM
v5.5.4.9

B+

Neoteric Informatique
022-4172600
sales@neoteric-info.com

8,000

Write Tests (seconds)

ISO Write Speed
Assorted Write Speeds
Audio Write Speeds
RAW Write Speeds
RW-Assorted Speed
Read Tests
Audio Extraction Full Test
Assorted Read Speeds 
Nero CD Speed-Read Test
Average Read Speed (x)
Random Seek Time (in
millisecond)
Onboard Buffer Size
Package Contents
Includes bundled appli-
cations, blank CD-R and
CD-RW media

Final Rating
Contact Details
Vendor Name
Phone
E-mail

Price (Rs)

Acer CRW
4406EU (4/4/6)
1275
1189
1045
1212
1180

992
994

6.23
140

2 MB

Easy CD Creator
v4.02, DirectCD
3.0, 4x 650 MB
CD-RW
B

Benq
022-5705230
pankajpamani@
benq.com
8,999

Freecom Traveller
CDRW Light (4/4/20)
909
1186
1046
failed
failed

1559
812

6.51
119

2 MB

Adaptec Easy CD 
Creator v4.05,
Freecom 700 MB 
CD-R
C+

J S Equipments
022-3810713/8
jse@vsnl.com

22,500

Impulse GCD
161040 (16/10/40)
346
316
280
327
487

139
160

30.86
121

2 MB

Nero v5.5, TDK
700 MB CD-R,
Imation 4x 650 MB
CD-RW
B+

J S Equipments
022-3810713/8
jse@vsnl.com

26,000

Kodak 4832e CD-RW
External USB
1271
1184
1038
1233
failed

failed
918

failed
failed

2MB

Adaptec Easy CD Cre-
ator 4.02, Nil, 8x 650
MB CD-R

B-

Neoteric Informatique
022-4172600
sales@neoteric-
info.com
10,000

Yamaha CRW 2100SX-VK
(16/10/40) SCSI External
356
327
291
328
360

failed
165

29
123

8MB

Easy CD Creator,
DirectCD, Take Two, 650
MB CD-RW Yamaha, 700
MB Yamaha CD-R
B+

Integra Dataware 
022-8215179
mumbai@
integramicro.com
9,500

Yamaha CRW 2200IX -
VK (20/10/40) Firewire
302
293
257
284
469

151
478

29
131

8MB

Nero, InCD, Nero Toolk-
it, Nero MIX, Yamaha
CD-R 700 MB, Yamaha
700 MB CD-RW
A

Neoteric Informatique
022-4172600
sales@neoteric-
info.com
24,000

External CD-Writers



The Samsung SW-224 BRNS
(24/10/40) beat the others in terms of
random access time, scoring a trim 80 ms
whereas the rest clocked at about 100 ms.

A rather peculiar result was observed
with the Asus CRW-2410S: it suffered in
the audio extraction test, and crawled in
last, taking all of 582 seconds (9 minutes
42 seconds) to rip from the audio CD. It
churned out the same result when we
reran the test. Nevertheless, we would
give the drive the benefit of doubt since
the average access time and the average
read speeds were pretty much in line with
the rest. 

External CD-Writers
If portability is what you want in a CD-
Writer, then you should consider buying
an external CD-Writer. These writers have
been around for a while and are quite reli-
able. 

Since portability is of the essence
here, we weighed the external writers that
came into our lab. Strangly, all the IDE
writers weighed far less than most exter-
nal CD-Writers. 

The lightest was the aptly named
Freecom Traveller CDRW Light (400
grams). However, the writer failed the

audio write and the RAW write tests. The
scores for the other tests too were noth-
ing to write home about. 

The Kodak 4832e CDRW, weighing
more than 2.5 kg, also failed to complete
the RW Assorted test. It clocked 16 min-
utes and above in all the other tests,
which is not surprising considering that
this is a 4x writer. 

The Yamaha CRW 2200IX-VK
(20/10/40, Firewire) simply blew the com-
petition away, with scores comparable to
those of internal IDE writers; it even bet-
tered some of the internal writers. It was

not a cake walk for either of the Yamaha
entries here though: the Impulse GCD
161049 (16/10/40) writer actually beat
the Yamaha 2100SX-VK SCSI drive in all
but one test. 

One thing that you must keep in
mind is that with external writers speed
isn’t everything. An easy-to-use interface
and fast and easy configuration are far
more important. The Acer CRW 4406EU
came out trumps here. It uses the stan-
dard USB interface, is easy to configure
and does not require any additional inter-
face cards for it to function. Nor did it fail
any test, though the scores were low due
to the fact that it could write only at 4x
speed. The only major gripe with it was
the pathetically slow read speed of 6x.

Choosing the right one
Consistency is the name of the game.
Unfailing consistency, predictability and
data integrity that would give you sound
sleep every time you burn that critical
backup. 

The scores throughout the test were a
little inconsistent. You would see some
writers perform brilliantly in some tests
and then return really low scores in oth-
ers. However, one writer stood out time
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The first CD-Writer was
sold for $1,49,000. It burned CDs
at 1x and was used to write only
audio CDs. For data CDs it needed
to have an additional circuit board
which cost $14,000. To write CDs
it needed a machine called the
publisher which was what we
now know as the hard drive 
subsystem. This was where the
writer read the data from. This
publishing machine was as big as
a washing machine.

Krypton (16/10/40)

357
315
278
323
Failed

242
161

30.64
90

2 MB

NTI CD Maker v5, Ritek
10x 650 MB CD-RW

C+

Priya International
022-2663611
jain@priyagroup.com

5,300

LG GCE-8160B
(16/10/40)
330
309
276
323
476

138
157

30.94
95

2 MB

Adaptec Easy CD
Creator 4.03,
DirectCD 3.03, LG
10x 650 MB 
CD-RW 

B-

LG Electronics
022-6910123
sanjaym@lgindia.c
om
6,365

Plextor PX-
W2410TA
247
232
207
232
480

238
157

31.45
134

4 MB 

Nero v5.5, Plextor
Manager 2000, 1
10x 650 MB CD-RW,
1 24x 700 MB CD-R

A-

Zeta Technologies
022-4102288
tejas@zetaindia.com

9,950

Samsung SW-224
BRNS (24/10/40)
254
240
215
235
476

192
166

29.65
80

2 MB

Nero v5.5, Sam-
sung 10x 700 MB
CD-RW, Samsung
24x 700 MB CD-R

A-
Samsung Electron-
ics India
011-6322517
marketing@sam-
sungindia.com
8,000

Sony CRX175A1
(24/10/40)
251
247
214
231
484

154
158

30.23
92

2 MB

B’s Gold Recorder, B’s
Clip Writing Software,
Retrospect Express,
Music Match, Arcsoft
Photo Base, Arcsoft
Video Impression
B

Rashi Peripherals
022-8260258
ho@rptechindia.com

10,000

Yamaha CRW-2200
(20/10/40)
295
284
238
285
471

152
172

28.91
130

8 MB

Nero v5.5, NeroMIX,
INCD, Yamaha 650
MB CD-RW, Yamaha
700 MB CD-R

B

Integra Dataware P. Ltd.
022-8215179
mumbai@
integramicro.com
9,000

Yamaha CRW 3200E-
VK (24/10/40)
244
226
200
225
473

145
155

30.16
103

8 MB

Nero v5.5, InCD,
Nero Toolkit, Nero
MIX, Yamaha 700 MB
CD-R, Yamaha 650
MB CD-RW

A+

Neoteric Informatique
022-4172600
sales@
neoteric-info.com
15,000



after time, impressing us with a consi-
tently good performance—the Yamaha
CRW 3200-VK. This writer wins the
absolute performance crown hands
down. It’s built to last and built to per-
form. It also comes with a whopping 8
MB buffer that would ensure that you are
not faced with a buffer underrun 
problem. 

However, picking a winner for the
Best Value Award was a tough one. The
formidable Samsung SW-224 BRNS
(24/10/40) bagged this award—owning a
24x CD-Writer for Rs 8,000 is an irre-
sistible option. Sure you can buy cheaper
CD-Writers rated at speeds lower than
24x but the absolute value that the Sam-
sung drive offers coupled with sheer per-
formance is unmatched.

At the same time, it would be unfair
if we did not mention the Sony, Plextor
and Asus drives. These were up there in
every test, fighting it out neck and neck,
claiming top spots on occasions. 

As for the external writers, Yamaha
CRW 2200IX-VK was unmatched in
terms of pure performance and walked
away with our Best Performance award.
The Best Value award in this segment
goes to the Acer CRW 4406EU for unfail-
ing and reliable performance. 

The Winners!
Internal Writers

Yamaha CRW3200E-VK 
Yamaha CRW3200E-VK is the fastest

among the internal IDE drives. It
burnt the assorted data in just

226 seconds (3 minutes 46
seconds) and took only 200
seconds (3 minutes 20 sec-

onds) to write the 650 MB of music on a
CD. It was also fast in rewriting the assort-
ed data on the CD-RW at 10x, taking only
473 seconds (7 minutes 53 seconds),
which is again very low time. The drive
had a massive 8 MB buffer which is one
of the highest capacity buffers in a CD-
Writer. 

The drive had good build quality and
came bundled with Nero v5.5, InCD Nero
Toolkit and Nero Mix. In addition, the
pack included Yamaha’s 650 MB blank
CD-R and 750 MB CD-RW media, as well
as IDE and audio cables. However, the
writer is available for Rs 15,000, which
makes it one of the most expensive inter-
nal drives. 

SPECIFICATIONS
24/10/40x speed, 8 MB buffer, EIDE/ATAPI interface 

Samsung SW-224BRNS (24/10/40)
The SW-224 24x writer is one of the
fastest writers as far as writing assorted
data on a CD-RW goes—it took 476 sec-
onds (less than 8 minutes) to burn 650
MB of data at  10x speed. To write data in
the RAW mode, it took a mere 235 sec-
onds, which again is one of the lowest
time taken for this test.

The build quality is average but the
front panel has a distinctive

look, with the tray’s corners

rounded off and an illuminated eject but-
ton. This Samsung drive incorporates
Burn Proof  technology but its 2 MB
buffer is a bit less. The writer came bun-
dled with a manual, IDE/audio cable,
multi-speed CD-R and 10x CD-RW blank
media. The burning software included
with the writer was Nero v5.5, which is
the latest offering from AHEAD software.
At Rs 8,000, it is ideal for both home and
office users, who burn CDs on a daily
basis and for whom time is a critical 
factor.

SPECIFICATIONS
24/10/40x speed, 2 MB buffer, tray interface,
SPDIF out

test drive ■
■ CD-Writers
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Yamaha’s latest speed demon

FireWire IEEE 1394
400 MBps (800 MBps is soon
going to hit the market)
Very few motherboards have this
port integrated. FireWire cards
are relatively easy to find 
nowadays
Expensive
No compatibility issues

Apple and the DV community. A
huge number of DV camcorders
and editors are already shipping
with support for FireWire

USB 2.0
480 MBps relates to a faster 
transfer rate
Next generation of motherboards
will have this integrated

Relatively cheaper
Peripherals meant for USB 1.1 can
still be run from this port
Intel's influence gives USB 2.0 a
big advantage. With motherboards
soon to have chipsets that directly
support USB 2.0, it will be the best
that could’ve happened to USB

Transfer Rate

Availability

Price
Compatibility with
older protocols
Who is backing
which standard?

USB 2.0 vs FireWire IEEE 1394: What's the Beef?

Fast and dosen’t burn a hole in your pocket

Decision Maker
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External Writers
Yamaha CRW 2200IX-VK
(20/10/40) FireWire
This is the only 20x FireWire writer avail-
able in the market. The FireWire writers
generally have a slower transfer rate than
USB 2.0 writers, but the Yamaha FireWire
impressed us with faster scores than the
USB 2.0 writer we tested. It took 302 sec-
onds (5 minutes 2 seconds) to burn the
ISO image on CD-R and 257 seconds (4
minutes 17 seconds) to burn the audio
CD. This makes it at least 10-15 per cent
faster than its USB 2.0 counterpart. The
writer was also fast in reading the data
and logged a read speed of 29x. The

Yamaha FireWire comes with

an 8 MB buffer, which makes it Burn-Proof
in the true sense. The writer weighed 1.58
kg, which puts it on the lighter side of the
external writers. The only problem a PC
user could face is in terms of FireWire sup-
port as most PCs lack this. The writer is on
the costlier side and comes at a hefty price
tag of Rs 24,000 (the FireWire card and
cables cost approximately Rs 6,000 extra).

SPECIFICATIONS
20/10/40x speed, 8 MB buffer, FireWire interface 

Acer CRW 4406EU (USB)
This is probably the cheapest external
writer one can get. It has a USB 1.1 inter-
face which makes it inexpensive but slow.
The writer took 1,275 seconds (21 min-
utes 15 seconds) to burn the ISO image
at 4X on CD-R and 1,045 seconds (17
minutes 25 seconds) to burn the audio
CD. To burn the assorted data on the CD-
RW, it took 1,180 seconds (19 minutes 40
seconds) which was less than the time
taken to write the same data on a CD-R
(1,189 seconds; or 19 minutes 49 sec-
onds). This Acer writer had a regular 2 MB
buffer and was equipped with Seamless
Link burn proof technology. 

It came bundled with Easy CD Cre-
ator 4.02 and DirectCD 3.0 burning soft-

ware. Priced at Rs 8,999, it is

the cheapest CD-Writer in the market.
However, given its slow speed, it’s not
suited for continuous writing work where
lots of data needs to be burned in a short
time. However, it will suit the needs of a
home user who has run out of a free IDE
connection and doesn’t want to spend
much on the writer.

SPECIFICATIONS
4/4/6x speed, 2 MB buffer, Seamless Link burn
proof technology.

HATIM KANTAWALLA AND YATISH SUVARNA
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Yamaha’s fiery FireWire writer

Less of a speed demon, more of value

1/2 page AD
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test drive ■
■ e-mail clients

E
-mail has become an integral part of digital life.
Unless you use it, you’re still trapped in the 20th
century. E-mail, hyphenated or not, has turned
out to be the ultimate triumph of Internet tech-
nology. Over the past few years, the Net has

come across some groundbreaking technologies, yet e-
mail still remains the nuts and bolts of the Web.

In this article, we flip through the chronology of e-
mail from its origins to now, a time where it has come of
age. Come along with us for a crash course in ‘E-mail Inter-
nals 101’ and later choose from some of the best e-mail
clients that speak the language of electronic mail.

Maybe it’s time we look back, see how far we’ve come,
blow out 30 candles, and pay homage to one of man’s great-
est achievements in the last century. The ubiquitous e-mail.

IN TEST

5E-MAIL CLIENTS

Eudora Mail 5.1  . . . . . . . . . . 64
The Bat! 1.53  . . . . . . . . . . . . 64
Outlook Express 6  . . . . . . . . 65
Microsoft Outlook 2002  . . . . 65 
Netscape 6.2 (Messenger)  . . 65

CONTENTS

30 years of e-mail . . . . . . . . 61
How e-mail works  . . . . . . . 62
E-mail clients:
Which one’s for me?  . . . . . 64
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30 years of e-mail

The most revolutionary communi-
cation tool since Graham Bell’s tele-
phone has just turned 30 and like a

fine wine, it just gets better. In the 21st
century, electronic mail has wormed its
way into our lives to the point that we
can no longer do without it. From our
personal lives to businesses, there isn’t a
single aspect in between where its influ-
ence hasn’t been felt. 

Today, the popularity and usage of 
e-mail ranks second after the telephone
but the gap between the two is steadily
tightening. Per day, an estimated 4 billion
e-mail messages flow through electronic
ravines and the figures are on the rise.
And why not? It’s a medium that com-
bines the best of the telephone and postal
mail.

Tracing the roots
In 1957, at the height of the Cold War,
the Soviet Union scored one against the
United States when it successfully put in
place the world’s first artificial satellite,
Sputnik I. To up the ante with the Soviets,
the US Department of Defense set up a
division dedicated to extreme technolo-
gy research, ARPA (Advanced Research
Projects Agency), which later fashioned
ARPANET. For the first time in history,
computers were able to exchange infor-
mation electronically.

In 1971 Ray Thomlinson, a program-
mer, created history by sending off the
world’s first piece of electronic mail. The
e-mail, was addressed to himself and the
body read the message, “QWERTYUIOP”
or “testing 1-2-3”. Two years later in order
to make e-mail easier to use, TCP/IP, the
language of the today’s Internet was born.
Many others have significantly con-
tributed to the evolution and progress of
e-mail and the ability to send attach-
ments and graphics are just some of the
advancements that hundreds of other
developers added in e-mail.

During the computer boom of the
1980s, the infrastructure was in place, set
to carry homes and offices into the Inter-
net age of the 1990s. As the growth of PC
sales continued to soar, the ban on com-
mercial traffic was lifted in 1991; this in
conjunction with the creation of the Web
browser was the big bang of the e-com-
merce age.

Throughout the decade, the Internet
continued to witness a dramatic surge in

traffic. Web-based e-mail services capi-
talised on the opportunity. Hotmail, the
most well-known e-mail portal in the
world, was later sold to Microsoft for $400
million in January 1998. The extreme suc-
cess of Hotmail spurred a trend where
competing portals would offer free Web
e-mail services to its devoted reader base.

Not a bed of roses
The sheer freedom and flexibility that 
e-mail offered has made it the number one
application used on the Internet. But with
the fruits of e-mail also come the pits of
invasion. In its early days, e-mail was a very
safe means of sending messages since the
e-mail itself consisted mostly of text. But
once e-mail was capable of carrying attach-
ments, malicious hackers started using it
to send viruses, Trojans and worms. 

As if this isn’t enough to force users to
take a cautious approach towards e-mail,
things get nastier with the abuse of unso-
licited e-mail, spam. Named after the tins
of American ‘SPiced hAM’, for each legit-
imate message sent across the Net, there
seems to be a disproportionately higher
amount of spam filled with promises of
getting filthy rich, shedding pounds off
your waist, and buying fabulous offers
that you can’t afford to miss.

Commerce takes a twist
The growth of e-mail has had a profound
influence on enterprise. Documents, visu-
al designs and just about any piece of busi-
ness correspondence can be sent instantly,
and at much lower costs than overnight
delivery services. E-mail has provided a
grand replacement for telephone calls in
many instances. What’s more, as this
medium is so informal, one doesn’t have
to worry about composing grammatically
correct words and sentences.

Since there is no paper involved, the
storing and retrieval of messages becomes
much easier and quicker with less space
consumed.

The next generation
There is no doubt that e-mail will remain
and continue to grow in terms of usage.
But at some point in the near future,
other marvels like this will have a similar
impact in the way we communicate—one
only has to consider the rate at which
Short Message Service (SMS) and instant
messengers are growing.
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How e-mail works

Each day, billions of e-mail messages
are sent across the Web through an
array of networks and servers.

Thanks to the easy-to-use tools that we
use to send and receive e-mail, the process
from our point of view is pretty transpar-
ent. All it takes is an e-mail address and a
message. It’s so quick and easy that you
could probably send over a half dozen
mail messages without even realising it.
No wonder it is such a popular
communication tool.

Ever wonder how that
electronic message is sent
across the world in just a mat-
ter of seconds? How is it that
e-mail always lands up in the
correct mailbox? The answers
to these questions are simpler
than you think.

Getting started
Aside from an Internet connection, the
only piece of software that you need to
install is an e-mail client. If you’re
already making use of electronic mail,
you might have the likes of Outlook
Express, Pegasus or similar programs
installed on your computer. E-mail mes-
sages are similar to letters sent by snail
mail and can be broken down into two
major parts.

One part of a mail message is known
as the header. Similar to an envelope, it
contains the name and address of the
recipient(s) and the subject of the 
message. Some clients also show your
name, address and date that the message
was sent.

The second part of an electronic mes-
sage is the body. Like a letter which can be
stuffed with text and pictures, the body
of an e-mail can hold text, images and
other various attachments like com-
pressed files. 

How it works
There are many computers linked to the
Internet which run software applications
dedicated to performing a particular task.
These servers, as they are called, can
either ‘serve’ Web pages, files or even
focus on the task of e-mail processing.
Once you’ve composed a message and
clicked the Send button, the e-mail client
forwards the message to a server which
takes care of all things related to the 
e-mail’s destination.

Both the e-mail client and the mail
server communicate using a specialised
language designed to handle the mail
that you send. This protocol, known as
SMTP or Simple Mail Transfer Protocol, is
the standard used across the Internet for
sending electronic mail. When you send
the message, the mail client sends it
across to a local SMTP server. Your ISP
usually has servers set up for these pur-
poses operating 24 hours a day. For

example, VSNL users in Mumbai
can use 202.54.1.18 as their
SMTP server.

Once your message is sent
to the local server, the first
step is to look up the recip-
ient’s e-mail address stored
in the header. Take an 
e-mail address, somebody@

somecompany.com for
instance. This address can be

broken down into two parts, the domain,
which in this case is somecompany.com
and the user name, somebody. If you were
to send a mail at this address, your mes-
sage would be forwarded to your local
SMTP server, which in turn would hunt
for the somecompany.com domain. Once

found, the message is passed to its desti-
nation and stored there until the recipient
is ready to download it.

When someone has sent you a mes-
sage, the SMTP server delivers it to some-
thing known as a Post Office Protocol ver-
sion 3 (POP3) server. Similar to how SMTP
is used for sending messages, the POP3
protocol is used to process the act of
receiving messages. 

Each incoming mail server assigns a
certain amount of storage space for every
e-mail account on that server. This space,
no matter how big or small, is called a
mailbox.

When you check your e-mail, the
mail software establishes a connection
with the mail server that holds your mes-
sages. If there are messages waiting, the
client will issue a series of commands that
begins the download of all correspon-
dence stored on the POP3 server.

As you can see, tracing the path of an
e-mail message is much easier than it
seems. Anyone in the world with a valid
e-mail address can send and receive mail.
Almost all ISPs and major online servers
offer at least one e-mail address with each
account.

Unlike letters, electronic mail lacks the
element of privacy. Hackers and other
would-be intruders can intercept a mail
message in transit or directly tap into
your mail server and read stored mes-
sages from there. Although you use a
password to download your messages,
the mail server doesn’t check to see that
the right person typed it in. Naturally, this
is a topic of utmost concern. 

If you want to keep your confidentiali-
ty intact, the way to go about doing it is
encryption. This is a process which
scrambles ordinary text into coded infor-
mation which can only be deciphered
with the help of keys. With 40-bit encryp-
tion, there are billions of possible combi-
nations to decode the information and
only one key can work. With 128-bit
encryption, there are 300 billion trillion
times as many possible keys as 40-bit
encryption. This makes it absolutely
impossible for an intruder to find the key
regardless of how powerful their 
computers might be.

Security features such as these do not
prevent you from browsing through the
Web nor does it place any limitations on
non-encrypted Web sites. The only thing
encryption delivers is security and, of
course, peace of mind.

If encrypted mail is an avenue that
you wish to pursue, PGP, or Pretty Good
Privacy, is the best way to go. PGP is the
de facto standard for encrypting electronic
mail on the Internet simply because it’s
easy to use, effective, and in most cases,
it’s free. In order to encrypt a mail using
PGP, you need to download the PGP
encryption package which is available for
download at many sources. Windows and
Mac users can download a copy from
www.pgp.com.

Keep in mind that if you’re sending a
PGP encrypted e-mail—the receiving end
will need it installed in order to decipher
the message. But there shouldn’t be any
reason to worry since PGP is available
across several platforms including OS/2,
Amiga and all flavours of Unix.              

Encryption
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Before e-mail software, checking 
e-mail wasn’t a simple mouse click
away. Back then, TELNET was the

only way to go. It was text-based, slow
and generally not so easy to use since
everything, right from logging in, had to
be done manually. Can you imagine 
having to connect, login and use a com-
plicated menu system just to check 
your mail?

With today’s software, all that mun-
dane work is completely automated but
it doesn’t just stop there. Reviewed here
are five mail clients that go beyond just
sending and receiving your messages.
Spice up your experience with some fea-
ture-packed software. After all, electron-
ic mail is only as good as you make it.

Whether its support for multiple users
that you need or just a slicker interface,
one of these packages will suit your needs.

Eudora Mail 5.1
Eudora is light, fast, and full of features,
but you need to pay $39.95 to get the 

ad-free version. This e-mail client has sup-
port for almost all security protocols, it’s
the perfect companion for PGP, and in
general, a highly usable interface makes it
an ideal choice for any power user.

Eudora possesses some robust features
such as auto redirecting mails, a plethora
of filter options at multiple levels, etc.  It
supports opening multiple windows. You
can define your own set of filters for the
received mail and if you have shared a
folder or mails with another user, then
there are a set of predefined filters which
can be automatically applied for scan-
ning attachments. This can be helpful
while sorting mail for multiple users,
and then sharing it over the network.
The PureVoice plugin in Eudora allows
you to send a voice message as an attach-
ment which can be opened using the
PureVoice plug-in on the other side.

Eudora’s functional interface is
extremely customisable, though it might
confuse first time users, as it takes some
time to get used to all the features it 
supports. 

Though Eudora has support for mul-
tiple user profiles, it is not as simple to
make use of this facility. To have multiple
user profiles on one computer, you will
have to create shortcuts to the Eudora
executable for each user, and map it to his
mail folder. 

Overall, the most customisable and
feature-filled of all mail clients, Eudora
fits the bill for almost all users because of
its ease in usability and multiple versions.
+ Support for voice e-mail
+ Allows multiple folder view in a single 
window
- Expensive
- Feature rich, but tough to configure for
first time users 
Price: $39.95 (approx Rs 1,918)
Web site: www.eudora.com

The Bat! 1.53
The first thing you will notice after con-
figuring this e-mail client is the mail
ticker which notifies you every time you
receive a mail—
you can click on
the ticker to read
the mail. The
Bat! possesses a
very good editor
which allows
you to compose
messages which
allows you to auto wrap and auto for-
mat text. By providing templates, The
Bat! simplifies the work of the user to a
great extent. On the flip side, this editor
does not allow you to create messages in
HTML format.

There are default templates for reply-
ing, forwarding, and read receipts that
can be edited as per the user’s need.
Apart from the standard set of templates
there is something called ‘quick tem-
plates’ in which users can create tem-
plates and add macros. This is especially
helpful in scripting the replies to similar
mails. You can script common replies,
adding specific customer information to
it using macros, and reverting back
quickly.

The Bat! comes with full support for
PGP keys and built-in encryption. It
doesn’t require any other tool like
PGPFreeware to be installed. The multi-
ple level sorting and filtering capabilities
are commendable too and go far beyond
other tools.

The ‘parking’ feature prevents you
from accidentally deleting important
messages.

If you want an e-mail client which is
not only easy to use but also boasts of
powerful filtering, sorting and security
capabilities, then this e-mail client is
meant for you. However, it is quite expen-
sive for $36 for a single user business
license. 
+ Exceptional sorting and filtering 
capabilities
+ Provides good security features
- Cannot compose messages in HTML 
format
- Expensive
Price: $36 (approx Rs 1,728) (business-
single user) 
Web site: www.ritlabs.com

E-mail clients: which one’s for me?

There can be a number of reasons that
prevent a message from being delivered
to the recipient. Here are some of the
more common errors that cause a mail
to bounce back to you and what they
mean.
■ Lack of disk space: If a recipient’s inbox
is full, they will not be able to accommo-
date further messages stored in their
inbox unless some space is freed. Usually,
errors such as these remain oblivious to
the mail account holder.
Steps to take: In such cases, your local
mail server will not attempt to resend

the message at a later time. You will
have to send the message again once
the user has erased some of their mail.
■ User or e-mail address unknown: This
is a common problem which tells you that
the mail has reached the server correctly,
but not the user’s mailbox. Either the per-
son’s e-mail address is no longer valid or
there are some problems at the destina-
tion’s mail server.
Steps to take: Again, the mail server 
will not try to send another 
message automatically. You’ll have 
to resend it.

Common E-mail Error Messages Decoded
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Outlook Express 6
If you have Windows installed on your
machine, you are likely to have a version

of this e-mail client on your computer.
Outlook Express has evolved from a
faulty, buggy and insecure 
e-mail client to a slightly more stable but
still quite bland client. But it remains an
easy-to-use option.

It allows you to create folders and set
basic filters and rules to them. It supports
the NNTP protocol, making it easy to col-
laborate with newsgroups. The easy-to-use
interface makes it a favourite with most
desktop users. The integration with
Microsoft’s Hotmail service means that
you can read your Hotmail messages with-
in the client and store them offline if you
like. With the latest release, Outlook
Express has become more stable. Howev-
er, it is more vulnerable to viruses than
other clients due to its support for
VBscript, which is on by default but can
be turned off. Be ready to download and
install patches any time Microsoft releas-
es a new update, as this is one of the
hottest exploits around. 

If you need multiple user support,
Outlook Express is the best bet. It can
handle multiple e-mail profiles and con-
figure each to access various e-mail
accounts. Each user profile can have  cus-
tomised settings, mail profiles, etc. The 
e-mail editor is also quite good. It pro-
vides all features right from formatting
text to adding background colours. Sup-
port for basic templates is also a nice
touch.
+ Very simple and easy-to-use interface
+ Comprehensive feature set
- Vulnerable to viruses
Price: Free for use (comes bundled with
Internet Explorer)

Microsoft Outlook 2002 
This e-mail client, part of the Microsoft
Office Family, is also sold as a standalone
program. It’s a complete personal infor-
mation manager which takes care of your
mail, appointments and other daily sched-
ules and reminders. You can automate
actions linking two activities together, for
example, planning a meeting and sending
the schedule to the relevant people auto-
matically.

When com-
bined with an
Exchange 2000
server in organisa-
tions, Outlook
2002 allows you to
send notifications
for meetings and
appointments including task report noti-
fication to a whole group, maintained on
the server side. You can set alarms to be
reminded of pending tasks or appoint-
ments. This version does not have any

drastic improvement over the previous
one, but the subtle changes make it a pleas-
ure to work with. Features such as colour
coding, group scheduling, improved inte-
gration of WinWord for editing/compos-
ing mails and implementation of task pane
and voice capability make it a favourite
amongst business class users.  

Microsoft has beefed up the security
features and made this program quite
resilient to viruses. It has also integrated
MSN messenger service which was previ-
ously missing.

Overall, this program is an excellent
Personal Information Manager—useful
for executives who need help keeping
track of their daily chores. To unlock its
full potential (especially the collaboration
features) you should use Outlook 2002 in
a corporate work environment along with
Exchange 2000.
+ Takes care of all the needs with respect to
e-mailing and task scheduling 
+ Support for Exhange2000 server, integra-
tion with Office XP
+ Extremely easy to operate
- Requires Outlook Express to be installed
Price: Rs 5,000
Contact: Microsoft Corporation India P Ltd
Phone: 011-6294600
Fax: 011-6292650
E-mail: msconnect@microsoft.com 

Netscape 6.2 (Messenger) 
The new Composer can add numerous 
e-mail accounts and working is simpler.
Like all e-mail clients, this one too allows
you to add customised filters for messages,
and the new version includes a set of tem-
plates for easy and quick replying. It does-
n’t support VB scripting. So it’s not prone

to be infected
with viruses that
use VB script for

executing. Composer supports sharing of
the e-mail folder for others to view. But
here one must manually scroll to the mail
folder and then share it. Like Outlook
Express, it supports news servers and works
well as a newsgroup client. Overall, this is
a good e-mail client and desktop users not
satisfied with Outlook Express (and it’s
security) will be safe with Composer. 
+ Good sporty interface
+ Does not support VB scripting
- No support for plugins
Price: Free for use (comes with Netscape
6.2 browser)
Web site: http://browsers.netscape.com/
browsers/main.tmpl

PRASHANT MASRANI

Plug-ins
PureVoice Player-Recorder
LifeFX FaceMail
SMSReminder
VoiceNotify

Anti-virus and security
PGP
Norton AntiVirus 2002
AVG
F-Secure

Spam filters
SpamKiller
EMail Sentry
AvirMail
Spam Buster

Top e-mail related downloads

What you Need in an 
E-mail Client
■ Interface: Since e-mail is going to be
a regular chore, it’s best to use some-
thing that you are comfortable using.
■ Features: Test the features that you
will be using commonly, say an address
book. If you have a wide base of con-
tacts, you’ll need multiple address books
and perhaps a bulk-mailing feature.
■ Security: If security is an issue, make
sure the software comes with some
form of built-in encryption such as PGP
and MIME.
■ Customisation: Taking care of multi-
ple e-mail accounts can be rather
painful; ensure that each user of your
computer can segregate their settings
from yours.
■ Protocol Support: Essential for POP3
and IMAP4 in order to ensure universal
access with various types of mail clients.
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This Logitech Freedom
optical keyboard and

mouse is a whole standard
apart from your typical mouse
and keyboard combo. It con-
sists of a wireless keyboard
and an optical mouse. The
keyboard sports ‘space age’
looks and is very comfortable
to use. The layout of the
shortcut keys is just right and
they are easily accessible. The
other buttons are well laid out
too and they have a great feel
to them. Using the bundled
iTouch software, the keyboard
can be easily configured for all
the extra shortcut keys. The
packaging of the product is
excellent and comes bundled
with the manuals, driver CDs,
MouseWare and the iTouch
software, spare batteries and
the receiver. The keyboard
and mouse communicate
through radio waves and
work surprisingly well even
beyond the specified range of
6 feet. The optical mouse has
a resolution of 800 dpi and

uses no moving parts, which
means there’s no cleaning
required. The provided scroll
wheel feels handy while
browsing the Net. The mouse
buttons can be configured
easily through the Mouse-
Ware software. 

If you want an ‘ordinary’
keyboard-mouse combina-
tion then this set is definitely
not the one for you. It
requires 4 AA batteries for the
keyboard and 2 AA batteries
for the mouse and the average
battery life span that we have
generally observed for devices
such as these is around four
months. Priced at Rs 8,000, it
is clearly the most expensive
combination of input devices
that you can buy.

SPECIFICATIONS:
Infrared mouse included; many func-
tions such as browser launch; iTouch
software to configure keys for various
applications; in-built clickable wheel
on the keyboard

Price: Rs 8,000
Contact: Rashi Peripherals
Phone: 022-8260258
E-mail: ho@rptechindia.com
Web site: www.rptechindia.com

This 16x DVD drive
from AOpen comes

with Dynamic Damp-
ing System, which helps
in nullifying the vibration
that is generally present in
high-speed drives. The drive
has excellent build quality and
comes bundled with the
Cyberlink PowerDVD 3.0 soft-
ware DVD player. It performed
very well in the test suite—it
never skipped a frame and
played the DVD impeccably.
We tested the drive for DAE
performance wherein it
extracted a 50 MB track with-
in 31 seconds, proving itself to
be quite a force to reckon with.
However, it took more time
than similar speed DVD drives
when subjected to the file
transfer test. Opening 10 TIFF
images from the drive in Pho-
toshop took around 71.65 sec-
onds—slightly on the higher
side. The access time logged

was 64 ms, which is
really low.

Though this is
certainly not

the fastest
speed of access that you

can get, this drive will serve
the purpose well, if you want
to have only one drive for all
purposes—CD as well as DVD.

This AOpen drive costs as
less as Rs 4,500. When you
couple the price with the
drive’s decent performance,
you have a really affordable
DVD drive on your hands. 

Price: Rs 4,500
Contact: Yogi Comp
Phone: 022-8806582
E-mail: yogicomp@netkracker.com

SPECIFICATIONS:
16x DVD speed, 48x CD speed, 256
KB buffer, DDS (Dynamic Damping
System)
Benchmarks: 2030 in CD Winbench
99; 64 ms random access time in
SiSoft Sandra 2001te; 33 seconds to
rip the outermost track which was
61.26 MB in size

Aopen DVD-1648

Performance 1/2

Build Quality
Value for Money
Features 1/2

OOVVEERRAALLLL 1/2
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AOpen DVD-1648
Driven performer

The Canon CanoScan is
just a little over an inch

thick. This scanner can
even be kept vertical
on the saddle that
comes along
with it while
scanning documents.
This will prove especially use-
ful if you have limited desk
space. The scanner comes

with Adobe Photoshop Ele-
ment, ArcSoft PhotoBase, and

ScanSoft OmniPage OCR
software. Its

preview time
was logged at

19 seconds,
which is a little on

the higher side due to
the initial warm up time
taken by the scanner. But

Logitech Cordless
Ease of use
Build Quality
Value for Money 1/2

Features
OOVVEERRAALLLL

A-A-

A speaker system, an MP3 player, an optical keyboard and mouse,
a tool for creating Flash effects, a data recovery utility and more...

Bazaar
Logitech Cordless 
Freedom
As good as it gets

Canon CanoScan N1240
Smart scanner



once the scanner is in regular
use, the scans are fast. 

The scanner picked up
minute details in the test
photograph, such as wrinkles
on the face and the texture
on the fabric. The colour
appeared a little brighter than
in the original photograph.
The scanner depicted all five
colour blocks that were used
for the resolution test at 1200
dpi. Generally in this test,
most scanners depict the 

difference between two lines
up till four blocks and scan
the fifth as a solid block. The
scanner is expensive but the
quality is top-notch and it is
a silent operator.
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This speaker system is
powered by two satellite

speakers and one 8-inch sub-
woofer. The subwoofer was

amply powered but the satel-
lite speakers proved to be the
weak link as the size and per-
formance of the satellites did

not seem to match with the
sub. Installation was quite
simple as the Labtech Pulse
does not require any drivers
or files to be installed. A
handy little instruction
manual shows the detailed
procedure of connecting
one colour-coded plug to a
jack on the back of the sub-
woofer and another colour-
coded plug to your PC’s
audio-out jack. Aesthetically
speaking, the black coloured
speakers might fascinate
some users as they have a
sleeker, aerodynamic look as
opposed to the box shape of
other speaker setups. We
played a standard set of
audio, MP3, VOB files and a
DVD and found that the
speakers were pretty decent
in sound reproduction in all
of these. Also, when tested
with Quake III, the panning
and firing sounds were all
reproduced very well. There

was minimal distortion at
higher frequencies and the
speaker setup held itself well
at higher volumes except for
the fact that you sometimes
felt the lack of a little more
‘twang’ at the higher end of
the frequency spectrum.

Overall, this speaker sys-
tem would be ideal for those
who like an excellent 2.1
speaker setup. However, for a
2.1 setup, Rs 4,200 it is a bit
too much.

Price: Rs 10,995
Contact: Canon India 
Phone: 011-6806572
E-mail: brijesh@canon.co.in
Web site: www.canon.co.in

SPECIFICATIONS:
1200x2400 dpi resolution; USB 1.1
interface; 48-bit depth; A4 size scan
area
Benchmarks: 19.6 seconds preview
time; 56.19 seconds to scan photo-
graph in full colour mode at 300 dpi

Canon CanoScan
Performance 1/2

Build Quality
Value for Money 1/2

Features
OOVVEERRAALLLL 1/2

B-B-

This is probably the fastest
office application-orient-

ed PC you’ll find in the mar-
ket. Powered by a P4, 1.5 GHz
and 128 MB RAM, this
machine isn’t built for high-
end graphics performance

and has a basic integrated SiS
300 graphics subsystem—try-
ing to run 3DMark 2001 or
Quake III would have proved
futile. Nevertheless, in the
Business Winstone 2001 test,
it scored 35.2, indicating that

it will take care of all your
general office applications,
accounting software and low-
end graphics applications. In
Content Creation Winstone
2001, it scored a trifle low at
42, indicating that its proces-
sor was being bottlenecked
by the platform and memory
subsystem. A score of 40 in
this test should be considered
the bare minimum. The
machine’s build quality is
pretty decent and it comes
bundled with Windows Me.

Price: Rs 51,999
Contact: IBM India
Phone: 022-8353131
E-Mail: adildoct@in.ibm.com
Web site: www.ibm.com

IBM NetVista A22P 
Just right for Office

IBM NetVista A22P
Performance
Build Quality
Value for Money
Features
OOVVEERRAALLLL

BB

SPECIFICATIONS:
P4-1.5GHz; 128 MB RAM; Maxtor 
20 GB IDE hard drive; E54 15-inch
monitor 
Benchmarks: 35.2 in Ziff-Davis
Business Winstone 2002; 42 in ZD
Content Creation Winstone 2002 

Labtech Pulse-424 
Sound, sweet sound

Price: Rs 4,200
Contact: Rashi Peripherals
Phone: 022-8260258
E-mail: ho@rptechindia.com
Web site: www.rptechindia.com

Labtech Pulse-424
Performance 1/2

Build Quality 1/2

Value for Money
Features
OOVVEERRAALLLL

BB

SPECIFICATIONS:
3 speakers; 20 Watts RMS sub-
woofers; 32 Watts RMS power out-
put; power supply: internal 

Napa DAV315
Delivers what it promises

The most economical and
reliable bet in CD MP3

players yet. For the price that
this player comes at, you can’t
get anything even remotely as
good in India. The Napa
DAV315 is a portable MP3-CD-
Player with a 120 second skip
buffer that actually works, and
works very well too. It even
survived a real trek without a
single skip, so you can be sure
that it won’t skip during your
regular Sunday morning jog. It
will not fit into your  pocket
but comes with a carrying strap
that attaches firmly to the MP3
player, letting you hang it com-
fortably around your neck. 

The bundled earphones
aren’t too good—this one is
not powerful enough to drive
our AKG K44 reference head-

phones to their full poten-
tial—but they don’t disap-
point when used with stan-
dard Philips earphones. The
player is crisp on mids and
highs but a little low on bass.
This can be attributed more to
the earphones rather than the
player. The Napa reads all pos-
sible MP3 formats including
VBR MP3s, and from all CD
media, ranging from CD-Rs to
RWs and even CDs burnt
using multiple sessions. There
are five preset equalisers avail-
able, but they are better left



you can easily overclock the
machine without fears of fry-
ing the processor. What this
utility does is that it auto-
matically overclocks the
processor through 1 MHz
increments and checks for
system stability. You can then
choose to run the system at
the higher frequency. 

The benchmark scores
were, nevertheless, nowhere
close to what you can gener-
ally expect from a machine
using RDRAM, and consider-
ing the fact that the proces-
sor interface adopted was
Socket 478, this mother-
board would ideally be
meant for the 2.0 GHz and
above range of processors
from Intel. Pairing such a
fast processor with SDRAM is
truly bottlenecking the

processor to a great extent
and is not recommended.
Nevertheless, it is a feature-
packed board with onboard
sound and an onboard
Promise IDE RAID controller,
which supports RAID 0 or
RAID 1.

Price: Rs 6,500
Contact: Rank Data Products
Phone: 022-3873168
E-mail: rankdata@vsnl.com

Soltek SL-85SD 
Performance 1/2

Build Quality
Value for Money 1/2

Features
OOVVEERRAALLLL 1/2

B+B+

With 56x drives now
almost becoming the

standard, this drive at
52x speed is a tad
slow and gave
below average
performance in
almost all the tests. 

The SiSoft Score of
1660 logged by this drive
was way below as compared
to other 52x drives, which
normally score in the range
of 2000 for this test. The
audio ripping was also not
very fast; it took a little
under 48 seconds to rip the
innermost track of the audio
CD which was 72.83 MB 
in size. 

The only thing going for

this drive however was the
random access time. It

scored a neat 51
ms, which is
a better score
when com-

pared to other
competing drives. 
This is just

another drive with very
little to talk about in terms of
performance. The pricing too
is a little on the higher side.

Sony CDU5211 (52x CD-ROM Drive)
High price, average performance

The Napa DAV CD-MP3 hits
the sweet spot with skip-
free playback and a
reasonable price tag

“
Aliasgar Pardawala
Reviewer

SPECIFICATIONS: 
3 DIMM slots supporting SDRAM PC
133; AGP 4x slot; 6 PCI slots; CNR
slot; 4 USB Ports and integrated IDE
RAID controller
Benchmarks: 55.7 fps (normal
mode), 55.2 fps (high quality mode),
53 fps (max settings) in Quake III
v1.30; 66.2 in Content Creation;
drive index of 22009 in SiSoft Sandra;
29 MBps sequential read, 6 MBps
random read; 39 MBps sequential
write; 8 MBps random write speed; 8
ms average access time

”
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The Soltek SL-85SD is
Soltek’s solution for users

who would like to go in for a

Pentium 4-based system
based on the 845 chipset
using ordinary SDRAM. It
supports Pentium 4 proces-
sors with the Socket 478
interface. There is support for
up to 3 GB of PC-133 SDRAM
through three DIMM slots.
The packaging of the product
was very good and it came
with a detailed manual and a
driver CD along with the
unique RedStorm overclock-
ing utility. With this utility,

Soltek SL-85SD Motherboard
Packed with promise

alone as that brings down the
volume level a bit. 

The best part is that this
player comes with an adapter
and rechargeable batteries, so
just plug the adapter into a
wall socket, put in the
rechargeable batteries, and it
charges quickly enough to last
you for a long jogging trip, or
the hour-long journey to
office, and more. You can use

two regular AA alkaline batter-
ies to keep it alive for around
six-seven hours easily. All this
for a price of only Rs 5,000,
which is half of that of other
popular CD MP3 players.

Price: Rs 4,500
Contact: Moon Computers
Phone: 022-2653390
E-Mail: sales@moonindia.com
Web site: www.moonindia.com

SPECIFICATIONS:
120 second skip buffer; reads CD-Rs
and CD-RWs; rechargeable battery
included

Napa DAV315
Performance 1/2

Build Quality
Value for Money 1/2

Features 1/2

OOVVEERRAALLLL
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Price: Rs 2,200
Contact: Rashi Peripherals
Phone: 022-8260258
E-mail: ho@rptechindia.com
Web site: www.rptechindia.com 

Sony CDU5211
Performance
Build Quality
Value for Money
Features
OOVVEERRAALLLL 1/2

BB

SPECIFICATIONS:
128 KB buffer; single and multisession
compatible 
Benchmarks: 1660 in Ziff-Davis CD
Winbench 99; 2784 Kbps sequential
read speed
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HDD Sheriff 2000 is a
hardware-based solution

for protecting the data on
your hard drive by taking a
backup on the partition
(which is configured while
installing the software). Dur-
ing installation, you can
define the amount of disk
space to reserve for backups.
The interface is easy and sim-
ple to use but there is no help
provided in the main inter-
face. Your only source of help
is the manual which explains
everything with screenshots.
There are four modes of oper-
ation—two supervisor modes
and two protection modes.
Protection modes are the
normal user modes, and all
changes that are made to the
file system, deletions, FDISK,
etc, are ignored when the sys-
tem is rebooted. You can
make permanent changes to
the drive only when you are
in the supervisor mode. The

software
also lets you

multi-boot the
system, protects at least four
hard drives or up to 10 logi-
cal drives on the PC, and lets
the system be used by multi-
ple users with individual set-
tings. A value-for-money
product that can eliminate
almost all chances of data
being mishandled or deleted
from your machine.

Price: Rs 3,490 (single user)
Contact: Maatra Technologies
Phone: 9520-4221222
E-mail: info@maatratech.com
Web site: www.maatratech.com

SPECIFICATIONS:
1.14 MB installs size; available in PCI
and parallel interface

HDD Sheriff 2000
New Sherrif in town

HDD Sheriff 2000
Performance 1/2

Build Quality 1/2

Value for Money
Features 1/2

OOVVEERRAALLLL 1/2
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Coffecup Firestarter 4.2 lets
you create Flash effects

that can be easily included in
your Web page to make it
more attractive. The built-in
sound and GIF images make
the task easy for the develop-
er, especially newbies. 

It generates HTML code
for whatever you
create, which can
be viewed for ver-
ification. Strange-
ly, though the
Firestarter doesn’t
allow you to
change the HTML
code from within
its notepad, it

allows copying the code into
the Web page. After creating
the effects, you can view it by
just clicking on the test but-
ton. 

With Coffecup, making
splash screens becomes very
easy using the built-in effects
such as ‘Explode’ and ‘Shrink’.

Coffecup Firestarter 4.2
Coffee for a starter

Firestarter even allows for
converting WAV files to MP3s
and GIF to Macromedia Flash
(SWF) and uploading to the
FTP.  The download size of the
trial version is 3.2 MB and 
the full version can be yours
for $49. 

Price: Rs 2303 (approximately)
Web site: www.coffeecup.com

SPECIFICATIONS:
3.2 MB download size; allows 
import of animated gif files; SWF
files up to 80 per cent smaller in 
version 4.2

Coffecup Firestarter
Performance 1/2

Ease of use
Value for Money 1/2

Features
OOVVEERRAALLLL 1/2
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EasyRecovery is a data
recovery solution from the

world-renowned system utili-
ties developer, Ontrack. It lets
you recover files and data 
lost due to a hard drive or a
system wide crash, power
surges, etc. During the test, we
purposely deleted randomly
selected files. It took around
10 minutes to recover these
files which were around 24
MB in size. 

The interface resembles
the system suite utility of

Ontrack. It runs on Windows
95/98/2000/ and NT and
through the emergency boot
disk feature, you can create
emergency floppies so that
the system doesn’t boot in
Windows and the files can
still be recovered through
DOS mode. EasyRecovery can
also perform a comprehensive
diagnostic test on your hard
drive just like scandisk and it
lets you know the status of
your drive—whether or not
the lost files can be recovered
from the partition. 

Price: $489.00
Web site: www.ontrack.com 

EasyRecovery Pro 5.0
Get it back

Easy Recovery Pro 5
Performance 1/2

Ease of use
Value for Money
Features 1/2

OOVVEERRAALLLL

BB

SPECIFICATIONS:
Can recover files and folder of all
types; works with Windows
95/98/2000 and NT

The Panda sports a more
intuitive interface than

other competing anti-virus
suites. It also has the highest
number of anti-virus defini-
tions, which are updated
almost on a daily basis. The
user will have to use the spe-
cific user name and password
to log on to the FTP server to
download the definitions. 

This software also has the
facility of monitoring Inter-

net activity thereby giving
you complete protection in
the Internet age. You can
even block certain ports so
that your computer remains
protected (like a firewall).
Needless to mention, like all
anti-virus products, even
Panda has a heuristic scanner
wherein the scanner can
detect new viriuses on the
basis of behaviour. It can 
also scan through e-mail

Panda Antivirus Software
Panda on guard
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messages contain-
ing nested tables,
compressed files,
audio, video, etc.

If your machine
is connected to a
network and if a
virus is detected,
Panda allows you to
send warning mes-
sages to the workstation
servers through e-mail or send
an alert to the server. 

Another feature this soft-
ware boasts of is the 12-hour
SOS service—if the software
fails to cure a virus, you can
send a sample across to the
customer support team which
will then try and provide a
solution to the problem. This
keeps your work and produc-
tivity unaffected. 

This anti-virus software

does not have fast
scanning capabili-
ty and if you hap-
pen to be using a
program called
Morpheus, then
Panda will detect it
as a virus. This
problem has yet to
be resolved by the
developers. How-

ever, it is a brilliant product
overall. Make sure you have
sufficient memory as Panda
is a real memory hogger.

SPECIFICATIONS:
Highest number of virus definitions;
good protection capabilities from the
Internet

System Commander 7 is a
utility that offers you the

luxury of having more than
one operating system on
your hard drive. In fact, if
you wish, you can have as
many as 32 FAT compatible
OSes on the
hard drive.
System Com-
mander 7 also
has in-built
features to
partition the
drive without losing data.
Once installed and restarted,
the user is greeted with cool
screens which show the
details of the operating 
systems installed on the PC. 
All you need to do is click on
the icon. The icon of the
operating system displayed
can be changed from the Set-
tings tab.

System Commander sup-
ports all the major operating
systems such as Linux,

Solaris and OS/2. Usually,
the Solaris operating system
doesn’t let you boot the
machine if it is not installed
on the Drive 0. You then
need to boot the system
through a diskette, but this

has been
taken care of
by System
Commander.
The in-built
security fea-
ture prevents

other people from using it
because the program gener-
ates a login ID and password
while installing the software.

System Commander 7
One is not enough

If you are thoroughly
bored of your dreary

Windows desktop and
want to modify  its looks,
DesktopX 1.0 is the tool
for you. It comes with a
variety of readymade
themes and at the same
time allows you to create
some of your own. It is very
easy to use since there are no
command line operations
involved. You can use it to
make the desktop more ori-
ented to your style of use; it
helps navigate faster and
more efficiently. 

The DesktopX 1.0 can cre-
ate easy-to-understand icons
for users new to the PC realm.
It can also be used to make
the desktop resemble other
OSes such as the Mac OS,
Amiga, etc. The themes can be
downloaded from the Inter-
net. Although DesktopX 1.0
claims to use very little

resources, it got a little slower
and the mouse movements
got a little sluggish when we
loaded the inputs. 

DesktopX 1.0 is recom-
mended only if you have a
healthily (256 MB RAM and
more) configured machine
and are ready to tinker around
with the OS. 

DesktopX 1.0
New look for the desktop

Price: Rs 937.65 (approoximately)
Web page: www.stardock.com

SPECIFICATIONS:
3.2 MB download size; allows import
of animated gif files; SWF files up to
80 per cent smaller in version 4.2

DesktopX1.0
Performance 1/2

Ease of use
Value for Money
Features
OOVVEERRAALLLL

B+B+

Price: $29.95 (downloadable)
Web page: www.v-com.com

SPECIFICATIONS:
Support for most of the OSes; allows
up to 56 primary partitions on up to
14 drives; boots from floppy even if it
has been disabled in the BIOS

System Commander 7
Performance 1/2

Ease of use 1/2

Value for Money
Features 1/2

OOVVEERRAALLLL 1/2

B+B+

There are daily updates for
Panda Antivirus, which
ensures protection against
even the latest viruses

“
Yatish Suvarna
Reviewer ”Panda Antivirus

Performance
Ease of use
Value for Money
Features
OOVVEERRAALLLL 1/2

B+B+

Price: Rs 1,800
Web site: www.pandasoftware.com
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■ undercover

Anti-virus protection is dandy, but
how do you safeguard against los-
ing valuable data to a black out? As

an undercover agent I am generally pre-
pared for anything. But the other day I was
caught unawares. Hard at work on a par-
ticular assignment, my PC suddenly went
on the blink thanks to an electrical failure.
As I sat there in the darkness hoping  I had-
n’t lost any data, I resolved to
upgrade my kit with the best
protection for such occur-
rences—a UPS.

Chancing on a comput-
er shop in Andheri, I asked
for a UPS for my PC. He asked
me where I lived. Taken aback, I
asked him why he wanted to
know. His answer: “Most suburbs in
north Mumbai face acute power
problems and hence a UPS is recom-
mended. Otherwise an ordinary
power strip would be more than
sufficient.” “But how will a
power strip help when
a brown-out occurs?”
I argued. His logic was
that brown-outs don’t
occur too often. Well, he
was mistaken and I soon
found that very few PC
and electronics deal-
ers knew much about
the vagaries of power. A
brown-out happens when lower than nor-
mal line voltage is supplied by the power
company. A power line voltage reduction
of 8 to 12 per cent is usually considered a
brown-out. 

Hoping to find a better solution at an
electrical hardware shop, I walked into one
and asked about how best to guard my PC
in case of a brown-out. This chap knew
what he was talking about. He told me
how brown-outs cause unregulated power

supply to the computer.
Power supply problems are
far too complicated and con-

voluted errors due to erratic
power supply can
creep into almost
every single PC
operation.  

My next stop
was Lamington

Road. The first deal-
er I spoke to recom-

mended a UPS from
APC. He said they are the

best and the most afford-
able. “The APC Back-UPS 500

AVR is the most popular of all the
APC models and is widely recom-

mended and sold too. You can
get it for about Rs 4,500”.

He added that unless I
had a 17-inch or higher

monitor with
printers, scanners and more than two
ATAPI devices (more than one CD-ROM
and one hard drive), this UPS would suf-
fice. Otherwise I’d have to go in for one
with a higher VA rating. 

At my next stop I told the vendor that
I needed a UPS but didn’t know how to
calculate the VA rating. He confessed that
he didn’t know either, but he did know
that 500-650 VA is enough for must PC
users. True. But if you have a 19-inch
monitor and several other power con-
suming hardware then 1 KVA would be
the minimum you’d require. 

Another vendor told me that the TVSE
line of UPSs was doing well too. I asked
him how he’d rate the local (home made,
assembled, or unbranded) UPSs. Accord-
ing to him, local manufacturers were pret-
ty good when it came to day-to-day
working but they lacked consistency and
had flaky support mechanism. 

One vendor told me that for home
usage, an offline UPS is the only way to
go. An online UPS would be too expen-
sive and is recommended only if you are
running an expensive PC for critical

applications and data. He also rightly
added that an offline UPS has a
switchover time (from mains to battery
power) of milliseconds, which most
power supplies can handle very easily
without resetting the PC.

Another vendor said the ideal environ-
ment to run any electronic equipment was
to run a voltage stabiliser along with a reli-
able offline UPS, or use a line interactive
online UPS because most UPS systems
operate your computer directly off your
‘dirty’ power, except during periods of lost
power or brown-outs. Unfortunately, most
UPS systems have limited spike suppres-
sion and virtually no interference filtering

capabilities. Also, during brown-outs your
UPS may continuously alternate between
the power from the mains and the UPS
power and this discharges batteries and
thrashes the PC at the same time. But he
also said that the APC UPS was definitely
a cut above the rest and highly recom-
mended. He suggested that one should
keep aside 10  per cent of the PC budget
towards voltage stabilisers, UPS, power
strips etc. Lastly, he advised on ensuring
that all power connections are properly
earthed and not loose.

■ To buy a UPS all you need to
do is add up the total power
draw of your equipment.

First, decide which pieces of equip-
ment need UPS support. Typically, only
the CPU and monitor are supported to
cut down on power draw to the UPS. 
■ If the power draw is expressed in Amps
then multiply that value by your nominal
line voltage, 230V. If the power draw is
expressed in Watts, multiply by a factor
of 1.3 to 1.4 for VA load.
■ Example: 250 Watt power supply (x 1.4)
= 350 VA load (assuming that your moni-
tor is drawing power from the power sup-
ply of the PC). Add a measure of safety
and 500 VA is enough for most PCs.

Monitor Hunting
Imagine buying a 17-inch monitor
for less than Rs 10,000. Yes, It’s very
much possible now! A majority of

the popular brands and makes have
reduced their prices and have finally
broken the Rs 10,000 barrier. With a little
bargaining you might even get a 15-inch
monitor for less than Rs 6,500. 

A little hunting will also fetch you
amazing prices for some of the brands.
The lowest we found for a 17-inch was
Rs 8,000. So go sniffing! 

UPS and

ILLUSTRATION: Mahesh Benkar
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Acomplete mobile computing experience. Sounds weird
to you? Not really. Just stop a while to consider how each
generation of handheld has improved, how each new
release is capable of doing much more than was possible

earlier. And you will realise that handhelds are closing the gap in
the race with desktop PCs fast—at least in terms of functionality.

Microsoft is no newbie when it comes to handhelds. Earlier
devices powered by the Windows CE platform weren’t exactly
avant-garde. In fact, their presence on the market hardly left an
impression. With the third version of the CE software, now called
Pocket PC, Microsoft is hoping that it will be luckier the third
time round. Looking back at the previous avatars of Pocket PC,
this one is certainly attractive. But is a Pocket PC everything we
want it to be in computing and gadgetry?

What does the Pocket PC offer?
If you’re looking for a direct replica of your desktop’s entire appli-
cation suite, then the Pocket PC is not for you. It doesn’t offer all
the functionalities, not  yet. But if you’re looking for a core of neat
utilities, Pocket PC is a platform that holds its own. It sums up the
most useful tools for the mobile user, and then gives you some
more. It boasts of tasks ranging from basic Internet applications
and multimedia to managing spreadsheets and documents.

The word’s out
You can use Pocket Word to access and edit MS Word documents
on your handheld and make changes using the stylus as a writing
tool, or by simply tapping the onscreen keyboard. Several advanced
features such as macro support and Thesaurus have been left out,
but it does have some of the key features of MS Word—the spell
checker and the ability to use RTF files. Unlike Palm’s memo pad,
which is its primary means of entering short text-based informa-
tion, Pocket Word allows for the formatting of documents.

Pocket Excel 
As its name suggests, Pocket Excel is a scaled-down flavour of
Microsoft’s popular spreadsheet application. Considering that its
purpose is to offer mobile finance calculation, you would expect
Pocket Excel to do well despite being stripped of its powerful fea-
tures. Unfortunately, with the Pocket PC’s small screen size, you
can view only a limited amount of data at a time and you are
forced to keep scrolling through the pages to get at the bigger
picture. However, one useful feature that the Pocket version car-
ries is the tabs located at the bottom of the screen that let you tog-
gle between multiple spreadsheets.

Just browsing through
Internet Explorer on the Pocket PC is an application, which acts
as a clear separator between the Pocket PC and Palm platforms.

The Pocket PC
examined A close look at the Pocket PC, the tools it offers,

and where it’s headed

PHOTOGRAPH: Jiten Gandhi, IMAGING: Ram



With the Pocket ver-
sion, you can easily
view Web pages
without requiring 
a special modem.
With Microsoft

ActiveSync and a combination of certain Web services, you can
download a collection of Web pages onto your Pocket PC and use
the browser to view them later when you’re on the go.

Funnily enough, Pocket PC features Windows Media Player,
but before you get excited about it, take into account the 16 MB
to 64 MB of storage space, most of which is already being used by
applications. Even if you have its entire capacity at your disposal,
can you really store a decent collection of videos, or even songs for

that matter? At best,
the Pocket PC plat-
form is suited only
for small clips of
audio, or for taking
notes, perhaps. But if
you do insist on
watching movie
clips and listening to
MP3s, the only way
to go is to purchase

memory upgrade cards, or better still, IBM’s Microdrive. 

Microsoft Reader
If you like to read while travelling, you will definitely appreciate
Microsoft Reader, which is designed to use e-books or electronic
books. What makes this reader a nifty utility is a feature called
ClearType, a way of displaying letters on the screen for maxi-
mum legibility. The text is clear and crisp and one really can’t
complain about too little fitting on a single page. Reader effi-
ciently uses about 90 per cent of the screen to show the text in
an e-book, so it is pretty comfortable to read despite the text
being rather small. If you are interested in mobile finance, you
will like Money, a small finance package for people on the move.

Ease of use
Chances are, your first brush with the Pocket PC will be marred
by confusion, despite the fact that it has a friendly look and feel
to it. But after you spend a few hours with the device, things will
settle in a bit, and you’ll be able to navigate your way through
most of the basic functions such as browsing and synchronising
the device with the desktop. Seasoned computer users won’t take
too much time getting busy with this neat little gadget. But what
about those who aren’t as tech-savvy?

We tossed queries at the myriad handheld users we had a
chance to question. The replies were
highly varied and just as subjective.
However, from the feedback, it
appears that the experience really
depends on whether you are an opti-
mist or a pessimist. Microsoft, you
see, has gone to great lengths in get-
ting not only its premium offerings
ported, but also streamlining the

code and smoothening the interface. It is heartening to know
that commendable efforts such as these are being pushed into
improving PDA usage. But those who are not too firmly rooted

in the digital age might find this a tad difficult 
to believe. 

Data portability
Pocket PC gives us two ways of synchronising data between the
device and a desktop PC—by infrared and by the wired approach.
You can either connect its cradle to your PC through the USB or
through the serial port, depending upon the model you choose.
Microsoft’s ActiveSync is a software which acts as content direc-
tor between the Pocket PC and the desktop. You can select how
automated the sync process should be, and coordinate every-
thing from your calendars and con-
tacts to e-mail and files.

Especially because we in India are
still deprived of wireless access, we
should be making use of the ubiqui-
tous Web more. Through specialised
services such as Avantgo, we can
access anything from condensed to
full-sized Web pages without a mobile
Internet connection. Hundreds of
Web sites (called ‘channels’ by Avant-
go), including Anandtech and CNN,
offer concise editions of Web pages
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Like a desktop computer,
Pocket PCs offer a path for
owners to upgrade their
operating system. As of now,
the only upgrade available for
Pocket PC owners is Pocket
PC 2002. Though most of the
functionality provided with
2002 is included in the origi-
nal version, users can benefit
through the enhancements
featured in the upgrade. The
focus here seems to be on
improving the look and feel
of the interface and adding
functionality to existing appli-
cations.

For the first time, the
Pocket PC has poised itself for
enterprise use. Among these
corporate trimmings is built-
in VPN (Virtual Private Net-
working), which gives you a
secure connection to your
company’s network through
the Web. In order to deploy
Web-based applications on
your intranet, Pocket PC
2002 features a Web server
which also gives you the free-
dom to work when you’re
offline.

For other market seg-
ments, these additions may
not appear to be so useful.
Perhaps the sole incentive for
personal users to make the
switch is the introduction of a
‘pocketised’ MSN Messenger.
But, this minor increase in
usability doesn’t alone justify
the need for an upgrade. Like
the transition from Windows
98 to Me, the road to Pocket
PC 2002 looks to be yet
another colourful, yet
uneventful journey. At best,
Pocket PC 2002 has some-
thing to offer corporations
looking to buy new hard-
ware.

Handhelds which have
native support for the latest
make of Pocket PC will come
up with new specifications.
For example, the new OS will
only support devices that
have chips based upon ARM
technology, such as Intel’s
206 MHz StrongARM proces-
sor. Upgrades to the Pocket
PC 2002 are available provid-
ed they meet the new soft-
ware’s requirements.

Pocket PC 2002

Polish up office documents on the move!

Ideally suited for simple accounting jobs

Tiny, yet clean and slick ➜



insight ■
■ pocket pc

79

through their services. Pocket PC uses the host’s Internet con-
nection to download pages from the Web during the sync
process. Once you subscribe to your favourite channels, the sites’
latest updates are downloaded to your Pocket PC the next time
you decide to update.

Recognise me?
For years, poor voice and text recognition has been the bane of
the mobile computing industry. With the Pocket PC, greater
emphasis has been placed on character recognition with the sty-
lus as a writing tool. But the muscle power of handhelds today
is a far cry from what it needs to be. Pocket PC’s text engine
includes a learning module which calibrates itself to the user’s
unique penning characteristics. The feel of a stylus and touch-
pad is completely different from that of pen and paper and takes
some time getting used to. When writing on this device, you feel
no resistance and you need to be lenient about how hard you

press it. Writing on a small area doesn’t help either; the hand is
used to resting on a solid platform as opposed to thin air. In time,
you will only have to get used to being careful about how you dot
your i’s and cross your t’s. Even then, you will have to deviate
from your natural style of writing.

What’s in the offing?
One gadget that’s left an impression on the minds of a music-hun-
gry generation is the Sony Walkman, a revolutionary product that
founded the personal audio industry. Sony’s ‘ingenious’ strategy is
actually quite simple: take a typically immobile object, make it
slick, and scale it down enough to fit in your pocket. Unfortunately
for handheld makers, this approach will only take them so far.

For handhelds to gain wide acceptance, they need to be eas-
ier and more efficient to use. Take browsing for example. Can
you imagine trying to navigate your way through the Web with
just a stylus complimented by poor handwriting recognition?
Instead, why not try and capitalise on a handheld’s obvious
advantages? Their small screens are ideally suited for a greatly
simplified interface that lays more stress on tapping rather than
glorified attempts at writing gibberish. As of now, handhelds are
years away from voice and handwriting recognition. So if there
are more refinements to think about, why are OS makers pre-
tending that their products have done it all right away?

There is no doubt that in the next five years, mobile com-
puters such as these will be as easily accessible as the cell phone
today. For one, it will cost around the same. Besides, if you take
this technology just a few steps further, there is no reason why a
digitally smart and savvy generation won’t adopt it. 

PRASHANT MASRANI

For a long time, Microsoft
dwelt in the Palm’s shadow
till they finally got it right
with Windows CE v3.0, sim-
ply known as the original
Pocket PC operating system.
Though the Pocket PC is a
marvel in itself, there is an
alternative out there which
offers its own rewards—the
Palm OS which was designed
with low cost, simplicity and
a low footprint in mind. Who
can ever forget the wafer-thin
Palm V? But in terms of func-
tionality, it is evident that a
Palm outfitted handheld looks
like a toy that can do small
tricks as opposed to Pocket
PC’s extreme likeness to a
desktop computer. Applica-
tions that Windows users are
accustomed to such as Word,
Internet Explorer and Win-
dows Media Player have been
ported to lighter and easier-
to-use Pocket PC versions.
Streaming audio/video, wire-
less connections (including
802.11b) and its tight inte-
gration with its desktop coun-
terparts make transferring
more than just address books
a reality.

So with all its bonuses,
why is the Pocket PC’s market
share only 25 per cent of that
of Palm? Microsoft must pay
heed to Palm’s massive devel-

oper support and the avail-
ability of Palm accessories;
finding Palm applications is
child’s play thanks to the
community-centric support
that it boasts of. Secondly,
the Pocket PC was essentially
designed to do more, and as
a result, the device costs
more. An entry level Pocket
PC starts at around Rs 20,000
while a Palm gadget comes at
less than half that amount.
Although Microsoft is fully
aware of these facts, it is pin-
ning its hopes on multimedia
and wireless applications to
justify the price tag. 

Both Palm and Microsoft
realise that in order to boost
their positions in this phase
of handheld growth, corpo-
rate acceptance is impera-
tive. With the specialised
services of the Palm OS and
Pocket PC’s exorbitant price
tag, currently, both are tai-
lored to suit the needs of
businessmen rather than the
average consumer. But once
the cost dynamics tilt in
favour of the Pocket PC,
Palm could possibly be on its
way to the grave. If Palm
even wishes to dream of
long-term survival, the com-
pany needs to shift its focus
away from its software’s pro-
prietary nature.

Pocket PC vs Palm OS

1/4 page AD
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Out of sight may no longer
mean out of mind! Not if
you’re the kind who swears
by instant messengers (IMs).

The Internet and instant messaging have
given a whole new meaning to the term
long distance relationships, whether its
your favourite aunt settled abroad or your
girl friend studying in a different city. Sep-
arated by such vast distances, you can still
be in close proximity, thanks to all those
messages shuttling back and forth at an
astounding speed. Adding features every
day, instant messaging has encompassed
business interests as well. But do you know
what makes an IM tick? If you’ve ever
wondered (between sending those smileys

and lovey-dovey hearts!) about the tech-
nology that makes this marvellous form
of communication possible, then you
might not want to put this magazine
down until the next few pages.

Anatomy of the chat system
So how does your message reach a friend
through the streams of servers spread
across a vast geography? The message is
sent via copper and fibre connectors across
the world at two-thirds the speed of light.
In effect, the users find no difference in
the delay that occurs due to the transmis-
sion of messages across servers. For two
people to communicate effectively with
each other they need to speak a common

language. Similarly, for two programs to
communicate with each other they need
to connect through a common conven-
tion, called a protocol. The protocol
decides the method of communication
between the chat client and its server.
Most IMs use their own proprietary pro-
tocols (that’s why a Yahoo! user cannot
contact a MSN user, though both may be
online). 

The user logon process in an IM
involves two phases: the authentication
phase and the instant messaging phase. 
Authentication: When you enter your
username and password in the instant
messaging client and try to login, the
client establishes a temporary connection

Message in 
a window

A behind-the-scenes look at how Instant Messengers work and how you can make the most of them

ILLUSTRATION: Mahesh Benkar

➜
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with an authentication server. The server
searches its vast database for the user-
name and password combination that
you keyed in (see diagram, ‘A working chat
session’). If the search is successful the
server lets you know that you have been
successfully connected. 
Instant Messaging: Once you are autho-
rised to use the chat service via a particu-
lar client, a connection is established with
another server called the communication
server. The client sends your computer’s
address (IP + port) to the communication

server. The server maintains a directory of
users who are logged onto it, which
includes the user ID and IP. In return the
server sends your buddy list to the IM
client. The client frequently sends packets
of information to the server inquiring
about the status of your buddies and
when one of them signs in, goes offline or
changes his status, your client is informed
with an appropriate signal from the 
server. 

Once you key in a message to your
friend and hit the Send button, your 

message is handed over to the chat client.
The client identifies the address of the
user from the directory on the communi-
cation server and routes it to him/her. (See
table, ‘Instant Messengers Compared’)

That’s the underlying principle of how
you can send a message from India to a
friend in the US within seconds. But what
makes instant messaging better than e-
mail? Usually an e-mail has to travel
through numerous servers before it reach-
es the recipient and hence is slower. In the
case of instant messengers, however, a
message is routed through only one serv-
er (addresses of your buddies are stored on
the network of communication servers
across the world) and the message reaches
the recipient who is connected to the same
server, instantaneously. The time lag
between the message relay and arrival is so
infinitesimal that you find instant mes-
saging almost instantaneous. Besides the
speed factor, e-mail also lacks the interac-
tive and personal touch that an IM offers. 

Video, voice and file transfers
Your IM is a collaborative tool that not
only lets you type in text niceties but also
lets you see and hear your loved ones. The

Jarkko Oikarinen started Internet Relay
Chat (IRC) in 1988 and revolutionised the
chat system. It was an implementation
that allowed people who were logged
onto a Bulletin Board Service (BBS) to
communicate with each other. People
with special interests could come together
online for the first time.

The use of IRC saw a massive growth
when Kuwait was invaded by Iraq in
1991. Users from all over the world want-
ed to have a first-hand glimpse of what

was happening in Kuwait. When all other
lines of communication were cut, an IRC
link to Kuwait was framed, which
remained active for more than a week. For
a glimpse of what happened, check out
www.ibiblio.org/pub/
academic/communications/logs/Gulf-
War/. 

Since then, instant messaging has
moved down an evolutionary path to
what is available today from various serv-
ice providers.

IRC—Internet Relay Chat

INFOGRAPHICS: Jaya Shetty



transmission of voice and video follow the
same principle as an instant message. 

When you try to send a picture to your
friend, a file transfer is initiated. The serv-
er checks for the file’s size and if found to
be too large, it denies a connection for the
file transfer. If it is within the size limits, a
session is initiated with your peer and the
file is sent in small chunks. Some IM serv-
ices upload files to the communication

server. Your peer is
notified with a link
using which he/she
could download the
file from the server. 

MSN opens a tem-
porary peer-to-peer con-
nection for the file transfer. Thus, when
you send a file to your friend, a connec-
tion is established directly between your
client and your friend’s client. They com-
municate with each other without the
intervention of the server, allowing for
faster file transfers. But during network
congestion this system may not work and
hence a server intervention and store-for-
ward mechanism is more worthwhile. 

Most multimedia communication
occurs via a buffering server, which stores
and forwards digital information. Once
you enable ‘voice chat’ the client contacts
the communication server, which directs
it to an audio server. The server immedi-
ately sends a notification to your friend
that you would like to have a voice chat
with him/her. If your friend consents, a
voice communication channel is initiat-
ed between the two of you. Now you can
use your microphone to chat. The voice
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Today most surfers use Yahoo! MSN, ICQ
and AIM. So what could be more brilliant
than the idea of a single client, which
could control all messenger accounts?
Multiple messenger users find it extreme-
ly convenient to use such clients. Config-
uring Yahoo!, MSN, ICQ and AIM
accounts is quite easy. Once the accounts
are configured, your buddy lists are
imported from the respective services.
Now you can send/receive messages to
all your buddies on different services from
a single window. 

Some of the most popular cross-plat-
form mix messengers are Jabber, Trillian
and Odigo. While Trillian and Odigo sim-
ply let you configure all your messenger

accounts, Jabber gives you much more.
Jabber is an XML-based open source mes-
saging client that can be used to config-
ure Jabber and other messenger
accounts. The mind blowing features of
Jabber include accessing your Jabber
account from anywhere using devices
such as PDAs, mobile phones, etc, mak-
ing it completely interoperable. The com-
munity is focused on enhancing this piece
of software with features such as SMS
services and wireless access. Jabber focus-
es more on security and privacy with no
compromise on the ease of use. Jabber
also allows you to set up your own chat
server. Check out www.jabber.org and
find out what interests you.

One for the Chatterbox

Over one billion instant
messages are exchanged
every day



data is seamlessly relayed to the audio
server, which buffers and sends it to the
receiver. Owing to the speed at which this
happens, you do not experience a lag in
the voice (provided you have a high speed
Internet connection).
You would find an appar-
ent lag while using a dial-
up Internet connection.
So you can now save a
bundle on a long dis-
tance call to that inter-
esting girl you met on
the Net the other day!

Video communication is an altogether
different ball game. The client receives the
frame from your Web cam and sends it to
the viewers connected to your Web cam
without passing through an intermediate
media server. A noticeable delay in frame
rate and refresh rate makes it quite like a
slow motion video, but that’s inevitable
because of the congestion that would exist
on the network. Video quality can improve
and match real life speeds if the connec-
tion was dedicated solely to video relay.
The video quality might also depend on
the quality of the camera in use. 

Is reliability at stake?
Most messengers use the ASCII text mode,
which means all your messages are sent as
plain text between the server and the
client. Since messages are sent mostly as
unencrypted data and they travel through
public networks, the risk of being snooped
on is pretty high. Messenger service
providers warn you of potential hazards

in sharing personal information on the
Web. It’s possible for a professional

to sniff the data packets and
steal your personal informa-

tion when it is sent across. Sniffing agents
and packet snatching programs are avail-
able on the Net in plenty. A hacker might
use any of these programs to catch data
packets that travel over public networks.

Since the messages are in
plain text, the hacker has less
to do on deciphering them. 

Messengers are not meant
for exchange of secure infor-
mation. Flaws in the messag-
ing client can be exploited by
hackers to plant malicious
code on your computer.

Besides, a class of messenger viruses have
started causing havoc. George Bush and
Pic 1324 are two such viruses. They come
to you as a file sent from one of your
friend’s virus infested computer. When
you accept the file on the messenger, your
PC gets infected and a file called
msgsprd.exe is copied into the memory.
Once the program is actively resident in
the memory, it starts spreading to other
contacts on your buddy list.

The last word
Instant messaging has created a new par-
adigm on the Internet. It’s the most pre-
ferred application of the Net after e-mail.
Not just individuals but also businesses
have started looking at instant messaging
as a cheaper alternative to communicate
with their customers and clients. Busi-
nesses can have closed instant messaging
solutions deployed on their networks to
increase security and privacy, while also
cutting down on communication costs.
Exchange 2000, the messaging software
that’s available from Microsoft allows you
to deploy instant messaging solutions at
the corporate level. 

Today IMs are mostly used at a 
personal level. The potential to extend
an IM’s interoperability can enhance
communication and take it to new
heights. Open source clients such as Jab-
ber give you the flexibility of using mes-
sengers on varied platforms such as PDAs
and other mobile devices. SMS has
already integrated itself with messaging.
Instant messaging will evolve to a service
where you can talk to devices from any
platform and every device available 
on earth. 

VIDYARAMANAN S.
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Yair Goldfinger, Arik Vardi, Sefi Vigiser,
and Amnon Amir. They are the brains
behind ICQ (I Seek You), the world’s
most popular instant messenger from
Mirabilis, a company formed by the
foursome. Back in 1996 when the Inter-
net was gathering momentum among
the masses, Mirabilis realised that some-
thing was lacking in the whole concept
of the Internet—interaction. The missing
link was instant messaging. ICQ enticed
its users with new features such as user
created public and private chat rooms.
Soon the online community sprang into
a large ensemble of special interest
groups. Today ICQ has improved many-
fold and offers its customers a highly
integrated messenger that includes an 
e-mail facility, option to send and
receive SMS, make phone calls from PC
to PC for free or to a phone from your
PC at very minimal charges. Palm, Pock-
et PC and Windows CE versions of ICQ
for the PDA are also available. 

Desperately Seeking You

Emoticons

Video and voice 
conferencing

SMS Facility

Buddy search

Message archiving
Maximum characters
allowed

MSN
Could do better 

Netmeeting is good for
video chat, bad for
voice chat
—

You need the e-mail
address or sign-in name 

Save messages manually
400 

Yahoo!
Good looks and 
variety
With a fast connection
this is the best for voice
and video chat
—

Search is easy and
includes parameters
such as interest, age,
and sex 
Optional feature 
800 

AIM
Not the very best

No video chat here

—

Often results in search
errors

No archiving option
1,024 

ICQ
None here

Make do with only text 

Send an SMS via 
leading mobile service
providers
Search on various
parameters and add
buddies with a single
click
Enabled by default
Online: 7,000 
Offline: 450 

IndiaTimes
Try these at your own
risk! 
A simple desi text mes-
senger

—

Missing in action! 

Out of the question 
150

Instant Messengers Compared

Three million
users sign up for
instant messaging
services every
month
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Small things go a long way in extending the life of your machine. Here’s how to keep your PC in 
top-notch condition so that it continues to hum with perfection

What is the most forgotten task in the life of a PC?
The answer is maintenance. Some of us may rea-
son that an expensive piece of machinery is sup-
posed to take care of itself. It isn’t so—the onus of

keeping a smooth machine smooth falls upon nobody else but
the owner.

So if you have been ignoring the clean-up session of your PC
for a while, now is the time to get started. Here’s what you need
to get organised: a screw driver, a vacuum cleaner, tissues, a soft
cloth, glass cleaner (spray bottle), a cologne or any mild cleaning
solution, cotton bud swabs and some different-sized brushes. 

If we break down the elements you have to clean, they fall in
seven main categories: your monitor/LCD screen, the CD/DVD-
ROM drive, the keyboard, mouse, printer, scanner (if you have
one), speakers, and the power supply. 

Let’s start with the first thing you see—your monitor.

Monitor/LCD
You view the outside world through your monitor. Let that
view not get blurred (or glared) by laziness on your part—
a clean screen means your eyes stay healthy too. Here’s 
the process:
■ First things first: switch off that power supply before you touch
anything. Unplug your computer, and begin cleaning only 
after that. 
■ Spray the glass cleaner solution in short bursts on the monitor
screen.  
■ Take a paper napkin (or a soft cloth) and clean the glass in one
direction. Remember, one direction only. Then wait till the
screen has dried.
■ Spray the glass cleaning solution on a soft cloth and clean the
outside cabinet of your monitor. 
■ Use only a moist cloth to clean an LCD screen.

PC Garage

ILLUSTRATION: Mahesh Benkar
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■ If your monitor is equipped with a manual degauss
function, try to degauss the monitor to see if the colour
dissipates. If this function is not available, turn the mon-
itor off, wait for about 15 minutes, and turn the monitor

back on. 
■ Make sure the display resolution and refresh rates are within
the specification of the monitor.

■ Do not spray any cleaning agent while the monitor is
still warm—let it cool down first. 
■ Never spray the solution directly on the screen as it
could damage the coating. 

■ Exercise caution while cleaning the on/off buttons and the
control panel. Do not let the cleaning solution enter these
areas.
■ Never spray anything on the vents on the backside of your
monitor. This could cause damage to internal parts.

CD/DVD ROM
A CD or DVD-ROM is the most extensively used hardware
peripheral. In order to extend its life, use a Lens cleaner at least
once a month. One common mistake users tend to make is that

they sometimes close the disc-loading tray manually—this can
result in misalignment of the tray due to the external force
exerted by the human hand. It is highly recommended that
you close the tray by pressing the button from the panel, and
not by pushing it in. 

Keyboard
The most used PC peripheral is also perhaps the dirtiest. To get
your keyboard spanking clean, first lift it upside down so that
all the loose dust particles fall off. Then use a vacuum cleaner
to blow out the particles that have settled beneath the keys.
Thereafter, unplug your keyboard, place it on a flat surface,
spray the cleaning solution on a tissue, and scrub clean the
areas that have dirt marks.

Ideally speaking, you should be cleaning you keyboard once
in two months. On a more realistic level, try and do it at least
once in three or four months. But if you’ve dropped something
like jelly or raspberry jam, then there’s no avoiding that clean-
ing session.

■ Do not use alcohol, solvent or anything that could
remove the printing on the keys or melt the plastic. 
■ Avoid spilling liquid (and food) on the keyboard as the
food material may enter inside and render certain keys (or

even the entire keyboard) non-functional. 

Mouse
Cleaning a mouse is one of the easiest tasks and we usually
tend to open it whenever it gets slightly sluggish. This is how
you should go about cleaning your mouse:
■ Turn off the PC and unplug the mouse. 
■ Open the ‘locking ring’ that holds the mouse ball in place (fol-
low the arrows indicating the proper direction to turn and
unlock). 
■ Be careful with the mouse ball—moisten some paper napkins
with Cologne (or any mild cleaning solution) and clean the
mouse ball with a gentle rubbing motion. If the tissue gets dirty,
change it and use another one.  
■ Next, you will notice two rollers inside the mouse. Clean and
wipe them with the cleaning solution. Let the mouse dry for a
few minutes before using it. 

Never use your
nails or any
other sharp
device to clean

the insides of the
mouse.

Scanner
If you own a scanner,
you’d often have found
images marred with
light or dark stripes or
displaying a check
board pattern. This
indicates that it’s time
to clean your scanner glass.  
■ Unplug the scanner.
■ Raise the front lid, apply a very mild streak of cleaning agent
to a soft lint-free cloth, and clean the glass. 
■ Wipe the glass with a soft cloth and wait for it to dry.

■ Make sure the transportation lock is enabled before
you transport the scanner from one place to another.
This prevents the CCD array mechanism tray from 
moving. 

■ Always unplug your scanner before cleaning. 

■ Always keep the media (the CD) in a lined case so
that it remains free from dust and scratches. 

■ If you find dust settled on the media, clean it
immediately with a soft clean cloth. Your CD-ROM
drive can’t read a dirty CD. 

■ Make a habit of holding the CD from the edges, and always
clean it from the centre to the outer portion. 

■ For longevity of the media, do not expose it to
direct sunlight. 

■ Do not clean the media in a circular motion
(even if it seems easier). 

■ Make sure you don’t leave any fingerprints on the CD.

Media care

Clean the rollers inside the mouse

The wrong way to close the 
CD tray 

The right way to close the 
CD tray 
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■ Never apply the solution directly on the scanner glass. 
■ Do not unscrew the lid in order to clean it from inside
if you find that the glass is dirty or has a slight dust or
smoke film underneath. Call the authorised service cen-

tre and get them to do the needful. 
■ Never use abrasives, Isopropyl alcohol, benzene, acetone, etc
on the scanner glass. This will streak and cloud the glass and
cause damage. 

Printer
The worst part about a malfunctioning printer is that you usu-
ally find out the fault when the need is urgent. To avoid such
situations, keep your printer well maintained. It’s very easy
actually and you needn’t do much. Most problems are related
to the ink which runs out and paper jams.   

■ If you’ve installed the ink cartridges for the first time,
remember that they need to be aligned. To do this, use
the software that came along with the printer. All you
have to do is click on the Align button and the cartridges

will align automatically. 
■ Store the car-
tridges in the
right packaging;
it makes sense to
store extra car-
tridges in their
factory-supplied
containers. If you
regularly switch
between colour
and black ink,
store the swapped
out cartridge in
an old factory-
supplied contain-
er or in a small
zip-lock bag. 
■ To avoid paper jams, clean the rollers inside by using 
alcohol. Do not forget to set your paper guides carefully and
remember to never mix different types of paper in the 
same tray. Half the problems won’t arise if you use the 
right paper.
■ Maintain the print head of your dot-matrix printer. Over a
period of time, the metal contacts on the back of the print head
may oxidise and lose their conductivity through exposure to

air. To clean it, you should use isopropyl alcohol and a lint-
free swab.
■ For switching off the printer, use the printer’s power switch
rather than the switch on a surge protector. 
■ Use the nozzle-clearing function (it blows ink through the
nozzles to unclog them) if you have an inkjet printer. Use it reg-
ularly, especially if the printer lies unused for weeks at a stretch.
■ Spray a mild glass cleaner on a soft cloth and use it to wipe
clean the outside of the printer.

■ If you spot a leakage, never open the inside parts of the
printer. Always call the authorised service centre. 
■ For optimal trouble-free performance, use the origi-
nal ink cartridges, not the cheaper refilled ones from a

local shop.   
■ Avoid placing a bunch of papers in the tray without separat-
ing as this leads to paper jams.  

Speakers
A good set of speakers would rarely give up on you, provid-
ed you use them reasonably. Being a music-lover doesn’t nec-
essarily mean blasting the speakers at the topmost decibel
level. 

■ Wipe the speakers using a soft cloth dampened with
a mild detergent such as dish soap.
■ You can also lightly vacuum the grilles to remove the
suspended dust particles. 

■ If you are using an adapter other than the one that came
along with your speaker set, match the ratings of the ampli-
fier (RMS) and adapter (ohms), otherwise you could cause
damage to your speakers.  

■ Avoid listening to music at extreme volumes and reduce
the volume level when a clear distortion is audible.
■ Never plug the speakers off while they are still on. 

Ideally speaking, you should schedule operation cleanup
for each of these peripheral devices every two weeks. If you
are a very busy person (as we suspect), complete all these
cleaning exercises at the first possible free weekend that 
you get.

Cleanliness pays off in the long run, you know that, so wipe
that dirt off as soon as you can. It’s your investment. Make it
last more and enjoy a clean computing experience.

MITUL MEHTA

Power watch
The most common power-related PC problems originate from
errant voltages. Hence, the best defence against voltage fluctu-
ation is a good surge protector. It is always advisable to buy
a good quality spike guard so that it can actually with-
stand any sort of fluctuation. 

There are spike guards that also feature a reset-
table circuit breaker which lets one correct small
interruptions with a quick flip of a switch instead of
having to replace a fuse. Surge protectors with 
this feature often cost more but are worth it in the 
long run.

■ Many-a-times you might hear strange sounds coming out of
the spike guard which might make you think that it’s time to
change it. Well, you are wrong. This sound simply means that

the contacts need to be cleaned.
■ Make sure the power is switched off before cleaning the

spike guard. Unplug all the attached peripherals and
clean the contact with a dry, soft cloth. 
■ If you are using an UPS, it is advisable to charge

and discharge the battery once a month so as to
extend its life. To do this, run the computer from the bat-

tery itself so that it gets completely discharged. Set the bat-
tery to charge again. 

After cleaning your cartridges, make sure
you place them back firmly in their slots
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Got a project to submit or a
report to send out? Does your
teacher or boss insist on neat-
ness and consistency? You

could pay your local STD-ISD-PCO-Xerox-
Computer Layout guy to come up with a
snazzy output in Pagemaker over a day or
two—or you could do it yourself in a few
hours and impress the hell out of any-
body. It’s not difficult at all and you don’t
need any special software. Just find out
how many more intricacies Word is capa-
ble of. You’ll be pleasantly surprised!  

Page formatting
To begin with, construct the page as you
would want the final output. This goes
slightly beyond setting the page size and
margins. From the Page Setup dialog
box, you can specify the layout of the
document—whether you want a differ-
ent first page (for instance, as a cover
sheet) or align text and graphics in the
centre of the page. All settings can be
specified for the entire document or only
for a section. This is particularly useful
for inserting items such as graphs and
illustrations in the document. You can
even add colourful borders to the 
document.

Another aspect of the page construc-

tion involves headers and footers. From
the Page Setup dialog, you can specify
header and footer positioning. You insert
text and images from View > Header and
Footer. These are usually used for includ-
ing the name of the document, page
numbers, and so on.

Paragraph formatting
Formatting paragraphs becomes very
important for presentation as well as
organising your material. Open Format >
Paragraph to begin. From here you can
set the paragraph alignment, the text

indentation, and the spacing within,
before and after the paragraph. You can
even format the first line differently.

Some very useful features are avail-
able under the Line and Page Breaks tab.
These options will make sure your 
document never looks shabby. ‘Win-
dow/Orphan control’ will make sure that
the paragraph doesn’t begin at the end
of a page or doesn’t end with a single
word. ‘Keep with next’ will cause the
current and next paragraphs to always
appear on the same page. This is very
useful for headings. ‘Keep lines together’
will make sure the entire paragraph
always appears on a single page, unless it

is too large. This is very useful for com-
ments, excerpts, etc. ‘Page break before’
will move the paragraph to the next
page—useful for beginning new sections.
This is better than inserting a page break
manually, since the break will always
move with the paragraph.

Flow text in
columns, say, for a
list. Select the text
and click on Format >
Columns. Now select
the number of
columns. You can set
them to be of equal
or different sizes.
Adjust the space
between the columns
and choose whether
there should be a line in between.

Tabs are useful for inserting text exact-
ly where it should appear—a tab defines
the starting position of the text. You can
have any number of tabs in a line, and
the text between two tabs is separated by
a [Tab]. In Word 2000, you can automat-
ically set a tab by double-clicking any-
where on the page. You can manually set
tabs from Format > Tabs or by dragging
the tab mark on the ruler.

Word Play
Surprise! Microsoft Word is a page layout software too. Here’s how you can 

use it to create some of the most stunning pages

Specifying document layout in Word

Formatting paragraphs in Word

Formatting text in columns

You can directly

choose the num-

ber of

columns

by clicking

on the

Columns icon

on the Standard

toolbar.
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Styles
Styles are very handy with documents
that run over a few pages. A style is a pre-
set format that can be applied to text and
paragraphs. Changing a style applies the
new format to all text of that style across
the document. Using styles ensures con-
sistency and also makes it very easy to

change formatting. A third advantage is
that it allows you to organise sections of
the document in Outline View. For exam-
ple, if you use the default styles of Head-

ing 1 and Heading 2
for sections and
titles, you can quick-
ly move entire sec-
tions to any part of
the document by
simply dragging it.

Certain styles
such as for footnotes,
comments, headers,

footers, etc are automatically applied
when you use these features. You can
modify or create styles from Format > Style.
You can create new styles by clicking on
‘New’ or modify an existing style’s attrib-
utes from one of the options under ‘For-
mat’. Styles are of two types—character or
paragraph—the former affects only select-
ed text whereas the latter will update the
entire paragraph. To apply a style, simply
select it from the Formatting toolbar. The
dropdown list displays a preview of the
style and indicates whether it is a para-
graph style or character style.

Lists
Almost every report, thesis, manual and
such documents will have some form of
lists. Lists become easier to understand as
well as visually appealing if bullets or num-
bers are used. Word has very powerful fea-
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Setting tabs to insert text exactly where you
want it

Using Styles helps organise sections and
makes it easy to change formatting 

Word has a lot of powerful features that
afford excellent presentation in a mat-
ter of clicks. Here are a few of them.
AutoFormat: Click Format > AutoFor-
mat. Word can automatically format
the entire document based on any tem-
plate and a few rules. To modify these,
click Options. To format tables, click
Tables > Table AutoFormat.
AutoSummarize: Word can quickly cre-
ate a summary of the entire document.
Click Tools > AutoSummarize, select the
summary options and click OK.
Outline view: If you have used heading
styles or assigned levels to titles and
subheadings, manipulating the docu-
ment in Outline View is very simple.
Also, navigation across the document
becomes very simple using the Docu-
ment Map. Both these options are
available under the View menu.
Paste special: Copying text and images
from other applications, especially
browsers, can become quite annoying,
more so when you when you want to
maintain styles. Click Edit > Paste Spe-
cial and you can choose how Word
should treat the clipboard’s contents. 
Printing: If you need to finally print
several copies of your document to
send out, Word allows you to collate
the pages and even reverse the print
order (click Options on the Print dialog
box) so that you don’t waste time sort-
ing pages. Other options on the Print
dialog box such as printing only odd
and even pages, scaling and zooming,
etc can be very useful, too. If you want
to send your document to a production
house for printing, you can select the
‘Print to file’ option and create a .prn
file for processing.
Discipline: With a little bit of discipline,
Word can be a very friendly software in
the long run. For whatever you wish to
do, use the features provided—don’t
simply hit [Enter] several times or change
formatting arbitrarily. Inserting a Page
Break, using paragraph spacing or using
a Style will definitely prove useful once
your document is over two pages long.
Start using Word’s features one by one
and you’ll soon get used to them.

Though you can select
fonts, their sizes and
basic formatting from
the Formatting toolbar
(Format > Font) gives
you a lot more options.
You can apply several
effects and can even
hide the selected text,
which you can view by
enabling the option
from Tools > Options.

The options under
the Character Spacing
tab are two features
particularly useful for layouts. Spacing

will adjust the space
between two charac-
ters to squeeze them
closer or pull them
apart. Position adjusts
the vertical position of
the text. Often these
are used to fit text in a
particular space,
though often they
serve as very good
design functions, too.

Word can also add
Drop Caps to the para-
graph. Click Format >
Drop Cap, select the

style for the drop cap and click OK.

Selecting font and font sizes 

Make life easier

You can set the

outline level

of a para-

graph from

the Para-

graph format-

ting dialog box.

Formatting Fonts



tures for either option, and supports up to
nine levels of nested lists. You can format
simple lists by simply clicking on the icons
on the Formatting toolbar. To customise
the list, open Format > Bullets and Num-
bering. From here you can choose whether
the list should be bulleted, numbered, or
a combination of both. You can change
the formatting for the list, choose different
bullets and even use an image for the bul-

lets. If your list is separated by text in the
middle, you can choose to restart num-
bering from the new position or continue
from the previous list.

Tables
Tables allow for grouping material and
presenting it in a form that is easy to
lookup. To begin with, click on Table >
Draw Table. It’s neater if you let Word
automatically create the table from Table
> Insert > Table. You can also convert text
into tables (under Table > Convert),
though it is preferable that the text be
ready for conversion, with the columns

separated by commas, tabs or other such
special characters. The Table menu has a
lot of powerful options such as sorting
data, inserting or deleting rows and
columns, splitting and merging cells,
repeating heading rows across pages, etc.
Though you can modify most of the
table’s attributes from ‘Table Properties’ it
is much more convenient to use ‘Table
AutoFormat’. This has certain predefined
styles for formatting tables and you can
choose which attributes of the table to
modify.

Images
To insert an image in the
document, click on Insert
> Picture and choose
where you would like to
insert the picture from.
You can modify the picture’s
properties from the Picture tool-

bar or from Format > Picture—both will be
active only while the image is selected.
You can crop the picture and adjust its
brightness and contrast. You can even set
a border around the image and set it to
appear in grayscale, black and white or as
a watermark. You can set any one colour
of the image to appear as transparent. On
screen, the areas with that colour will
take the colour of the background and
when printed, the colour of the page.
This option is available only on the Pic-
ture toolbar. 

Word 2000 is bundled with a very
rich, well categorised and fully searchable
clipart gallery. Also, more images are
available online which you can get direct-
ly from the gallery. Word can also create
graphs from data in tables.

Borders and Shading
Borders and backgrounds can be modi-
fied from Format > Borders and Shading.
These can be applied to almost all objects
in a document. Depending on the select-
ed text or objects, you will see different

options in the ‘Apply to’ list.
Under the Page Border tab, you
will see an extra option of using
repeating images for page bor-
ders. Select the width, style and
colour of the line and choose
from one of the default borders
on the left or apply the lines to
the box on the right. Choose the
background colour from the
Shading tab.

Text boxes
One of the most powerful features of Word
is the text box which allows you to flow
text anywhere in the document. Moving
the text around becomes a matter of drag-

ging the box. You can add text boxes from
Insert > Text Box—just draw it anywhere on
the page. You can design an entire docu-
ment using text boxes or use them to add
box items between
flowing text.

Formatting a text
box is very simple.
First, let’s look at the
Text Box toolbar. You
can link as many
boxes as you like,
one after the other.
Overflowing text will
be automatically
added to the next
box. You can even
change the direction

Footnotes and endnotes
Inserting reference text is as simple as
clicking Insert > Footnote. Choose

whether it should be a footnote (at the
bottom of the page) or an endnote (end
of the document) and click on Options
for more numbering options.
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Inserting images into your document

Inserting text boxes in your document

Inserting a pic-

ture in the

Header will

automatically

set it as a

watermark

across all pages.

After formatting

one text box,

right-click it

and select

Set

Autoshape

Defaults. All

boxes will have

the current for-

matting by

default.

Formatting lists in Word

Setting a border for your page 



in which the text appears. For more box
options, open Format > Text Box. You can
change the border, background, layout
and internal margins of the box. Under
the Layout tab, click on Advanced and
you can completely control how text and
graphics around the box behave. 

Drawing Objects
Enable the Drawing toolbar and you
have access to a host of design elements.
Apart from Line, Rectangle and Oval,
you also have WordArt and a set of
AutoShapes. Each object is highly cus-
tomisable and you can even add text
within any of them (right-click the
object and select Add Text). Basic for-
matting of drawing objects is similar to
that of text boxes (Format > AutoShape).
You can further enhance their appear-

ance by adding shadows and 3D effects
from the Drawing toolbar. These are
again, highly customisable—after apply-
ing a default shadow or 3D effect, click
on ‘Shadow Settings’ or ‘3-D Settings’ for
more options.

Table of contents
Once the document is ready, you would
probably like to add a table of contents
(ToC) to it. Word can automatically add
one for you, provided you have used
Styles or set Outline Levels (for headings,
sections, subsections, etc.) in the para-
graph formatting for headings. You
would probably like the ToC at the begin-
ning, so go right to the top and hit [Ctrl]+
[Enter] to insert a page break. Click on
Insert > Index and Tables. Under the Table of

Contents tab, set how you would like the
ToC to be generated and click OK. You
can choose how many levels to show. If
you have used styles other than the built-
in heading styles, click on ‘Options’ to set
their levels now. Word automatically
inserts styles for the ToC. To modify the
appearance of various levels of the ToC,
click on Format > Styles.
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WordArt
WordArt is a simple way to insert artistic
text in your document. This is very useful
along with images, graphs, etc. Click on
Insert > Picture > WordArt to begin.
Choose from one of the existing designs
and enter the text. WordArt is highly cus-
tomisable from the WordArt toolbar. You
can select the shape, orientation and
spacing between the letters, apart from
the normal formatting options such as
border and background.

You can customise drawing objects in Word

Adding a table of contents is easy

Let’s create our own card using Word.
Begin by setting all page margins to 
1.78 cm and the orientation to land-
scape. Centre the paragraph alignment
and draw a line straight down the mid-
dle, along the cursor. Keep the [Shift] key
pressed to draw the straight vertical line.
This will serve as your guide for placing
other objects on the card. Open Format >

Borders and Shading > Page Border,
select an appropriate border and click
OK. Click Insert > Picture > Clip Art,
browse through the clip galleries and
insert an appropriate picture.

From Format > Picture, change its lay-
out to tight. You can now move the pic-
ture to the right side of the guide. Click
Insert > Picture > WordArt and enter your
message. Sign the card by double-clicking
where you want to enter the text.

Similarly, you can add a message to the
left side of the card, too. If you want more
control over the text, it would be better to
use a text box. If you want to give your
card a background, the simplest way to do
it is to draw a rectangle across the entire
page and apply the background. Right-click
the rectangle and click Order > Send to
Back. If you use the rectangle, you cannot
use any text on the document itself—you

will have to use text boxes.
Create a copy of this page and design

the front and back of the card. The front
comes on the right side and the back on
the left. Once it is ready, delete the 
vertical guides and print the card on 
two sides of the same page. Fold it down
the middle and your card is ready to send.

Create a Valentine card

Page setup for your Valentine card

Selecting an image for your card
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Surviving
CCRRAASSHH

You’re at the fag end of your
financial year. You’ve been work-
ing ever so diligently on your
year-end presentation. You

switch on your PC for the final bunch of
printouts and you’re faced with a screen
saying ‘disk boot failure’. Welcome to
your worst nightmare—the day your hard
disk crashes! 

What causes a hard disk crash?
Like any electrical appliance or product, a
hard disk is prone to malfunctions that
could lead to premature death. Your hard
disk may be working just fine, but sud-
denly one day your computer refuses to
boot up. Let’s take a look first at how a
hard disk crash could occur.

Mechan-
ical Faults:

If you bump
your hard disk

around, chances are it
will give up on you. While

transporting your hard disk, if the
hard drive’s read/write head isn’t parked
properly at the platter’s non-data storage

edge, the platter surface could get
scratched resulting in data loss. Most
recent hard drives come equipped with
an automatic platter parking mechanism,
so chances of this happening are rare if
the drive isn’t powered on. 
Electronics Failure: A power surge can
easily kill the hard drive’s logic board, or
even the small servo motors used inside.
The hard drive head uses an electromag-
netic actuator to move between positions.
It is possible that the actuator’s circuit
might get damaged, rendering the read
mechanism useless.
Media Errors/Malformed Data: Due to
manufacturing defects, or just plain
rugged usage, a certain part of the platter
can get physically damaged beyond
recovery, rendering that part of the plat-
ter useless. When this happens, a disk
utility generally marks all sectors in this

SYMPTOM
BIOS fails to detect the hard drive

Random crashes; error messages;

drive detected, but unusable

Sudden data loss; missing parti-

tions; boot errors

Drive makes noise/click sounds

AILMENT
Power failure, disconnected cables, drive elec-

tronics failure

Media errors, read/write errors due to other rea-

sons, unmarked bad sectors

Media corrupt, demagnetised

Virus attack on boot sector, file allocation table

corrupt, partition table corrupt/modified,

head actuator mechanism error, head parking

mechanism damaged 

A HARD DISK

Diagnosing the Problem

Crash! Bang! Kaboom! There goes your
hard disk. But here’s how you can recover
your data and live to tell the story
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area as bad sectors. 
If you don’t run a disk utility such as

Scandisk or Norton Disk Doctor, the
operating system continues to think of
this area as a legible sector, and tries to
read/write data to it. Failing to do so, it
gives error messages indicating that the
disk is inaccessible. You might also expe-
rience random lockups or crashes while
using such a disk. 

What’s recoverable,
what’s not
The good news is that
everything is recoverable—
everything! Even if your
data is inaccessible due to
corrupt or demagnetised
media. But at what price
and how? 

Physical errors or elec-
trical failures require the
disk to be opened and the
components replaced, and
hence require a qualified
technician at a data recov-
ery centre to perform these
operations. 

If your hard disk has
been physically damaged,
then recovery software would not be of
any help. At the data recovery centre, the
drive undergoes various tests and in the
case of a drive electronics error, that is,
your logic card being non-functional, it
can simply be replaced. 

A read error indicates that the drive
motor has failed, or the head has been
damaged, or it may not be aligned prop-
erly. In case of a media error the platters
would have to be physically removed

from the spindle and placed on a separate
drive mechanism. They will then be read
from there through custom-made recov-
ery software, which works on the princi-
ple of trial and error, and will try to recov-
er the data. 

However, sending your hard disk to a
data recovery centre involves a lot of
expenses, as the charges levied are not

based on the amount of data
to be recovered or the
amount of data that could
be recovered. Instead, the
charges are based on the
importance of the data to
the client and you could end
up paying a bill worth a cou-
ple of lakhs of rupees. In
India, such services are pro-
vided by Stellar Phoenix
(www.stellarinfo.com). 

If your hard disk is not
physically damaged, you
can do a simple file recov-
ery at home using custom
disk tools/recovery software
such as Ontrack
Easy Recovery and
Lost & Found.
Remember though,

that this can be done only if your
drive is detected by your BIOS.
You would need to connect
another hard drive to the
machine to recover data to; you
can’t use the same hard drive for
recovering files.

On the road to recovery
Here’s how you can go about
recovering your data:

As soon as you realise your hard
disk has crashed, first shut down your
machine so as to prevent any further
damage to your disk. Then restart your
machine, go to the BIOS and check if the
hard disk is being detected. If your hard

disk is not detected, you will have to send
it to the data recovery centre. However, if
the hard disk is detected then there are
chances you can recover your data
through a recovery software.

Next, plug in another hard disk
to your computer so that the data you
recover can be stored on it. However,
ensure that the hard disk has more free
space than the size of the data you need
restored, else the task won’t be successful.
If you wish, you can plug in a zip drive
also, but then make sure that the recovery
software you’re using supports such
media. Remember that even though you
might have another partition on the
crashed hard disk, you can’t recover data

STEP 2

STEP 1

While some hardcore geeks may just never
be content with their PC’s speed, most of
us are genuinely plagued by slow comput-
ers. Of the several factors that could lead
to a slow performing system, the hard disk
is an important one. 

In order to get the top-notch perform-
ance you need from your hard disk you
should, as a thumb rule, run the Scandisk
program bundled with Windows which
scans the hard disk for surface errors. The
hard disk consists of the file allocation table
(FAT), which indexes all the entries of files.
In the case of an entry being damaged,
your files may be lost or, at worse, your
system may not boot up. Hence, by peri-

odically running Scandisk you automatical-
ly eliminate severe damage to files that
may be caused during normal use of the
system or even due to an improper shut-
down of your machine. 

‘Disk Defragmenter’ is another utility that
comes bundled with Windows. This utility
arranges all the files systematically so that
the hard disk does not have to waste time
hunting for the rest of the program files
while trying to open a particular program.
Hence, if you frequently install and uninstall
programs, thereby causing changes in the
file arrangement, then you should run this
utility at least once a month so that your
hard disk performance does not get affected.

Keeping Your Disk Fighting Fit

The Root of the Trouble
The most common causes of damage to
hard disks are mishandling and bad
power. You can extend the life of your
hard disk by: 
■ Not plugging in many drives to the
same power cable
■ Making sure there is no voltage fluc-
tuation, or else the logic card could be
damaged, thereby rendering the drive
unusable.
■ Taking great care while installing or
removing the hard disk from your 
computer—a small jerk or bump could
be enough to damage your drive,
sometimes.

Average
life of a hard
disk should be
around three to
five years, con-
sidering an aver-
age practical
usage of six to
to eight hours
every day

The BIOS screen tells you that both the
hard disks have been detected



on the same hard disk. You have to plug
in another storage device on which data
can be stored. 

Next, make a bootable rescue
floppy disk from the recovery software.
Insert this floppy disk and boot your
machine in the MS-DOS mode. Do not,
by any chance, boot your machine from
the hard disk. In order to boot your
machine, make sure you go and change
the boot sequence from the BIOS.

After you’ve booted in DOS
mode, insert the recovery software floppy
diskette. One of the most widely used and
effective software in this category is Easy
Recovery from Ontrack. You can also use
other software such as Stellar Phoenix
Data Recovery Software, Final Data, etc.

After inserting the recovery soft-
ware, you will get an option where you
will have to select the primary hard disk
(that is, the one that has crashed) as the
‘recovery source’ and the second hard
disk as the ‘restore destination’. 

The software then analyses the
data that it has to recover from the crashed
hard disk. In order to recover the data, the
software tries to read the two copies of the
file allocation table (FAT) and then reads
the raw data on the hard drive, trying to
match it to the FAT. 

The data that does not match the FAT
is generally the data that you are trying to
recover. Once it finds raw data on the disk

that equals a file but no similar entry in
the FAT, it marks the data as a recoverable
file and adds it to the existing list of files it
has from the FAT. All the files that exist on
the hard drive, whether in the FAT or
detected by the software, are shown as
recoverable files. Once this is done, you
can choose what you want to recover, and

it will be copied to the destination drive.
The whole process might take hours to
complete depending on the data. 

Warranty woes
Like all products, even hard disks are

covered under specific warran-
ty periods, depending on the
manufacturer. Usually, a hard
disk (IDE) carries a one- to
three-year warranty from the
date of purchase, and certain
SCSI hard disks  carry war-
ranties up to five years. If dur-
ing this period your hard disk
crashes or malfunctions, you
can return it to the dealer so
that it can be sent for further
analysis to the company’s
RMA centre. There the hard
disk will be repaired and if suc-
cessful, the same hard disk will
be returned to you. If unsuc-

cessful, you will be given a hard disk
with a similar model that has also come
in for repairs.

In case your hard disk is not repairable
and a similar model is not available for
replacement, you can either opt for

STEP 6

STEP 5

STEP 4

STEP 3
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Hard disks with a rotational speed of 5,400
rpm use metal substrate disks, whereas the
newer hard disks that run at 7,200 rpm or
even 10,000 rpm use glass substrate disks.
Using glass substrate disks has its own
advantages, such as better ability to with-
stand shock, and reduction in surface
defects in turn helps reduce read and write
errors.

However, these could die out soon as
glass substrate disks are more brittle than

metal ones and more over, the magnetic
film coating applied on the glass substrate
disk peels off over time, thereby damaging
the hard disk.

Another important factor is heat. The
heat generated by hard disks with a rota-
tional speed of 7,200 rpm and above is
immense. This sometimes causes the plat-
ter dimensions to change, which is espe-
cially dangerous when data is read or writ-
ten on a hard drive.

Are High-speed Hard Disks More Vulnerable to Crashes?

Tracks and Sectors: A hard disk consists of
platters on which data is stored. These
platters consist of tens of thousands of
tracks that are tightly integrated in concen-
tric circles. These tracks contain loads of
vital information and thus are broken
down into sectors. Hence, a sector is the
smallest addressable unit that can hold 512
bytes of information. 
SMART: Self-Monitoring Analysis and
Reporting Tool (SMART) system uses inter-
nal hard disk monitoring technology to
analyse your hard disk and prevent hard
disk failure or data loss. 
Bad Sector: A sector that cannot be used
due to a physical flaw on the disk is called
a bad sector. 
Clusters: A cluster is a logical unit of stor-
age on a hard disk or a floppy drive. The

size of a cluster varies from 512 bytes to
256 kilobytes depending on the size of the
partition and the file system.
FAT: The FAT (file allocation table) tells the
Disk Operating System which portions of
the disk belong to each file. The FAT links
together all the clusters belonging to each
file, no matter where they are on the disk.  
Partition: Whenever a hard disk is format-
ted, it will have one partition by default.
Hence, a partition is a formatted section of
a hard disk. Large hard disks can be for-
matted to multiple partitions and each par-
tition acts like an individual or a separate
hard drive. 
Boot disk: A special floppy boot disk
allows your computer to boot even if it
cannot boot from the hard disk. This disk is
also known as a System Rescue Disk.

glossary

You can recover data using utilities like Easy Recovery

Select the files and destination path of the
files to be recovered
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another model or pay the difference and
buy a new hard disk.

As a last resort, you will be given a
credit note, the value of which will be 
calculated on the basis of a similar hard
disk available in the market and the age
of your disk. 

You will never be given a credit note
for the actual amount you paid while
buying the hard disk. You will also not
be given a new hard disk under the war-
ranty period unless the purchased hard
disk fails to function from the first day
itself, and that too has to be immediate-
ly reported back to the dealer. Since the

product is consid-
ered DOA (dead on
arrival), you are
liable for a fresh
replacement.

Monitoring
your hard disk’s
health 
The first approach
towards preventing
a hard disk crash
would be 
to activate the
SMART facility
from the BIOS. If
your BIOS does not
provide you with
this facility, you
should install pro-
grams such as
Active Smart, Nor-
ton Disk Doctor, or
Smart Defender,
which continuously monitor hard disk
activity and reduce the risk of your hard
disk crashing by predicting disk failures
using special algorithms. Such software
usually monitor the performance of inter-
nal heads, motors and other critical com-
ponents of the hard disk. They analyse
the internal performance of the hard disk
and constantly compare it with prede-
fined threshold limits that are already
programmed into them.

When the performance of the hard
disk decreases or is not considered to be
satisfactory enough for a normally func-
tioning hard disk, it would be wise to
promptly back up your data, as the hard
disk could crash any time. 

However, keep in mind that once you
have enabled SMART, it will slow down
the performance of your hard disk to a
certain extent. This is because it continu-
ously keeps scanning each and every time
the disk reads or writes data.

You can also run third party software
from companies such as Seagate, IBM and
Samsung, which also provide custom-
made utilities that can diagnose hard disk
problems. For example, IBM has a utility
called DFT (Drive Fitness Test). This utili-
ty is a standalone software that runs in
DOS mode and is independent of the end
user’s operating system. 

Once you boot in the DOS mode,
DFT can diagnose whether your drive is
defective, has been damaged by voltage
fluctuations, is about to fail soon and
even tells you if it’s running fine or you
need a replacement. 

So, before coming to a conclusion
and sending your hard disk to the RMA
centre for repairs you can run these utili-
ties and do a self-check and try to repair
the problems. This saves you the time and
freight charges that you would otherwise
have to bear.

MITUL MEHTA and HATIM KANTAWALLA

Your warranty is not applicable if:
■ The product is not purchased from

an authorised dealer.
■ The product is not used according to

instructions given in the instruction
manual.

■ Defects are caused by improper use
as determined by the company 
personnel.

■ Modification or alteration of any
nature is made in the electrical 
circuitry or physical construction of
the set.

■ Installation or repair work is carried
out by persons/agency other than
those authorised by the company.

■ You’ve kept the product in an 
unsuitable environment. The recom-

mended temperature range for a 
drive is 60 degrees Centigrade.

■ The original serial number has been
removed, obliterated or altered from
the machine or cabinet.

■ There are defects due to causes
beyond your control such as light-
ning, abnormal voltage, transporta-
tion losses, etc.

How Warranted is a 
Warranty

The DFT utility analyses and repairs any errors on the hard disk

Monitor your hard disk’s health with Active SMART

Other manufacturers
should follow Sam-
sung’s example and
provide a three year
warranty on their
hard drives

Nilesh Zaveri
APEX ENTERPRISES

“
”
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When it comes to research,
the World Wide Web is
larger than any physical
library in the world. As a

reader, imagine your hands lifting all
those heavy books as you pore over pon-
derous pages, doing a painstaking
research one page at a time. Then imagine
a scene where your fingers are resting
lightly on the keyboard as you lounge
behind a monitor, scrolling the pages idly,
twiddling your toes. 

The Internet has thrown open the
information floodgates. It has chan-
nelised many streams and rivulets of
knowledge in the oceanic Web and often,
finding a particular bit of information is

not much tougher than taking a dive.
Though there is no foolproof way of
ascertaining the source’s reliability, there’s
no doubt about the vitality and interest
that the information itself holds. And
most of it is for free.

It’s not easy finding a particular
nugget of information among the billion
pages floating on the Web, especially
when search engines return thousands of
vague results. It’s not unlikely that you
happen to be searching diligently for
information on ‘cattle and farming’ and
get flooded with pages on goat porn. 

What you need are tools and tips to
find relevant data without being
swamped by the information overload.

With the right gear and the right links,
you will be sailing the information ocean
smoothly with the wind beating down
your face, and the giant waves of knowl-
edge waiting at your very command.

Tools of the trade
There is a huge difference between surfing
and searching. If you’re an avid Web
surfer, you’ve probably collected hun-
dreds of bookmarks in your Favorites fold-
er by now. And, if you’re like most people,
your collection is probably an unorgan-
ised bloated mess. A browser is a 
powerful tool if only used for browsing.
For cataloguing and cross-referencing
information, and for professional level

Fishing
Information

for
on the Web should be as easy as sitting
by the bay, watching the tide go by. But if
you keep landing old boots and crumpled
cans, then here’s the secret to hooking up
the right bait 

ILLUSTRATION: Mahesh Benkar
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research, you need something like the
MantaDB suite of utilities—a suite of
eight tools which add extra capabilities to
your browser. One of the most powerful
tools is the Web Page Indexer, which
scans the Web pages you’ve viewed and
remembers which words came from
which page. Think of it as a search engine
for all the pages you’ve viewed. If you’ve
ever been in a situation where you could
not return to a page you know you have
once seen, then MantaDB is for you.
Other utilities are self explanatory: the
LinkChecker, Personal Sidebar, Page
DeFramer, Web Page AutoRefresh, Font
Sizer and Sensible Colors.

Powermarks, an alternative book-
marking utility to your browsers,  trans-
forms your bookmarks into your own per-
sonalised Web directory. Clicking catego-
ry tabs also instantly sorts your book-
marks in ascending or descending order.
Powermarks adds keywords to your book-
marks when you import them and creates
a ‘dictionary’ of these words. Click on any
keyword in the dictionary window, and
voila! You have a list of all related links in
your collection. 

A few tweaks to your browser, like
increasing the cache size, cutting down
on images and multimedia would go a
long way in improving your speed. To
make a Web page available offline, add it
to your Favorites then click Make Avail-
able Offline. IE stores the Web page, com-
plete with graphics, into a temporary
folder. The history folder is a good way to
search for information stored in your
browser’s cache. You can sort the infor-
mation in many ways. It surely beats sav-
ing the document at any place and hav-
ing to search through them again. 

Power searching 
Successful searching involves two key
steps. First, you must have a
clear understanding of how to
prepare your search. To use
search engines effectively, it is
essential to apply techniques
that narrow down results and
push the most relevant pages
to the top of the results list.
Second, you need to know
how to use the various search
tools available on the Inter-
net. Search engines (Google,
AltaVista) are very different from subject
directories (Yahoo!, InfoSpace). Search
engines themselves can vary greatly in size,
accuracy, features, and flexibility. 

Because search engines vary in ability
to interpret complex searches, it’s a good
idea to start your search on a meta-search
engine. Meta-search engines act as a mid-
dle agent, passing on the query to the
major search engines and then returning
the results. Dogpile, AskJeeves, and
MetaCrawler fall in this category.

Along similar lines is a desktop search
utility called Copernic 2000, which simul-
taneously accesses 65 search engines on
the Web. Copernic filters out and elimi-
nates repeat documents found on more
than one engine. It also offers detailed
search histories so that found documents
can be viewed, downloaded or refined at
any time. Copernic 2000 can also auto-
matically eliminate outdated documents
and download documents selected for
consultation at any time. 

It’s not just HTTP 
Contrary to many people’s
understanding, the Internet
consists of more than just
Web pages and e-mail. The
resources/tools that comprise
the Internet are myriad—mes-
sage boards, online databases,
online catalogs, Usenet news-
groups, FTP servers, and
online chats/discussion
groups to name a few. Learn-

ing about them and how they are used
will help you determine how they are
most applicable to your research.

Usenet
Usenet is a set of people who exchange
articles tagged with one or more univer-
sally recognised labels, called ‘newsgroups’.
Usenet is a worldwide discussion system
consisting of a set of newsgroups with
names that are classified hierarchically by
subject—for example, alt.rec.phish and
alt.music.tool for the subject music. ‘Arti-
cles’ or ‘messages’ are ‘posted’ to these
newsgroups by people on computers with
the appropriate software. 

Usenet is available on a wide variety
of computer systems and networks and
its strengths lie in its decentralised nature
and lack of rules. However, its weakness-
es are also its decentralised nature and
lack of rules. 

Mailing lists 
As newsgroups are public discussions in
which you subscribe and participate,
mailing lists are lists of e-mail addresses
of people interested in a similar topic.
Mailing lists can be public or private,
ranging from as few as two participants
to as many as thousands. A mailing list
may be very active or it may be extreme-
ly slow. You should always subscribe to
one mailing list at a time. If, however,
you subscribe to multiple active mailing
lists simultaneously, you will quickly
find yourself overwhelmed with a huge
volume of e-mail messages you cannot
possibly read. Start off with one mailing
list and then expand slowly.

An Internet directory is an index or directo-
ry of Web sites classified according to sub-
ject categories. Directories are also useful
for finding information on a topic when
you don’t have a precise idea of what you
need. Many large directories include a key-
word search option, which usually elimi-
nates the need to work through numerous
levels of topics and subtopics. Because
directories cover only a small fraction of
the pages available on the Web, they are
most effective for finding general informa-
tion on popular or scholarly subjects. If you
are looking for something specific, use a
search engine. Yahoo! is an example of a
wide-ranging Web directory which covers
many popular subject areas. Encyclopaedia
Britannica, on the other hand, is a more
exclusive directory covering subject cate-

gories that  are more academically orient-
ed. Web sites within an Internet directory
are often arranged in a hierarchical manner
beginning with more general subject cate-
gories and advancing to more specific
ones. Many directories contain a search
engine component to help the user navi-
gate through the various levels of subject
categories.

No report looks as good without sta-
tistics, and the Internet is a handy
resource to extract statistical data from
market research sites. To corroborate your
points with statistics, check out
Statistics.com and Forrester.com. For-
rester Research provides demographic
analysis of Web users and the penetration
of the PC market, including age and
income bracket analysis.

What is an Internet Directory?

650 million
Usenet mes-
sages dating
back to the mid-
1990s have been
electronically
resurrected by
Google
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Specialty database directories
Sometimes a specialty database will be
more effective at finding what you need
than a general search engine. A massive
amount of information is not easily or
entirely searchable or accessible via search
tools. Specialty databases are dedicated to
collecting relevant sites for a particular
subject from a wide variety of business,
government, humanities, legal, news, and
science databases. For example,
Achoo.com collects health and medical
sites. Beaucoup.com lists more than 1,200
engines, directories and indices from
around the world. At Search.com you can
search more than 100 specialised data-
bases. If you can’t find it at any of the sites
above, try Internets.com, which is anoth-
er comprehensive specialty database
directory.

Pinpointing people 
For finding basic informa-
tion such as postal address-
es, phone numbers and 
e-mail addresses, there are a
number of ‘people finders’
that might be helpful.
Some people finders are
essentially huge phone
books, while others might specialise in e-
mail addresses and home page URLs.
Some of the best known are Switchboard,
Four11, and Who Where? You might con-
sider listing yourself, just in case someone
else needs to search for you in the future.
A site called Whitepages.com can help
you track a person, his/her business, e-
mail address and phone number. If these
don’t work for you, try unconventional
ways like searching for a name on Usenet,
or alumni sites, search engines and
domain names. The search functions in
ICQ, MSN, or Yahoo! Messenger might be
useful in tracking down a Net-friendly
person.

Locating businesses
With the Internet, you can gather a
tremendous amount of business intelli-
gence on prospects, competitors, vendors,
suppliers, and customers in just a few
hours. Not only does the Net serve as a
giant yellow pages for businesses, you can
locate high level company information,
find sales prospects and learn about an
industry. To find press releases and compa-
ny announcements, biz.yahoo.com/indus-
try/ and PR newswire are valuable
resources.

Bigbook.com and Worldpages.com act
as giant yellow pages for international
businesses—you can search for businesses
closer to home with Tata yellow pages at
Tpyponline.com and Getitindia.com.

Sometimes the best place to seek
information on a company is their 

corporate Web site. You
can find annual reports,
press releases, and infor-
mation about products and
services. If you want to dig
deeper, try searching
through online newspa-
pers. Scan the main page
for the terms ‘Archives’,
‘Search’ or ‘Back Issues’ to

research past articles. Sites like Newspa-
perlinks.com provide links to thousands
of newspapers worldwide. Try and find a
local newspaper located in the vicinity of
the company, and scan the archives or
back issues to research past articles.

Power resources
Everything2.com is man’s attempt to
create a ‘Hitchhikers Guide to the
Galaxy’. Started by the same people who
created Slashdot—the news for nerds
site—Everything2 works like a user 
written encyclopedia, with nodes on
everything from rock bands to particle
physics. Do not forget to check out 

giant online encyclopedias like Britan-
nica.com (an updated version of the
prestigious Encyclopedia Britannica),
Nupedia.com, and H2g2.com.

To satisfy your scientific curiosity,
check out guides at Howstuffworks.com.
If you want to know anything and every-
thing about the Net and computers,
you’ll find the answers at Whatis.com. 

And if you’re looking for insights,
opinions, or help on an extremely niche
topic, say, walkthroughs for a particular
stage in Diablo, check out Allexperts.com,
a site where experts share their extensive
knowledge. You can ask questions on any
topic, from philosophy to trivia. 

So now that you are armed with the
insider’s tips on how to
haul out the informa-
tion you are looking
for in the murky
depths of the Inter-
net, get out your
gear and go fishing!

SRIRAM SHARMA

■ Enter as many precise search terms or
phrases as possible in order to limit the
search. The biggest problem is noise, that
is, irrelevant or inconsequential sites
among the jewels. 
■ Enter singular terms. Most search
engines will find the substring and return
rivers for river. To generalise a subject, use
wildcards where allowed (surg* for sur-
gery, surgeries, surgical). 
■ Do not use common, generic search

terms, or if you must, include them in a
phrase with more specific terms. The
term ‘book’ would be far too generic
unless it’s part of a phrase like ‘book bind-
ing’ or ‘bookseller’.  
■ Enter multiple spellings where appropri-
ate: rationalize, rationalise. If you know
the correct spelling, use synonyms to
broaden an ineffective search. 
■ Use Booleans, especially proximity opera-
tors, to increase the relevance of your hits.

What You Must Do for a Rich Haul

It’s one of those long desperate nights
where you have to finish a term paper
in eight hours. Here are a few pointers
on turning an unmitigated disaster of a
class paper to a passable one. 
■ Take shortcuts. Instead of reading
the entire book read the review!
Reviews, abridged versions, movies are
good quick substitutes.
■ The Internet makes it very easy to
present your viewpoint with statistics. 
■ Use quotations and references.
Bartlett’s Familiar Quotations is an
encyclopaedia of quotes that you can
use for any topic. 
■ Search for Online Writing Labs
(OWL) on the Net. These are put up
by colleges to help students learn the
elements in writing. OWL covers
almost every conceivable aspect of
writing, from grammar and punctua-
tion to choosing a title for your paper.
■ Why walk the path when someone
has already mapped it down? Down-
load term papers from
Schoolsucks.com! Check out the stu-
dent essay network, the evil house of
cheat, and A1termpaper.com. 

A Desperate Night with a
Project Report

Business.com
offers news,
research, and 
contacts for 10,000
public companies
and 44,000 private
companies
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Are you the proverbial snail in your
office, always slow on the comput-
er? Do you use the mouse for all

commands and functions? You should
know better. Studies indicate that produc-
tivity decreases when you shift back and
forth between the keyboard and the
mouse to input data. So learn the short-
cuts, familiarise yourself with your key-
board, increase productivity, and show all
those guys their right place. 

While Windows comes with a lot of
default shortcuts which simplify tasks like
searching and opening windows applica-
tions (see box, ‘Windows Shortcuts you need
to know’) you might want to create some
shortcuts of your own. The easiest way to
create custom shortcuts is through the
Windows Start menu.

Assigning shortcuts in the 
Windows Start menu
You can assign a shortcut to all the pro-
grams available on your PC. Do the fol-
lowing:

Go to Programs in the Start menu
and right-click the application for which
you need a shortcut. 

Choose Properties from the con-
text menu that appears. There’s a text
area in the pop up window where you
key in your shortcut. Press the key com-
bination, for example [Ctrl] + [F12], that
you would like to use as the shortcut
access. You are done.

Test this by pressing the assigned key
([Ctrl] + [F12], as in our example) to
launch your application. 

If there is any default key combina-
tion that Windows uses, it will not
allow you to assign that combination
for your purpose. Instead, it will suggest
alternatives like [Ctrl] + [Alt] + [Your
key]. For example, [Ctrl] + [C] works
across all applications as a copy func-
tion and this key combination cannot
be used for customisation. When 
you press [Ctrl] + [C] it automatically

prompts you to change it to [Ctrl] + [Alt]
+ [C].

Really using the Windows key
Once you’ve had a taste of shortcuts, 
you wouldn’t be able to resist trying 
out newer, better options. Another
method that you can use to create 
custom shortcuts is by using a key 
mapping software.

If you find that keeping track of your
favourite shortcut combinations is a pain
with the Windows Start menu then you
should try Miniwin. This is a system tray
utility that lets you use the [Windows] ( )
key (present on most newer keyboards) to
access programs. Miniwin also allows you
to assign shortcuts to open folders, lock
desktop, logoff user, shutdown and 
much more.

Create a new shortcut key
Assuming you use Notepad often, here’s
how you can assign a shortcut key for
Notepad.

Click on the Miniwin system tray
icon and choose the settings option.

Now press the Plus button on the
Miniwin tool bar. This brings up a window
in which you could assign the shortcut for
your program.

Key in a descriptive name for the
program item and specify the location of
the program executable (in this case
notepad.exe) and then pick a shortcut
key (say n). This will set [ ] + [n] as the
shortcut combination that launches
Notepad.
Note: While you can use any [ ] key shortcut
combination there are very limited options for
using the [Alt] or [Ctrl] keys.

Setting the focus
You’ve done everything but the shortcut
still isn’t working. What’s wrong? Well, it’s
all about focus! When the focus is not on
the software you can’t use any of the
shortcuts that you have created.

Click on Miniwin in your
taskbar and from the pop up menu
choose ‘Set focus’ (a wiser option would
be to assign a shortcut to set the focus
too—Miniwin allows you to do the
same). 

Now when the focus is set, press
the appropriate shortcut (in our example
it’s [ ] + [n]) to start Notepad.

VIDYARAMANAN S.

STEP 2

STEP 1

STEP 3

STEP 2

STEP 1

STEP 2

STEP 1

Speed Secrets
Windows Shortcuts you
Need to Know
Have you ever played around with the
[ ] key on your keyboard? That’s the
small key between the [Alt] and [Ctrl]
keys. If you haven’t, you have lost out
on valuable time doing things in a
roundabout fashion. If someone comes
suddenly behind you and you have
some unwanted windows open, min-
imise all windows in one stroke by
pressing 

] + [M]. You wouldn’t get caught this
way. There are lots of other [ ] key
shortcuts which you could make use of
to increase your productivity level and
to avoid uncomfortable situations.

Some useful default Windows key
Shortcuts
[ ] + [m] - Minimises all windows 
[ ] + [Shift] + [m] - Undo minimise all

windows
[ ] + [e] - Opens Windows 

Explorer 
[ ] + [d] - Switches between 

minimising all open programs and 
showing them all

[ ] + [f] - Opens the Find window 
[ ] + [r] - Opens the Run window 
[ ] + [Break/Pause] - Opens System 

Properties 
[ ] + [Tab] - Cycles through items on

the task bar
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Software
Environment variables not
synchronised

I have Windows Me installed
on my PC. Whenever I open
System Configuration Utility
(by typing msconfig in the Run
command box) an error is dis-
played: ‘Unable to synchronise
the environment variables in
the Windows registry with the
environment variables in the
legacy files Autoexec.bat
and/or CONFIG.SYS’.
Vikaas Arora
Via e-mail

This error arises because
certain command lines pres-
ent in Autoexec.bat do not
match with the Windows reg-
istry. First, locate the autoex-
ec.bat and the CONFIG.SYS
files (to find them, go to Start
> Find > Files or Folders and
search). If these files are
empty, delete them. Restart
your machine (you will boot
fine) and if required,
Windows Me will recreate
those files. When you try to
access msconfig now, you will
not get this error.

Faster connection
I use Windows 98 on a

Celeron 333 MHz system with
128 MB RAM. I use a dial-up
modem and I used the follow-
ing commands in the
Windows registry to speed up
my Net connection: 
MaxMTU=576   String Type 
MaxMSS=536   String Type 
DefaultTTL=128 String Type 
DefaultRcvWindow=4288 String
Type 
But I am not satisfied with the
speed of the Net connection in
spite of having increased the

buffer and TTL size.
Can you please tell me
how I could further
increase the speed of
the connection and
whether there is any
way to increase the

buffer size to maximum
through any software or
through settings in the reg-
istry?
N. K. Sharma
Via e-mail

You have already config-
ured your dial-up connection
to the optimum. If you would
like a faster connection then
you can opt for cable or DSL
Internet connection. 

Missing music files
I had recently copied some

MP3 files to my existing col-

lection of MP3s on my
Creative Nomad Jukebox 20
GB using the given manager
(PlayCentre 2). The free disk
space decreased by the right

amount but I could not find
the copied files on my player.
Besides, it does not show up
on the PlayCentre 2. I have
searched under all the cate-
gories in the software but
haven’t had any luck. Also, I
cannot find the songs in the
player. Can I format the hard
disk inside the player? 
Raghu
Via e-mail

In order to find the copied
files and get them to show
on your player, you will have
to download the latest patch
from the manufacturer’s Web
site, format the whole player
and then start using it. 

Configuring mail accounts
in Outlook Express

I am in trouble with my

Outlook Express (Windows 98
SE) e-mail configuration. 
I have accounts with
VSNL.com, Yahoo.com,
Hotmail.com, Rediffmail.com,
Sify.com and India.com. Please
help me configure these
accounts in Outlook Express. I
did try a lot but each time
Outlook fails to get a connec-
tion with the mail server. I also
don’t know which type of
servers/services (POP3, SMTP,
etc) these e-mail services use.
Where could I get the precise
information? 
Ligon
Via e-mail

In order to download 
e-mail in any e-mail client
you should have the right
server names so that the serv-
er can be contacted and the
mail downloaded from your
account to your machine. In
order to download mail from
Yahoo! and VSNL, you have
to set the server as POP3. For
Yahoo!, type
pop.mail.yahoo.com as the
incoming server and
smtp.mail.yahoo.com as the out-
going server. For VSNL, the
incoming server is
pop.vsnl.com and the 
outgoing server is
smtp.vsnl.com. About your
Hotmail account, when you
add an account in Outlook

A tripping UPS, BIOS problems, truant modem…find your 
answers here for these and more

■ troubleshooting

MS config error in Windows Me

Creative Nomad Juke box (20 GB)
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Express, it automatically con-
figures the http server so you
need not worry about that.
You will not be able to down-
load Sify and Rediff mail in
your e-mail client, as they do
not provide the server names.

Virus attack
I have a P-III 800-MHz sys-

tem with 384 MB SDRAM, a
20 GB hard disk, a 50x 
CD-ROM and 8x4x32x CD-
Writer. I use Nero as the burn-
ing software. Whenever I start
Windows Me, I get the follow-
ing error. Can you tell me why
this problem arises?
Deepak Chander
Via e-mail

This error is because your
system has been infected
with a virus. Firstly, cd_load
is an advertising spyware:
CyDoor (CD_Load.exe) or an
AD-Trojan. Not only does it
send you ads but it also
assigns you a unique pin and
tracks you. To get rid of it:
1. Delete the following files
(usually found in C:\WIN-
DOWS\SYSTEM):
CD_CLINT.DLL
CD_GIF.DLL
CD_SWF.DLL

CD_LOAD.EXE
2. Delete the ADCACHE fold-
er and its contents (usually
found under
C:\WINDOWS\SYSTEM).
3. Remove Cydoor and
Cydoor Services from the
Windows Registry. The follow-
ing keys should be deleted: 
HKEY_CURRENT_USER\Soft
ware\Cydoor\
HKEY_CURRENT_USER\Soft
ware\CydoorServices\
HKEY_LOCAL_MACHINE\Sof
tware\Microsoft\Windows\C
urrentVersion\Run\Cydoor=
CD_Load.exe
This should rid your system
of the virus.

Of a Linux boot disk
I use Red Hat Linux 7.0 as

one of my operating systems. I
use the boot floppy, which I
created during the Linux instal-
lation, and I have deleted LILO
from the MBR (Master Boot
Record). Recently my Linux
boot floppy got damaged and
now I am unable to boot to
the Linux OS. What could be
the solution to my problem? Is
it possible to create another
boot floppy on another
machine running Redhat Linux
7.0 and use it in my machine
for booting? If so, can you also

advise me on how to cre-
ate a boot floppy under
Linux?
Anirban Guha
Via e-mail

The Red Hat 7.0 CDs
have boot images, kernel
images and a copy of
loadlin, which you can

use to boot Linux from DOS,
and provide parameters such
as which partition to use and
so on. This allows you to
boot into your current
installed copy of Linux and
re-create a boot disk with
your copy of the kernel.

Windows and Linux on a
single partition

I have a Pentium III 933-
MHz system, 128 MB RAM
and a 20 GB hard disk drive. I
have three partitions on my

hard disk, each with a disk
capacity of 6 GB. I have
loaded Windows 2000
Professional along with
Windows Me in the first parti-
tion (C:). Can I load Linux in
either the same partition or
any another one along with
these two OSes? If yes, could
you suggest some method by
which this can be done? Is
LILO supported on a system
loaded with Windows 2000
Professional? 
Nikhil
Via e-mail

You can install Linux on
its own native partition. You
can use a custom boot disk
that can be created while set-
ting up Linux, and choose
not to use LILO. Red Hat 7.2
comes with GRUB, a new
boot loader that supports
Windows 2000/XP directly.

Configuration error
I am facing a problem in

my stand-alone PC loaded
with Windows NT
WorkStation. While accessing
the Internet via the dial-up
menu it connects perfectly,
but if I use the connection dia-
log box while double-clicking
IE 4.0, it gives a message 
stating, ‘Unable to connect
due to Configuration Error’.

What do I do?
Amit Kumar De
Via e-mail

This error is because you
have not set that particular
connection as the default
connection for Internet
Explorer to connect to the
Internet. Do that and your
problem will be solved.

Video editing software
I have a Celeron 300 MHz

PC with Windows Me as the
OS. Is there any software avail-
able, which I can use to cut
some parts of a VCD movie
and store it in my computer? I
have a Casio digital diary with
Send and Receive data option
in the communication menu.
Please tell me how I can con-
nect it to my computer and
also a software that can do
this.
Manan Bajoria
Via e-mail

In order to edit a VCD
movie you can use a software
such as iFilmEdit available for
download at www.cinax.com.
Now for your second query:
you will have to buy a data
cable especially for the digital
diary to connect it to the
computer. It’s easily available
in the market. Once you con-
nect it to your serial port,

Before you buy a PC
I I plan to buy a PC with a Pentium 4 processor. I’d

like to know which board offers a better per-
formance, an 850 chipset with RDRAM
or an 845 chipset with SDRAM? Is it
true that the RDRAM does not
perform well at least in compari-
son with the SDRAM?
Pradeep
Via e-mail

A Pentium 4 with
SDRAM is a good solution
for those who demand
good performance at eco-
nomical prices. However, if
you want top-notch per-
formance from a P4-based
machine, then opt for the
850 chipset, which supports
RDRAM.

Configure your e-mail client

The message indicates your machine
is infected with a virus
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you will have to install a
software called CASIF/Win in
order to enable your digital
diary to communicate with
your computer. 

Accessing mail
Our company has four

nodes and a server. We use
Netscape as our e-mail client
and we have only one e-mail
ID such as xxx@vsnl.com. I
would like to set up a system
whereby all e-mail down-
loaded on our server is auto-
matically sent to all the nodes
and can be accessed 
simultaneously. 
Shahnawaz Khan
Via e-mail

In order to set up a system
as you desire, you should set
it to leave a copy of the mail
on the server. Since a copy of
the e-mail is there on the
server, all clients can down-
load it. 

However, this would
mean that over a period of
time, a lot of server space
will be taken up by these e-
mail. Hence, you could free
up server space by manually
downloading old mail on 
to another machine for 
storage.

Connect using Win Proxy
I connect to the Internet

using Win Proxy. I am unable
to configure Microsoft
Outlook or Netscape
Communicator to work with
Win Proxy. How do I over-
come this problem?
Lejo Joseph 
Via e-mail

For Netscape, just config-
ure it to use SOCKS proxy for
external connections, and it
will automatically use SOCKS
to access all SMTP and POP3
services. For the POP3 and
SMTP proxy through
Outlook, you would need to
enter usename% servername as
the username, and the pass-
word remains the same for
any server. Enter the server
name as the proxy’s IP
address. Here ‘%’ stands as a
separator between the user-
name and password.

Hardware
More RAM 

I have an assem-
bled system, a
Celeron 366 MHz
CPU with 32 MB
SDRAM and I use
Windows 98
SE. My computer
being slow, I want

to increase the RAM size.
What technical specifications
must I note before buying
the RAM? How much RAM
will my motherboard sup-
port? I do not know the
name of my motherboard
manufacturer, but with the
help of the BIOS string I
found that it uses an Intel
i810E chipset. The BIOS ID
is 09/03/1999-i810-ITE8712-
6A69MSMDC-00.
Anantha Narayanan N.
Via e-mail

As you have a Celeron
processor, your system runs
at 66 MHz FSB (Front Side
Bus). Since most newer RAM
modules available in the
market (specified at 133 MHz
or higher) are also backward
compatible, you need not
worry as to whether the
RAM you buy will be com-
patible with your machine or
not. About your second
query, as per the information
you have provided, the Intel
810E chipset motherboard
supports a maximum of 
512 MB PC-133 RAM.

Dim display
I have an Intel Celeron 400

processor and I use Windows
Me as the OS. When I start
my computer, the display is
dim for the first 10 minutes or
so, after which it becomes
normal. I had a SiS (8 MB)
AGP card, which I replaced
with an ASUS Riva TNT (32
MB) card. But the problem
persists. Please help.
Rajendra
Via e-mail

There is nothing wrong
with your graphics card,
hence replacing it with a bet-
ter quality card will not solve

your problem. It is likely that
the cable that connects your
monitor to the graphics card
is loose. Refit the cable tight-
ly and your problem will be
solved.  

Monitor on the blink
I have an Intel 810 chipset

and a 15-inch monitor. One
out of 10 times, on restarting
the computer, the LED on the
monitor panel blinks continu-
ously but nothing appears on
the screen. Only after switch-
ing off the monitor and
switching it on again does the
problem go away. Please
advise me.
Sapan Agarwal
Via e-mail

The problem you are fac-
ing could be because of a
faulty monitor. You must
consult the service centre
and get it thoroughly
checked.

Tripping away
I have a 500 VA UPS.

Sometimes, even when the
power supply is on, the UPS
switches to battery power
while at other times it oscil-
lates between the battery and
main supply. There are also
times when the UPS gets com-
pletely discharged and I am
forced to switch off my com-
puter even when power sup-
ply is present. Please tell me
what to do.
Sapan Agarwal
Via e-mail

To begin with, there is
nothing wrong with the UPS
that you are using. It is more
likely that you are using an
offline or a line interactive
UPS, hence when the voltage
goes up it switches back to
the mains and when it goes
down it trips to the battery.
In order to avoid this, use an
online UPS that continuous-
ly runs the machine from
the UPS itself while simulta-
neously charging the battery.
It would then not need to
trip itself to the mains or the
battery.     

Sound driver problems
I have a Pentium III (650 MHz) processor and Intel 810

motherboard. Sometimes my sound driver (Crystal Codec) gets
corrupt and the volume icon in the system tray vanishes. If I
install the sound driver again, the volume icon appears in the
system tray but on restarting, it vanishes again. Please help. 
Sapan Agarwal
Via e-mail

It would appear that the drivers you are using are corrupt.
Hence even on successful installation, it does not function
correctly. Go to Add/Remove programs and remove the

sound drivers. Then
go to the manu-
facturer’s Web
site and down-
load the latest
version of the

drivers and
install them.
This should
take care of
your problem. 

ILLUSTRATIONS : Mahesh Benkar

Leave a copy of your e-mail on the server
so that all clients can download it
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Moody modem
My system has a Pentium

III, 800-MHz processor on an
Intel 810e-based motherboard
with 256 MB RAM. I currently

run Red Hat Linux 7.0,
Windows 98 SE and Windows
XP (Professional) on it. My
internal modem (HSP56
Micromodem) does not work

in Windows XP (but works per-
fectly in Windows 98 on
COM4). Although it shows as
working properly in the device
manager (on COM3), the
moment I double-click on the
connection icon, a message
saying ‘Opening port…’
appears and the system hangs.
After that it doesn’t respond to
any keys and I have to reset it
manually. I have tried chang-
ing the modem IRQ. Is there a
solution? 
Bobby Sherique
Via e-mail

In order to get your
modem functioning properly
in Windows XP you should
download the latest soft
modem (internal modem)
drivers for your chipset. In
case the manufacturer hasn’t
developed any drivers for
Windows XP you can down-
load and install the
Windows 2000 WDM drivers
and your modem should
work fine.

Soundcard error
The following lines are pres-

ent in my Autoexec.bat file:
SET BLASTER=A220 I5 D1 H5
P330  T6 
SET CTSYN=C:\WINDOWS 
C:\Program 
Files\Creative\SBLive\DOS-
DRV\Sbeinit.com  
During boot up the
Sbeinit.com file shows me the
following error: 
Creative SB16 Emulation
Driver. Version 4.00 
SB IRQ conflicting with PCI
IRQ 
Creative SB16 Emulation
Driver not loading 
But my soundcard works fine.
How do I get rid of this error
message?
Sarathy
Via e-mail

In order to get rid of the
error message, go to your
BIOS settings and make sure
you allot your soundcard to

IRQ5 PCI/ISA bus. This can
be done through the
PNP/PCI option in the BIOS.
The settings indicated in the
Autoexec.bat file are meant
for plain DOS mode for play-
ing DOS-based games or run-
ning DOS-based audio pro-
grams. If you don’t play such
games, you can safely
remove these commands
from the Autoexec.bat file.   

BIOS baffler
When I start my computer,

after the memory check and
the detection of the primary
master and slaves, it stops
and shows a message that
says, ‘Checksum Error -
Defaults Loaded. Press F1 to
continue’. What is the solu-
tion to this?
Manu Iyer
Via e-mail

The error message that
you get could be because of
two reasons. Either your
BIOS battery is discharged
(or your battery is dead) or
your BIOS is corrupt. To
solve this problem, first try
to clear your CMOS settings
by locating the ‘CMOS clear’
jumper. Use your mother-
board manual to locate the
exact position of the
jumper. In case there are no
jumpers, but there are two
points, then short them.
Once you have cleared your
BIOS settings, reboot your
machine. If the error contin-
ues to appear, shutdown
your machine and try
changing your battery. If the
error still appears, it means
your BIOS is corrupt and
you will have to flash your
BIOS. If you are not sure
how to flash a BIOS, do not
attempt to do it by yourself
as you might render the
motherboard useless. So if
your computer is working
just fine even with the error
message, simply ignore it.

Disabling a program
After installing programs

such as MSN Messenger,
Yahoo Messenger and Adobe
Acrobat Reader I find that my
computer takes a little longer
to completely load Windows.
I assume it is because even
these programs load up on
start up. I do use these pro-
grams, but I don’t want them
to load up automatically.
How do I fix that?
Harish
Via e-mail 

You can use these pro-
grams without them starting
up automatically while load-
ing Windows. All you have
to do is go to Preferences in
each of these programs. You
will find an option, which
asks whether you would like
to run the program auto-
matically on starting Win-
dows. Simply disable that
option and the program will
not start on its own. In case
you have a program that
does not support this

option, go to Start > Run and
type in msconfig. A small pro-
gram will open up, which
allows you to disable your
start up programs. 

Missing CD-ROM drive
I recently installed 

Windows 2000 on my
machine and now whenever I
click on My Computer it takes
a while to open up. Some-
times even when it opens it
fails to display my CD-ROM
drive. At other times the CD-
ROM drive is displayed and it
works fine. This never hap-
pened while I was using Win-
dows 98. Where exactly does
the problem lie?
Shweta
Via e-mail 

There is nothing wrong
with your CD-ROM drive.
The problem lies with Win-
dows 2000 and the BIOS of
your motherboard. It seems
that you have not upgraded
your BIOS prior to
installing Windows 2000, as
a result of which the BIOS
fails to detect your CD-
ROM drive. You will have to
go to the manufacturer’s
Web site and flash your
BIOS. You will not face this
problem again. 

Removing Nimda
My computer has been

infected with the Nimda virus.
I installed Norton Antivirus
but it failed to detect some of
the infected files. The ones
that were detected have been
quarantined. Can you suggest
a way to completely remove
the virus?
Suman
Via e-mail 

To completely remove
the Nimda virus you will
have to download a removal
tool specifically created to
remove this virus. You can
download the tool from
www.pandasoftware.com and
run it to remove all strains
of the virus.

Troubleshooting FAQs

Send your problems to sos@jasubhai.com
or write in to Digit, D-222/2, Om Sagar, MIDC,
Nerul-400 706

Disable MSN Messenger
from startup
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Must-have plugins
for Winamp
What sets apart Winamp
from other MP3 players is
the large number of plug-
ins available that extend its
capabilities.

Wowthing DSP plugin 
Winamp provides you with
some default equaliser
options, but there is no
actual boost in terms of
sound quality. Wowthing
enhances the sound quality
through its sound boosting
abilities, which include
Trubass for bass adjust-
ments and Wow for treble.
Snag it from

www.rioport.com/software/Wo
wThing.exe.

SoftAmp VirtualSound 
If you cannot afford a four-
point surround sound
speaker, you can simulate

it with this wonderful 
plugin. This DSP plugin
allows you to position four
virtual speakers (two
woofers and two tweeters)
around a virtual person 
on the screen. For audio-
philes who cannot afford
high-end speakers and
have to deal with clunky
headphones or speakers,
this one's definitely 

handy. It's yours at
www.softamp.com.

X-Plugin
X-Plugin is one of those
funky plugins. It has 15
speakers (yes you read it
right, it is 15) neatly placed
around your Winamp. The
speakers can be docked
anywhere on the desktop,
with some cool looking

insight ■
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TROUBLESHOOTING
Solutions to some common problems you might be facing

with your Winamp

Why is Winamp's out-
put jumpy?
There could be several reasons
why your Winamp output stut-
ters or jumps. It may be due to
an aging computer, too many
processes, fragmented hard-
drives, and so on. If the quality of
MP3 playback means the world
to you, just follow these steps to
listen to music smoother than a
well-aged Chardonnay. 

Try these settings and give it a test run. Now open Photoshop, 10
browser windows, and a dozen applications to see if it stutters. Most
likely it won’t. 

Winamp’s volume controls don’t work on my system
Open the Preferences window and select Plugins/Output. Select
Nullsoft waveOut Plugin and click Configure. Look for a little check-
box labelled Alt setting mode. Check it, click OK, and close the
Preferences window. Now play some music and try out your new
volume controls.

[Alt] + [F]
[J]
Up and down arrows
Left and right arrows
[Z], [X], [C], [V], and [B] 
[Shift] + [V]
[Ctrl] + [Tab]
[Ctrl] + [P] 
[Alt] + [S]

Brings up the main menu
Jump to file
Adjust the Volume
Fast forward or rewind the song
Previous Track, Play, Pause, Stop, Next Track
Stop playback and fade out 
Cycle between all open Winamp windows
Brings up the Preferences
Brings up the skins menu

PLAYBACK MUSIC
Check out some keyboard shortcuts and plugins you
just cannot do without, create new skins, burn your
music files onto CDs and more

Wowthing: For audiophiles looking
to tweak their Winamp beyond the
normal equaliser pulgins

1

2

3

1. Go to Winamp >
Preferences > Input, and
select the MPEG audio
decoder. Increase the thread
priority to the highest.
Increase the Full File Buffer
to 6000 Kilobytes. This will
make Winamp load the
entire song if it is smaller
than that. 

2. Go to Winamp >
Preferences > Output, and
increase the buffer length to
10,000 ms. Set priority to
Time Critical.

3. Go to Winamp >
Preferences > Options and
increase the Process Priority
Class to Realtime.

Winamp Keyboard Shortcuts
Right-click the Winamp title bar and choose About Winamp
or press [Alt] + [F] + [W] to bring up a list of more than 50

keyboard shortcuts. Here are some important ones:

If you cannot afford a four-
point surround sound
speaker, you can simulate

it with this wonderful 
plugin. This DSP plugin
allows you to position four
virtual speakers (two

handy. It's yours at
www.softamp.com.
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equaliser lights. It makes
you feel as if you are in a
party environment. Snag
this one from
www.winamp.com/plugins.

Reproduction 
Control 1.28
If you frequently use
Winamp and find it difficult
to shuttle back and forth
between windows to open
files, reduce the volume or
skip a track (or any of those
basic functionalities), Repro-
duction Control is the
answer to your prayers. You
can control your Winamp
with customised shortcuts
that you can use even when
you are not in the Winamp
window. For instance, you
can increase or decrease the
volume in Winamp by tap-
ping your customised hot key
even while working on a
Word document. Lift it from
www.winamp.com/plug-ins.

Voluptuous Valentine’s
dancer
Tired of seeing the same
beat up visualisation
options? Give yourself a
visual treat with WildTan-
gent’s Valentine’s dancer.
The valentine dancer

swings to the beat of the
music and will remain a
novelty for some time. Pick
it up from
www.wildtangent.com

Creating your own
Skins for Winamp
One of the winning points
of Winamp is its customis-
ability. A vast community of
users has created numerous
input, output and visualisa-
tion plugins. 

Tools for some Winamp
skinning 
Making your own skin for
Winamp is pretty easy. But
before you get down and
stick your elbows in the dirt,
here's a list of programs you
need: 
■ A paint program such as
Photoshop or Paint Shop
Pro or MS Paint
■ Winamp’s base skin to use
as a template. 
■ A text editor to configure
the fonts and colours of the
browser and playlist editor.
Notepad will work just fine.
■ An icon editor such as
Icon Edit Pro or Microange-
lo if you want to edit the
cursors and pointers for
your skin.
■ A compression tool to
browse through skins and
zip it all up when it’s done—
WinZip for instance.

Start at the base
The .wsz base skin is a Zip
file designed to keep all the
pieces of the skin organ-
ised. Every skin that’s made
is open source. You can
browse though it to look
for design tips. The best
way to get started is to

extract a base skin and mod-
ify it. Create a new directory
in your Winamp\Skins
directory. Create a new fold-
er in your Skins directory,
and unzip the Winamp base
skin with an unzip utility.
Once you’ve installed the
base skin, you can look at
the files in that directory.
There should be a whole
bunch of .cur (cursor) files,
and .bmp files, and a few
.txt files. All of these files are
optional. Any missing files
will use Winamp’s defaults.

Editing the skin
Editing the BMP files is a bit
complex. The filenames are
self-explanatory, but if you
belong to the echelons of
the uninitiated then,   
■ Pledit.bmp changes the
look of the Playlist Editor
■ Eqmain.bmp changes 
the look of the graphical
equalizer
■ Main.bmp changes the
look of the main window

All the other .bmp files
change the look of individ-
ual controls of the main
interface. Once you’ve made
changes to the different

BMP files, zip them
up and hit [F5] in
Winamp to reload
the images.

Editing the text
files
You can change
other aspects of
Winamp using the
three .txt files includ-
ed in the skin. 
■ Pledit.txt changes
the font and colour
of the playlist text. 
■ Viscolor.txt has 24

lines, with each line con-
sisting of a RGB triplet and
a comment: 24,33,41, //
comment. These 24 lines
define the colours used in
Winamp’s built-in visualisa-
tion. Region.txt lets you
specify a sub-region of
Winamp’s main and
equaliser windows to 
show. This lets you carve
out the parts you want to
show, and keep the rest
transparent.

Editing cursors
The filenames for the cursor
files are also pretty self-
explanatory.  
■ EQTitle.cur is for the EQ's
title bar. 
■ Normal.cur is for use in
Winamp’s main window. 
■ PWSSize.cur means that
this cursor is for the Playlist
Editor. 

If you have any doubt,
you can just try making a
major change to check
where the change takes
effect. Cursor changes hap-
pen immediately; there's no
need to reload the current
skin in Winamp to 
see them. 

The .wsz file will open in any unarchiving utili-
ty. Here’s the framework of the main window
in Winamp

Valentine’s dancer: it swings to your
tune
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Keeping it Real

Get a copy of RealProducer
Basic from
RealNetworks.com. The
Basic version is free.

Open RealProducer and
click New Session. A wizard
will pop up. Click Record
from file and hit OK.

Select Capture Audio and

click Next. Give your set a
name and click Next.
Choose either Multi-rate
stream or Single-rate stream,
depending on your server,
and click Next. Select your
target audience and click
Next. Select Music (higher
quality, but mono) or Stereo
Music (lower quality, but

stereo) and click Next. Click
Finish. Begin recording by
clicking the Start button.

Now all you have to do is
find a service such as
Groovefactory, or create
your own server that will
host the files.

SHOUTcast
Nullsoft’s SHOUTcast is a
streaming audio system
designed to work across all
platforms. At the heart of
SHOUTcast is the DNAS
(the distributed network
audio server). When you
setup a SHOUTcast server
the DNAS accepts the audio
stream from Winamp and
the SHOUTcast DSP plugin.
It then delivers it to listen-
ers who are connected to
this DNAS. In this set up,
you could either be a listen-
er, source provider, or a
server.

Listening to streaming
radio 
Start an instance of
Winamp. Visit www.shout-
cast.com, www.live365.com, or
www.icecast.org. Select your
music category from the
choices available. Click on
the Tune icon and the

stream automatically starts
with your MP3 player (usu-
ally Winamp). No special
installations are required. 

Source provider 
You can be a music source
provider and any DNAS
could listen to you. You
could use Winamp as your
music player. A SHOUTcast
source plugin (this can be
downloaded from
www.shoutcast.com) needs to
be installed for your
Winamp. This plugin pro-
vides Winamp with broad-
casting abilities and you are
now ready to stream your
music. Remember, to enable
others to listen to what you
play, you need to have a
DNAS. 

Time to server  
Download the SHOUTcast
server software from the site
and install it. Start the DNAS
GUI. Open the configuration
file by clicking on the Edit
Config option from the
menu bar. This opens the
configuration script in a
default viewer (usually
Notepad). Every entry has an
easy-to-follow remark along
side. Set the maximum user
limit taking your bandwidth
into account.

If you know a little about
IP and networks, you can
mess around with the SrcIP
and DestIP (source and desti-
nation IP). If not, leave
them at their defaults. Now
you are ready to listen from
a source and stream it across
to users connected to the
DNAS of your SHOUTcast
server. 

You can be both, the
service provider and the
server. You can set up both
the services in the same
computer or, depending
upon your resource avail-
ability, you can set a couple
of computers as servers and
a single computer as a server
listening from all the service
providers.

BROADCAST: A RADIO STATION
OF YOUR OWN

Internet radio works on the simple premise that you
play your music. Start a channel, sell it to your
friends, and fight back against the networks that’ve
been strangulating you with boybands and all that
mellow nonsense. All it takes is a little know-how,
a decent soundcard and some basic encoding soft-
ware that you can get for free

If you would like to make
a live recording of all the
tunes on the Web, a

straightforward approach to
this is the disk writer plugin
of Winamp. It writes a WAV
file at the time of capture
from the relay. This direct
approach requires more
work and disk space, and
some editing with a wave
editor such as SoundForge
or CoolEdit. A faster way to
do this is StreamRipper,
which creates MP3s out of
streaming radio. You can obtain
StreamRipper32 from 
www.oddsock.org/tools/sripper.

StreamRipper32 does not

create any desktop icons or start
menu items. So go to the folder
and run an instance of the pro-
gram. On the top left, under

Broadcast Parameters, you will
need to enter the full URL of the
stream. 

Under the Output Section,
you will need to select a
Destination Directory.
StreamRipper32 will create a

number of sub-directories
and delete and move files on
its own. It will be limited by
the permissions you have on
the parent directory. You
can enter a number in the
Max Bytes to Rip field to
control when to stop record-
ing, but the default value of
zero will allow it to run until
you either run out of disk or
click the Stop Rip button. 
Click the Start Rip button

and let StreamRipper do its
thing. 

Streamripper snags an MP3 from SHOUTcast live

Streamripping: Recording Live

Open RealProducer and
click New Session. A wizard
will pop up. Click Record
from file and hit OK.

Select Capture Audio and

click Next. Give your set a
name and click Next.
Choose either Multi-rate
stream or Single-rate stream,
depending on your server,
and click Next. Select your
target audience and click
Next. Select Music (higher
quality, but mono) or Stereo
Music (lower quality, but 

Start an instance of
Winamp. Visit www.shout-
cast.com, www.live365.com, or
www.icecast.org. Select your
music category from the
choices available. Click on
the Tune icon and the 

Download the SHOUTcast
server software from the site
and install it. Start the DNAS
GUI. Open the configuration
file by clicking on the Edit
Config option from the
menu bar. This opens the
configuration script in a
default viewer (usually
Notepad). Every entry has an
easy-to-follow remark along
side. Set the maximum user
limit taking your bandwidth
into account.

If you know a little about
IP and networks, you can
mess around with the SrcIP
and DestIP (source and desti-
nation IP). If not, leave them
at their defaults. Now you
are ready to listen from a
source and stream it across
to users connected to the
DNAS of your SHOUTcast
server. 

You can be both, the
service provider and the
server. You can set up both
the services in the same
computer or, depending
upon your resource avail-
ability, you can set a couple
of computers as servers and
a single computer as a server
listening from all the service
providers.



13

Burning music files on
to CDs
Got a collection of your
favourite Transglobal Under-
ground numbers? You can
burn custom compilations
like these, and with the
right tools and directions it’s
child’s play. The tools
required for this exercise are
a CD-writer, CD-burning
software and the songs of
your choice in WAV or MP3
format. You could use the

demo version of Nero CD
burning software to burn
your CDs. This allows you to
record your own custom
audio CDs that can be
played in any standard
home or car stereo.
■ Install the software:
Download the demo version
of the burning software from
www.ahead.de. Install the
application and launch it.
The software prompts you
with a registration screen.
Click the Demo button. The
software throws open an
option to create a new CD or
to duplicate another CD. (If
it doesn’t, click on File >
New). Choose the Create
New CD option and click on
Next.
■ Select the type of CD:
Next, you need to choose
the type of the CD. Choose
it via the next window that
pops up. Choose Audio CD
from the options listed and
proceed to the next screen
to finalise. 
■ Drag and Drop the files:
There will be two panes visi-
ble to you in the main Nero
Window. On the left you
have the explorer that you
can use to locate the tracks
you will record. On the right
is the compilation explorer,
which lists the contents of
the CD. Drag and drop the
files of your choice from the
left pane to the right. A sta-
tus bar below indicates the
maximum minutes you
could record. You can record

Format
MP3

Ogg Vorbis

WMA

LAME

MP3 Pro

Pros
Excellent sound quality at
high bitrates; versatile,
portable, swappable

Open source; has plugins for
popular applications such as
Winamp, Sonique; supports
multiple channels

Low CPU requirements,
available to anyone using
Media Player 
LAME used to be Lame 
Ain't an MP3 Encoder. LAME
is a completely open,
patent-free, license-free
Codec 
Offers you decent quality
sound at low bitrates; low
system requirements 

Cons
There is no need to pay to
get a license to decode an
MP3, but there is one to
encode. Even if you write a
free encoder, you are sup-
posed to pay for a license
Popular only among geek cir-
cles and open source zealots

WMA 8 is copy protected 

—

SBR technology synthesises
high frequencies rather than
recovers them.

Go for this if
Disk space is cheap. Quality is
something that once lost
through over-compression
and/or a poor Codec, can
never be recovered 

You are developing an applica-
tion where audio compression
is needed (chat, game sound,
etc). You need to pay to use
this Codec. Ogg Vorbis is
good for small developers
Quality requirements are not
very strict and storage space is
quite limited
Quality is highly imperative
and you plan to burn high
quality audio CDs

Your portable MP3 player has
upgradeable firmware 

Lossy audio compression is
the JPG of music: for a
minor loss of quality that
you cannot discern, you
have a sound file which is

many times smaller than the
original and can be broad-
cast, swapped and played on
portable media. The battle
for the best compression

Codec is far from complete.
Audio compression is a new
concept and there are still
various algorithms contest-
ing for public approval.

BURNING/RIPPING MUSIC
Want to move music out of your PC on to a CD?
Make live-recordings of streaming music? Here's
how

Which format do I pick?
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72 to 80 minutes of music
depending upon the capaci-
ty of the CD. 
■ Burn it: Once the files are
chosen and you are ready to
burn, choose Write from the
File menu. This opens a win-
dow seeking your confirma-
tion to burn the CD. Click
on the Burn button. As soon
as the process begins you
will notice a progress bar
while each track is being
burnt on the CD. Once the
burning is done the red light
near the progress bar turns
green indicating successful
completion

There are, of course,
many ways of doing this—
MusicMatch Jukebox is a
freeware software that does
the same. Another popular
alternative is Easy CD Cre-
ator. The program accepts
popular audio formats such
as MP3 and WAV as input.
Easy CD Creator supports
BURN-Proof (Buffer Under
RuN error Proof) technology.

Converting for the
PC: Ripping using
MusicMatch 
Open MusicMatch.
Insert a CD into your
CD-ROM. If you’re not
connected to the Inter-
net, connect now. The
program will automati-
cally search the online
CDDB. If it finds a
match for your CD, all
the artist and album

information will be filled for
you. If it doesn’t return a
match, you may need to
type in the track listings. 

After the CDDB returns a
match or when you’ve 
completed entering artist
and album names and all
the track titles, hit the
record button on the
recorder. Depending on the
speed of your PC, you
should have the CD com-
pletely ripped in less than
10 minutes.

The bitrate dilemma:
Which one do you pick?
Music available on CDs and
other similar media can be
digitally encoded into 
various music formats—from
WMA to Ogg Vorbis to MP3.
But all of them follow a
common digital coding con-
vention called bitrate. This
defines how much of detail
(number of bits) is to be
stored per second of a song
in an encoded file. Bitrate
decides the quality of the
encoded file and its size too.
Does it really make a drastic
difference in terms of sound
quality when you encode
files with different bitrates?
The more details (more bits
per second or high bit rate)
you store into a file, the bet-
ter the sound quality. Stor-
ing more information per
second of music builds a
larger MP3 file. If you are
sensitive to subtle musical
details and are finicky about
sound reproduction, you
should opt for a higher
bitrate encoding (greater

than 192 Kbps). 128 Kbps is
the usual encoding level
music enthusiasts choose.
Encoding at this rate offers a
perfect balance of small file
size and quality of music.

Music encoding can be
done in three ways—con-
stant bits, average bits or
variable bits per second of
music. In constant bitrate

(CBR) the same number of
bits is added to each second
or frame of music. Whether
it’s a scream or silence, the

same number of
bits is added
into the

encoded file (which is actu-
ally a waste, since periods of
silence don’t require more
bits to be stored). Average
bitrate (ABR) lets you
choose an average number
of bits that are to be added
to each frame. Variable
bitrate (VBR) is an intelli-
gent method introduced by
Xingtech, which decides on
how many bits are to be put
into a frame or second
depending on the complex-
ity of the sound. Software
that employ the VBR
encoding scheme use lesser
bits for periods of silence
and more bits according to
the frequency (sound) level
of the music.

The next time you rip
your music CD, don’t forget
to use VBR and encode at
high bitrates. You might end
up with a smaller file size
than if you used CBR or
ABR. The only caveat is that
if you are into portable MP3
players, most do not play
bitrates higher than 192
Kbps. Check your player-
specifications before you
encode your MP3s.

FEBRUARY 2002

Music Match JukeBox

The Nero wizard is the least complicated
method of burning MP3s 

MP3’s can be encoded with various
parameters

If you have an aging but
priceless collection of tapes
lying around, take a day off
to try this out. 

Connect the tape player
to your soundcard’s line-in
terminal with a 0.25-inch
mini-jack and record the
contents of your tape as a
WAV file. Nullsoft’s
Diskwriter plugin, or Music-
Match Jukebox or any plain
vanilla wave editor will do. 

Set the software to record
from the line-in channel,
press Play on your tape deck,
and wait for the tape to play. 

After the WAV file has
been written, and the con-
version from analog to digi-
tal is complete, comes the
process of normalisation.

Normalising your file
involves searching for any
abnormalities in it and pre-
venting it from playing too
low or too loud. 

Cut the WAV file to
pieces. From this you can
convert to MP3 or to any
other format you want
using Audiocatalyst or any
other encoding software. It
is possible to burn the tape
onto an audio CD as well,
but the quality will not be
as good on a CD since the
original source was a tape. 

Before you create the
CDs, you may want to
transfer the WAV files to an
editing studio such as Pro
Tools, SoundForge XP Stu-
dio 5.0, or CoolEdit Pro.

Moving Music from Audio Tapes
to MP3s

Music available on CDs and
other similar media can be
digitally encoded into 
various music formats—from
WMA to Ogg Vorbis to MP3.
But all of them follow a com-
mon digital coding conven-
tion called bitrate. This
defines how much of detail
(number of bits) is to be
stored per second of a song
in an encoded file. Bitrate
decides the quality of the
encoded file and its size too.
Does it really make a drastic
difference in terms of sound
quality when you encode
files with different bitrates?
The more details (more bits
per second or high bit rate)
you store into a file, the bet-
ter the sound quality. Storing
more information per sec-
ond of music builds a larger
MP3 file. If you are sensitive
to subtle musical details and
are finicky about sound
reproduction, you should
opt for a higher bitrate
encoding (greater

or frame of music. Whether
it’s a scream or silence, the

same number of
bits is added
into the 

players, most do not play
bitrates higher than 192
Kbps. Check your player-
specifications before you
encode your MP3s.
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Editing the ID3 tag
with MusicMatch Jukebox
Click the My Library tab.
Right-click on a track and
select Edit Track Tag. Select
information from drop-
down menus or specify
your own information. You
can even put URLs and 
e-mail addresses in the
Notes and Bios section.

Utilising CDDB
Say goodbye to ever having
to type in your disc and
track names again. The
CDDB (Compact Disc Data

Base) is a free database that
stores the disc and track
names for thousands of
audio CDs. Using the soft-
ware listed below, users can
log onto the CDDB and
download the track infor-
mation. The CDDB most
likely has your audio CD.
Several utilities across all
platforms, from rippers to
burners, to ID3 tag editors
utilise CDDB.

Broken Cross
This is a fast and easy-to-
use disk-cataloguing tool.
Its interface is based on
Windows Explorer. Disks
can be updated easily and
it can read and catalogue
contents of CAB, RAR and
ZIP archives. Descriptions
for the MP3 files can be
generated from ID3 tags. It
is also good for managing

audio CD collections.
Audio CD information can
be queried over the Inter-
net from CDDB. This infor-
mation can then be used to
generate descriptions for
the CD and audio tracks.
The program is multi-user
capable and has several
other useful functions.

Tag&Rename 
Tag&Rename is a power-
ful, easy-to-use program
for organising and archiv-
ing your library of music

files, from MP3 to .vqf
music formats. With
Tag&Rename, you can
quickly and easily rename
your music while also
editing the embedded tag
data used by popular
music players—both ID3
and ID3 v2 formats. It
simplifies the boring and
time-consuming task of
updating tag information
for your music by allowing
you to quickly access
information from the
CDDB1 database.

ORGANISING YOUR MUSIC
Imagine trying to keep your MP3s organised without
having the names of your songs, artists, or track
information. But thanks to tools such as ID3 tags,
CDDB and others, it's easy to organise all those
numbers

Broken cross is effective not only for MP3s but also for CD audio 

Tag&Rename offers CDDB support
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Listen.com
With over 1,30,000 record-
ing artists under its listings,
this is the big momma when
it comes to free music. But
here’s the deal. Listen.com
does not host the files;
instead it points you to
other labels where you can
find them. Five major record
labels have invested in 
listen.com, and it's all 
legitimate. 

Epitonic.com
This is a site started by some
obscure and independent
labels, which is probably
why they use the words
‘underground’ and ‘cutting
edge’ to describe their
music. From electronica, to
punk, indie and experimen-
tal music, you’ll find it here.
An interesting feature of the
site is that it carries in-depth
reviews by the editors along
with picks of the week and
descriptions of songs. The

blackbox feature on the site
lets you store an unlimited
amount of songs on 
epitonic.

Technomusic.com
This online record label 
has a plethora of free techno
MP3s broken down into
nine different sub genres.
You can download or 
preview all songs on the site
or listen to its streaming
radio.

MP3.com
While the site is known as a
vehicle for unknown artists,
quite a few big names too
can be found here. Anyone
can upload MP3s to
MP3.com, so you’ll find a
wide variety of artists from
the also-rans to the famous
ones.

Audiogalaxy.com
This site calls itself a ‘com-
munity of fans and artists’.

1.
■ Always follow a standard
naming convention for your
MP3 files and folders; for indi-
vidual songs use ‘Track num-
ber_Artist_Songname.mp3’
and for albums use
‘Artist_Album’ as the folder
name. Widely used and
accepted, this convention
makes your collection easier
to browse through.
■ Put ID3V2 Tags on your
newly ripped MP3 files from
CDDB entries, or do it manu-
ally. This helps automated
sorting of music, and is espe-
cially helpful when you need
to browse loads of MP3s on a
portable MP3 player or
rename them using a new
convention.
■ Delete wrong ID3 Tags from
files and replace them with
the right tag information
using a tool. Using a tool such

as ID3Killer, you can mass-
remove incorrect ID3 tags
from Internet downloaded
music and rename it to proper
tags manually, or using tools
such as Tag&Rename.
■ 192 K or similar bandwidth
variable bitrate files have
pretty much become a stan-
dard for ripping from an
audio CD. This bitrate pre-
serves most of the audio, and
doesn’t hog too much disk
space either. 
■ While archiving MP3s to a
CD-R, make sure you keep a
database of all the MP3s you
archived in a tool such as Bro-
ken Cross or MP3 Database.
It helps keep duplicate down-
loads to a minimum, and
makes searching for a certain
archived song easy, as the
tool will tell you which CD
you wrote it to.

FREE: WHERE? DOWNLOADING
FREE MUSIC

You don’t have to live with the guilt of stolen music
anymore. Musicians all over the world are using
MP3 as a promotional medium 

A perfectionist’s list of MP3 rules

After the RIAA interven-
tion, Audiogalaxy has
cleaned its act and now
hosts only legal music.
With a ‘sounds like’ feature
and introduction to vari-
ous new genres, this site
lets you find some real
gems. 

RollingStone.com 
A true ‘brand name’ in 
the music business, the
site offers free downloads
of selected tracks from 
top artists. Registration 
is required, but it’s free.

Amazon.com Digital
Music Downloads
Best known as ‘Earth’s
Biggest Bookstore’, Amazon
now offers free MP3s from
hundreds of well-known
artists, including rare and
previously unreleased
tracks. Independent artists
may offer music for down-
load and set up virtual 
tip jars.
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blackbox feature on the site
lets you store an unlimited
amount of songs on 
epitonic.

Technomusic.com
This online record label 
has a plethora of free techno
MP3s broken down into nine
different sub genres. You can
download or 
preview all songs on the site
or listen to its streaming
radio.

MP3.com
While the site is known as a
vehicle for unknown artists,
quite a few big names too can
be found here. Anyone can
upload MP3s to MP3.com, so
you’ll find a wide variety of
artists from the also-rans to
the famous ones.

Audiogalaxy.com
This site calls itself a ‘com-
munity of fans and artists’. 
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From Space Invaders to Tetris to Quake III and beyond. Tracing the birth and growth of that 
mind-changing substance—games 

F
rom Space Commanders and
Pong of yesteryear to the
photo realistic graphic accel-
erated games of today. From a
handful of 2D sprites to mil-

lions of textured polygons. From simple
straightforward script driven enemies to
‘bots’ that learn and adapt to your behav-
iour. From single player adventures to
elaborate online game worlds with the
interactivity and complexity of a small
country. The quantum leaps in concepts,
creativity and technology in the gaming
subculture are staggering. But as the say-
ing goes, Rome wasn’t built in a day.
There’s another saying that goes “One
does not sell the land people walk on”
which however has nothing to do with
this article. Anyway, for those who missed
the bus, here’s a history class on gaming,
attendance is not compulsory. No grades
or tests or term papers.  

Back when digital watches were still
‘droolmaal’ and computers were the size
of a blue whale, an MIT nerd called Steve
‘Slug’ Russell decided to create the ulti-
mate hack, an interactive game. After 200
hours of coding he created one in 1961—
two rocket ships that fired torpedoes at
each other. He called it Spacewar. Soon

everybody wanted one just like it. To fire
imaginary rockets at imaginary spaceships
was indeed tapping into a raw, powerful
instinct deep inside. Every homo sapien
who saw it salivated at the prospect of fir-
ing rockets in the comfort of their own
home. Enter the era of the game console. 

1972: The Game Odyssey
The Magnavox Odyssey, designed by a
military electronics firm was introduced
at a price of $100. With only 40 transistors
and 40 diodes, the console was so primi-
tive that players had to jot down the score
on a notepad. You had to place a screen
overlay on the TV screen as part of the
graphics. Those were indeed trying times
to live in. Soon Atari stepped in and took
this concept further, introducing the Pong
arcade machine. The gameplay was sim-
ple. Two players controlled a vertical bar
each that could bounce a dot between
them. Pong became an instant success and
it created the arcade video game industry. 

Space Invaders was the first blockbuster
videogame. It brought video games into
arcades, bars, restaurants and corner stores
and to the public. It was translated to the
Atari 2600 video game system. The home
version too turned into a huge commercial

hit. Atari was the forerunner of consoles
back then, with its cutting-edge 2,600-
games system. Drool over the specs of this
monster: 8-bit CPU at 1.19 MHz, 16-colour
graphics, two-channel audio (noise and
sound), 128 bytes of RAM. This was the era
of games such as Pac-Man, Centipede, 
Asteroids, Space Invaders, and Tempest.

The dawn of PC gaming
During the early 1980s, a promising per-
sonal computing revolution made it pos-
sible to play a different variety of games.
Text-based adventures such as Zork, Hitch-
hiker’s Guide to the Galaxy, and Wishbringer
took gaming to a different level altogeth-
er. By 1985, Infocom’s Zork sold more than
1,00,000 copies. Gaming had arrived, and
with it companies such as Electronic Arts
and Sierra established themselves. 

Games diversified into different gen-
res. Role Playing Games (RPGs) that were
played with dice were ported to the PC,
adventure games told their stories with
graphics, and 2D games made tentative
attempts at simulation. Civilisation and
XCOM established themselves as forerun-
ners of the strategy genre. MUDs, or multi-
user dungeons, became popular in
universities and wherever terminals were

INFOGRAPHIC: Solomon Lewis
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networked. Online designers began to
create truly interactive persistent worlds
for folks to inhabit and adventure in. By
the late 1980s names such as Ultima,
Civilisation and the Quest series estab-
lished themselves as gaming franchises
with massive fan bases. 

Rising sun
Meanwhile, the console world saw the
entry of Japanese manufacturers. The
Nintendo Entertainment System (NES)
with its 8-bit CPU dominated the console
market with an irresistible array of
games—Zelda, the Megaman Series, Tetris,
and of course, Mario. NES is credited with
being the most successful game system
yet, its closest competitors being the Atari
2600 and the Nintendo Gameboy. By the
1980s, games featured 2D sprite graphics,
MIDI level sound and multiplayer capa-
bilities. Computer games were no longer
meant only for geeks. Gamers had
become respectable. Almost. 

In the 1990s the first 16-bit console
from Sega made dents in Nintendo’s
world domination, with the Sega 
Genesis. Sonic the Hedgehog, was Sega’s
answer to Mario. Mortal Kombat, a fight-
ing game created a huge controversy
because of the blood and gore it depict-
ed, resulting in the industry appointing
its own rating system. Consoles would
go from 16 to 32-bit, CDs would replace

cartridges, and more powerful processors
would bring better graphics, sound, and
multiplayer capabilities. 

Achtung! 
The 1990s also saw the fading away of
adventure and turn-based strategy
games. Games that were too slow and
required too much planning or thought
didn’t go down too well with lowered
attention spans and twitch addicts. In
1991, a 3D action game from id software
called Wolfenstein was released as a share-
ware. Wolfenstein was about hitting out
at the Nazis; the action was frenetic, vio-
lent, and fun. The retail version sold over
2,50,000 copies. It kick started the FPS
(First Person Shooter) genre, following it
with 3D action games that have now
turned into an industry of their own.
With Doom, Doom II, Quake, Quake II,
and Quake III, id single-handedly pushed
the envelope in graphics and multiplay-
er, coining terms such as ‘deathmatch’
and ‘fragging’. 

Two other games would spawn
another subgenre that flourishes to this
day—Real Time Strategy (RTS). West-
wood’s Command and Conquer series and
Will Wright’s Simcity took
RTS to new heights, and

spawned dozens of imitators. Blizzard
revitalised the dying RPG genre with
Diablo, a hack and slash action-RPG
hybrid.

It’s a party—everyone’s invited 
In 1993, Doom made multiplayer gaming
possible, and thanks to a service called
Kali, it turned the Internet into one big
LAN party. Doom laid the groundwork for
all that was to follow in multiplayer gam-
ing. With the advent of the Internet, mul-
tiplayer and team play elements
flourished in PC games, and the evolu-
tionary path of most games has been
steadily heading toward that direction in
almost all genres. Almost all games today
offer some sort of online or multiplayer
feature. Multiplayer games increase the
‘replayability’ of a game because no two
experiences can be the same. The inter-
action with humans brings in certain
dynamics that a computer cannot offer,
and probably never will. 

The popularity of Counter-Strike
speaks for itself. RPG games went back
to their MUD roots with Massively Mul-
tiplayer Online Role Playing Games
(MMORPGs). These are persistent virtu-

al universes, where play-
ers can interact freely
with other players,
partner up, and live a
fictional life. Ultima

IMAGING: Ashwin Boricha



Online, Everquest and Asheron’s Call are
some of the most popular names in the
business. Everquest boasts of over 300,000
players.

Speed demons
As newer games demanded more realistic
3D environments, the drain on comput-
ing resources made it difficult for game
programmers to devote resources to the
gameplay itself. Even with monumental
advances in computing power as offered
by processors, game development was
slowed by the inability of computers to
keep up with the demands of 3D graphics.
To address this demand, 3DFX released its

new Voodoo Graphics chipset in late
1996. 3DFX revolutionised the industry by
outclassing available Pentium processors
and other dedicated 3D products in 3D
performance. Its proprietary Glide API was
successful during a short period between
1997-98. It wasn’t until Microsoft devel-
oped a 3D command language called
Direct3D that the 3DFX/Glide domination
began to crack. nVidia was one of the first
companies to jump on the Direct3D band-
wagon, and its GeForce range of cards rule
the roost today.

As desktop computing power has
exploded, so have the graphics capabili-
ties of the PC. During the unveiling of the

GeForce 3, Steve Jobs talked about the
time when they had to pre-render Toy
Story on a Cray Supercomputer. It took
them 1,000 hours to get 1,000 frames of
decent animation. Now with the
GeForce3, they can render the same scene
at 60 frames per second.

The early games were addictive fun—
fun in its most basic form. Today we have
games with genres and subgenres, each
with its own culture and clique that is
being defined and refined all the time. The
graphics and the sound will keep advanc-
ing to a point where it’s as good as the real
thing. But graphics maketh not a game. If
you take away all the fancy graphics,
sound, story, character development, puz-
zles and dialogue, then every game out
there is just
Pong. All said
and done, a death-
match is similar to Pac-
Man in 3D, and RPG
games are just imagina-
tive storytelling. 

SRIRAM SHARMA
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Pitfall — Atari 2600
You’re Pitfall Harry, the world famous jungle
explorer and fortune hunter extraordinaire.
Pitfall started the sidescrolling version of
adventure gameplay that was used in many
2D games. (1982)

Pac-Man — Atari
One of the most famous games from the
Atari generation, it’s Pac-Man’s story of
survival in a maze, amidst ghosts,dots and
power pills.                          (1983)

Yie Ar Kung Fu — Spectrum 
The first fighting game. Fighting games
owe it to this one for inspiring a successful
genre on the console.                 (1985)

Contra — NES
What would the NES be without 

Contra? You play as the Rambo-esque
character shooting bizarre enemies, col-
lect weapons with platform elements
such as jumping puzzles, moving plat-
forms, and of course, the mandatory
end-level boss.                           (1986)

Super Mario — NES
Mario (and Luigi) run and jump through
eight different worlds, eating mushrooms in
a contrived adventure to save the Princess.
With secret levels, power ups, and warp
zones, Mario was one of the most fun 
games ever. (1986)

F-19 Stealth Fighter— PC
This was Mircroprose’s Doom of flight sim-
ulators. F-19 found the perfect balance
between complexity and fun, attracting
both purists and newbies. (1988)

Prince of Persia — PC 
Rescue your beloved princess from the evil
clutches of Grand Vizier Jaffar. You travel
through dungeons and the castle to find
her within an hour, swordfighting along
the way.                                         (1989)

Atari 2000 Robotron — Atari 
Move and fire in eight directions to repel
the swarm of robots attempting to destroy
you and save your human family in the
process. (1983)

Dune 2— PC
Dune 2 is the grand daddy of all RTS (Real-
time Strategy) games on the PC. Based on
the Dune 2 novels by Frank Herbert, it’s
one of the most action-packed and addic-
tive games of all time.                     (1992)

Video Game Emulators are programs that
allow you to run video games on your PC.
Emulators are legal as long as they don’t
contain copyrighted material. ROMs on
the other hand are a different ball game. In
the case of discontinued systems, classic
gaming enthusiasts release the ROM
images since the company is not making
any money out of it, anyway. In a situation
where buying the game is out of the ques-
tion, it seems ethical to ‘warez’ these
games. Classic gamers refer to such files as
abandonware. But not all ROM images are
copyrighted. Some companies release their

games to the public domain or for not-for-
profit distribution. An example of this is
ROMs for the Vectrex. These are perfectly
legal, so long as they’re not distributed for
profit. Another interesting development is
the concept of New Classics, a term used
to describe new games written for old sys-
tems. People are still writing games for the
ColecoVision, the Atari 2600, Gameboy
and other systems. Programmers write the
game and release it as a ROM image. They
don’t need to make a cartridge, since emu-
lators can run their game. It’s all for fun,
and nobody is complaining. 

Ethical Warez

10 Classic Gam es
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MRP: Rs 299 ·Min Requirements: Pentium 166 MHz, 32 MB of RAM, 200 MB of hard disk space, 4x CD-ROM, Windows 95 or above. 

Car Cheat: To get a car that fires bullets
during a game, hit [Enter] and type HOW
DO I TURN THIS ON. The car should appear
by your first Town Center. It gives you a
cobra car, which has 500 hit points, 10
attack, 10 armour, and 10 range.

Reveal Map: To reveal the map, but not
remove the fog of war, hit [Enter] and
type MARCO. Typing POLO removes the
fog of war; you can see the territory you
have explored but not any activity on it
originating out of your units or build-
ings’ line of sight.

Activate Cheats

CCoouunntteerr  AAttttaacckk
Every civilisation in the Age of Kings
has a unique unit that you may have
no answer for. For example, if a
Japanese opponent is messing your
happiness with his samurais, a
brigade of archers can bring them
down easily. Britons have great arch-
ing units with better ranges, but have
weak paladins. Vikings are better war-
riors on water, with cheap docks and
war ships. It’s important to know your
weakness and build your support
structure around it. The trick is 
finding the chink in your opponent’s
armour and then exploiting it. 

arcade ■
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If a successful con-
quest is what pumps
you up, aim your
arrows straight at
these hot tips

In Age of Empires II: Age of Kings, you take control of one of 13
civilisations that include the Chinese, the Goths, the Britons,
and the Vikings among others. You start off with a handful of
villagers and expand and manage your economy to a point

where you can build a powerful war machine. The strategy, speed,
and tactics needed to win make it quite similar to speed chess. Age
of Empires has a huge fan base and was a tourney favourite at the
World Cybergames held in December 2001 in Korea.

SRIRAM SHARMA

The old adage that time waits for no man
holds especially true in the Age of Kings. In
this game, the faster you build up your civil-
isation, the more military units you can
crank out, and, conversely, the more tech-
nology you can research. Hotkeys here is the
name of the game—assign the [Ctrl] button
and a number to a unit. It helps you plan
and command an organised attack. Building
can also be faster if you use the keyboard
and the mouse simultaneously. 

Build a house Click a villager, then press 
[B] and the [E] 

Build a farm Click a villager, then press 
[B] and then [F] 

Build a tower Click a villager, then press 
[B] and then [T]

Build a building Click a villager, then press 
[B] + Hotkey for the
building

Build military Click a villager, then press
building [V] + Hotkey for the 

military building    

GE OFKING

Defence Tips
An early blow in the feudal stages of the game can put you in a position where you are
unable to recover. Here are a few simple tips. If you don’t have enough money to make
walls, use trees for protection. Keep scouts busy from the early stages of the game—they
keep an eye on the resources, the enemy on the map, spots to take advantage of, and the
wall. Housing that is spread out and wide will take a longer time to come under attack.
Housing spread far out also lets you expand your territory, setting up the infrastructure
when you advance to the later
stages. Housing can also act like
radars, keeping the fog of war at
bay. Don’t go around building
clumps of houses and buildings just
because they look pretty. Spread out
your buildings and decentralise your
base. Your enemy will end up attack-
ing low priority buildings that can
act as subterfuge.

GE OFKING

Speed Tips



It’s time to squash this lemon
in the junkyard. If you’ve

seen The Fast and the Furious or
Gone in 60 Seconds, it’s easy to
make a parallel between super-
cars and souped up PCs. Both
embody the best in technolo-
gy and are over-
clocked by enthusi-
asts to deliver the
best performance.
Exakt Entertain-
ment’s Supercar
Street Challenge
makes a desperate
attempt at tapping
into some of that,
letting you take
to the wheel of
some of the best cars and
even redesign them. 

But in plain racing terms,
this game is a flat tire. It allows
you to shape the car any way
you want, but that’s all it does.
The changes you can make to
the car are cosmetic; there is
no relation to speed, braking,
acceleration and handling.
Controls are largely arcade-
oriented, which is fine, but the
lame physics make it hard to

appreciate it. You keep plow-
ing through lampposts, trees,
statues and an assortment of
other obstacles. Since there is
no damage system, here’s a
simple strategy—the best way
to win is to bounce off walls
and keep the pedal on the

metal all the while. The
menu system seems like it was
ported straight from the con-
sole, and is unintuitive and
laborious. The lack of any
obstacles undermines the
sense of speed you have—
there is no fear of being slowed
down at all. 

Supercar lets you race
through several major cities,
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multiplayer modes, chance
cards, dynamic AI and differ-
ent gameplay scenarios, this
game keeps giving. 

Strategy/simulation man-
agement games might not be
everyone’s cup of tea, but with
interactive city dwellers, mul-
tiplayer capabilities, Internet

play and gorgeous 3D graph-
ics, it’s time you gave it a look. 
Developer: Deep Red
Genre: Strategy/Simulation
Contact: Milestone Interactive,
022-8381614
Web site:www.monopolyty-
coon.com
Rating: ★★★★✩

The most popular strategy
games today trace their

roots back to boardgames.
Dungeons and Dragons (D&D)
and Advanced D&D used to be
played with huge rulebooks
and dice. Over time several of
these boardgames got ported
to the PC with great success.
Deep Red and Hasbro didn’t
take long to figure out 
that Monopoly was another

boardgame  begging to be
ported to the PC.

Playing a boardgame on 
a PC introduces you to 
dynamics that you will not
find in a regular boardgame.
Monopoly Tycoon is a 3D real-
time management multiplay-
er game that simulates a city,
right down to its individual
citizens. You start off as an
entrepreneur in a city back in
the 1930s and grow with it.
The only driving motive here
is the American dream: grow
rich and powerful. 

The game is not only
about money circulation, but
also about being competitive
enough to outdo your oppo-
nents by building properties
and businesses that are 

relevant to the people at the
time. The best businesses in
the 1950s might be sports and
music stores, but as time goes
by, it might be a better idea to
tear them down to start a
computer store. 

Winning requires being
elected as a mayor, reaching a
certain sales target, profit mar-
gin, or empire value. There’s

also a survivor-style
elimination mode
where the true spir-
it of Monopoly—
bankrupting your
opponent comes
into play. 

The 3D
graphics are
colourful and
smooth. You
can zoom in

and out on buildings and
streetlights come on at night,
casting shadows in areas the
light doesn’t hit. Individuals
and cars change appearance as
time progresses. The music is
snazzy and changes with the
decades. 

It takes about an hour to
learn the ropes. After that, this
game has you in its grip.

The strategic and tactical
possibilities in here are greater
than in SimCity or Railroad
Tycoon, and the options open
to you are many. The con-
struct is so huge that there is
no single way to become rich
and dominant. That’s the
beauty of Monopoly Tycoon.  

If you played the board-
game in your childhood, do
give this PC version a look.
With single player and 

Does your gaming collection seem outdated? Or do you need an addition to your bookshelf? 
Get a glimpse at the latest in these categories right here

Hits n’ misses
MONOPOLY TYCOON

This means business

SUPERCAR STREET CHALLENGE

The Fast and the Futile



including Los Angeles, Lon-
don, and Monaco. But all look
extremely bland with no hint
of life anywhere. Even on a
GeForce2 with a 900 MHz
Duron, the frame rate stut-
tered and popped at the lowest
resolutions. The cars are over-
reflective and the textures flat
and lifeless. The graphics
engine is four years too old. 

The game’s great in 
concept, but not in 
implementation. Bad con-
trols, poor graphics, pedestri-
an sound effects, no multi-
player, a console of a menu
system and unchallenging
gameplay. Almost every rac-
ing game ends with some
techno or trance music and
this one is no different. If you

like trance, Supercar has one
of the best soundtracks
around. It features Captain
Tinrib, DJ Micro and Keoki
along with a host of other
performers from Moonshine
Records.

Simply put, this game
fares poorly and cannot hold
a candle to the likes of Need for
Speed, Colin Mc Rae, or 4x4 

Evolution. Even the extra effort
on packaging—the snazzy
DVD case, free demo CD, and
a poster fail to impress against
this onslaught of awfulness. 
Developer: Exakt Entertainment
Genre: Racing
Contact: Milestone Interactive
Phone: 022-8381614
Price: Rs 699
Rating: ★★

Visual Basic has been the
most popular Rapid

Application Development
(RAD) tool ever. Now that
.NET is coming up as a serv-
ices platform,
Visual Basic for
.NET is so hot
that you defi-
nitely need to get
your basics right.
This book gives
you a refresher
course on what
.NET is all about
and how you can
use Visual Basic.NET
to develop applications for the
platform. You will get a sneak
preview of the changes that
have been implemented into
the language core. Explana-
tions on accessibility to data-
bases using the ADO.NET are
so lucid that even a novice
should find it easy. For those
of you unfamiliar with XML

or SOAP, this book gives com-
prehensive explanations on
working with the same. In all
this is a project management

book. It helps you
learn, plan, devel-
op, and deploy
.NET applications
in a jiffy. 

The flipside,
however, is that
you should
already be a soft-
ware architect,
or at least an
expert at Visual

Basic to understand the real
essence of developing applica-
tions for this platform.
Publisher: IDG Books India Pvt
Ltd
Contact: IDG Books India Pvt
Ltd
Phone: 91-011-3275895
E-mail: idgbooks@vsnl.com
Price: Rs 249
Rating: ★★★

A RAD book, this!
Web services such as setting up
an Apache server, running an
FTP server, building new ker-
nels, and maintaining system
security.

Although it doesn’t claim
to be a ‘bible’, it’s a pretty
good book to start out with.
To put things in a nutshell,
this book can help you skim
the surface of working with
Linux and you will learn the

ropes to some extent, but
‘mastering’ Linux would take
you a lot more study and
effort.
Publisher: IDG Books India Pvt
Ltd
Contact: IDG Books India Pvt
Ltd
Phone: 91-011-3275895
E-mail: idgbooks@vsnl.com
Price: Rs 169
Rating: ★★★ 

Windows XP is the best
operating system from

Microsoft yet and everyone
wants to use it. If you share
the sentiment but are the
kind who does-
n’t take too
kindly to figur-
ing out the vari-
ous features of
your OS on your
own, then you
can turn to this
book for the sim-
plest of guidance. Another
reason is that you won’t have
to browse through pages of
dense text. You will find just
the required amount of infor-
mation. You can learn to fix
all your XP related problems
using the concise instructions
in this book. The book is
packed with images and illus-
trations that help you further
your understanding of Win-
dows XP. Starting with a men-
tion of the new features of the
OS, to its networking and
other interesting capabilities,

the book deals with the essen-
tials of XP in an interesting
manner. For those of you
working for the first time

with networks,
setting up net-
work connec-
tions with Win-
dows XP will be
quite difficult.
But with the
guidance and

examples offered here,
you too can cure your net-
working hangups in Windows
XP. A must have for every
Windows XP home user, this
book is like a product manual
that you can refer to when
you have a problem with your
new fancy OS.
Publisher: Prentice Hall of India
Pvt Ltd
Contact: Computer BookShop
Phone: 022-2070989,
2076356
E-mail:cbsbom@giasbm01.
vsnl.net.in
Price: Rs 225
Rating: ★★★★

WINDOWS XP PLAIN AND SIMPLE

Quick and easy

Learning Red Hat Linux 7.x
in two-and-a-half days is

quite a feat for anyone to
achieve.
W h i l e
the goal
of this
book may
seem a lit-
tle too far
fetched, the
book is still

pretty well written and good
enough to help a novice reach

the intermediate level. 
The book opens with a

guide to the very initial steps
such as installing the software,
as well as troubleshooting the
installation if you happen to
face any glitches at the very
onset. Next on the menu is
exploring various tasks such as
using the shell, bash com-
mands, networking, Internet,
etc. It also deals with complex
topics such as setting up Inter-
net services such as e-mail and

Learn the ropes, yet to walk it
RED HAT LINUX 7.X IN 2 1/2 DAYS

DESIGNING VISUAL BASIC .NET APPLICATIONS
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Virus alert!

E-mail someone you know every hour, on the

hour, sending them a warning about the deadly

virus that’s hit town.

Play switch!
If you’re in an office with computers really close to eachother, you are in luck. Pick a person whose computer is next
to yours or back to back. Make sure they have really longcables. Before the person who works across from you gets tohis station, unplug his keyboard, plug yours into his com-
puter and open a word processor on his terminal. When theperson gets back to work on his PC, start typing and be pre-
pared to double in laughter. You can also do this with miceand monitors.

Sound start Record your friend saying something stupid with a whole
lot of sound effects. Then sneak up to their computer and
pop it in as their Windows startup. Warning: your friend
will probably have a lot to say to you afterwards ‘offline’.

Printer daemon

Write a daemon that sends each individual page

of a print job to a different printer on the net-

work. Select the printer at random.

Where have all the icons gone?Try to take control of a computer, go to ControlPanel > Display and change everything to black.Have fun watching the PC user trying to find allthose icons.

A mousy trip
Tape the trackball to the insides ofthe mouse and watch with a straightface as your friend tries to hunt themouse.

Smooth operator

From the Control Panel, change the double-

clicking speed of the mouse to the fastest it can

be. To add to this, switch the settings for the

mouse buttons from right-handed user to left-

handed user or the other way around.

Keyboard capersPick one key that is used most often, for example ‘E’ or ‘I’,
take the spring out from under that key. Or how about
switching the ‘M’ and ‘N’ keys? You can get away with this
unnoticed for sometime. Works best when the person has apassword containing the letters ‘M’ or ‘N’. If that doesn’t
sound daring enough, how about changing your victim’s
keyboard setting to a different layout. (Mind you, keep your
Windows install disks handy in case anything goes wrong.)

Gnashing your teeth at that Smart Aleck who always seems to get
the better of you? Get the upper hand with these computer pranks

Spring me a floppy! 

Rig the spring in a floppy drive to fire the

disk a good distance from the machine

upon ejection.

Frozen desktop

Temporarily ‘freeze’ your friend’s desktop by doing a

‘Print Screen’ of their work area and saving it as their

wallpaper. The next step is to minimise the taskbar and

hide their desktop icons. They’ll never know what hit

them as they try desperately to click on the ‘frozen’

icons. 

FEBRUARY 2002
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www.4guysfromrolla.com
If you’re an ASP program-
mer, you must read up the
excellent articles on this site
regularly.
www.phpbuilder.com
PHP giving you a hard time
lately? Get online and find
solutions on this site’s sup-
port forums. The site also
has great articles, a code
library and PHP manuals.
www.jguru.com
Here you will find links
pointing to the best
resources on Java. 
www.otn.oracle.com
An excellent resource for
Oracle developers.
www.asktom.oracle.com
Tom’s the handy man for all
the help you need with
Oracle. 
www.webmonkey.com
A great place for those who
want to learn the basics of
anything to do with the
Web. 

Log on to www.indianrail-
ways.com and in a matter of
minutes look up the book-
ing status on each train.
You can also check your
reservation status in sec-
onds. However, to make
reservations you’ll still have
to stand in queue.
Time taken: A few minutes
to look up train options

Ronnie Sengupta, the
technology whiz
behind ZDnetIndia.
com is passionate
about two things—
music and technology.
Check out these ‘must
surf’ sites picked by
Ronnie if your passion
for programming
matches his.
“Programming today
isn’t what it used to be a
decade back. There are
so many technology
choices for a program-
mer—if not for the
Internet it would be
impossible to keep up”.

TECHWAY

Pin Drop Violence

7 per cent of the

online population in

the US has a PC at

home but chooses

not to have Internet

access at home.

Over 3 million home

Internet users in the

UK visited games

sites during 

November 2001, up

almost by half a 

million since last

November.
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Haul yourself to the rail-
way station, crane your
neck and jostle with
crowds to look up train
numbers and timings.
Fill out a reservation
form and brave the long
queues to get your 
ticket.
Time taken: The better
part of a whole day

Booking a railway ticket yourself
OLD WAY

India’s first hardcore/nu metal
metalcore band, PDV have won three
competitions in a row, including
Independence Rock 2001. The
campus band that is ripping
audiences into frenzied mosh pits
gives us the dope on their top five
sites.

www.audiogalaxy.com
This is where we head to for all our music.
It rocks!

www.metalhammer.co.uk
Here’s where you can get all the low-down
on international bands.

www.fatwreckrecords.com
Get all the information on the best
underground punk rock bands. And for
those of you into skateboarding, this is the
site.
hhttttpp::////ppddvv..vvrr99..ccoomm
It’s our band site, and we love it!

Pradeep (vocals), Mithun ‘Pervert’ (guitars), Vispy ‘V.A.S.P’ (guitars), Rohit ‘pereira-man’ (bass),
Neeraj ‘UFO-bait’ (drums)

www.gigpad.com
For all the information on the Indian rock
scene...when’s the next gig happening,
reviews on gigs, information on
competitions, album releases, who said
what, and a whole lot more.

Team’s Top Picks



The Netaji Indoor Stadium in Kolkata was the
hub for global hardware and software vendors,
when the seventh information technology
show of computer association of eastern region

was kicked off from the 11th to the 14th of January. The
theme for the exhibition was ‘Emergence of the Digital
East’

This was the biggest IT show in the region, and in
particular, a tribute to the growing significance of the IT
industry in West Bengal. 150 participants,
including 80 from

Eastern India representing all segments of the IT indus-
try participated in the exhibition to display the latest
range of products and services from all parts of the
world. The event, which was organised by Compass was
sponsored by Seagate and co-sponsored by VIA. Global
hardware majors such as LG, Kobian, D-link, Epson and
Samsung directly participated in the exhibition. 

COMPASS 2002 Chairman, Mr. V K Bhandari,
emphasised the growing importance of channels that
form the nerve centre of sales activities in the
Information Technology business world wide. Despite
the rapid spread of the Internet, channel sales continue
to evolve, expand and mature under difficult market
conditions. 

Arun Kumar Jalan said in his address: "The IT indus-
try has tremendous potential for growth and employ-

ment generation in the eastern region and we are very
pleased with the initiatives taken by the government of
the west Bengal in this area. Compass is committed to
harness and unleash this potential and contribute in a
very positive manner toward the development and
growth of employment and investment in this region." 

Outstation dealers meets at Bhubaneswar, Ranchi,
Jamshedpur and Guawahati were conducted by the sen-
ior members of COMPASS prior to the exhibition.
The OEM Resellers Meet was attended by hundreds of
dealers, OEMs, COMPASS members. With interactive
sessions and panel discussions, many others partici-
pated in the presentations made by the OEMs and
Principles.

COMPASS conducted a survey amongst its members
to assess the performance of OEMs and vendors. An

OEM Reseller Meet was also conducted to make the
channel aware about the technology road map of vari-
ous manufacturers. At the same time, it gave manufac-
turers principles to appreciate the channels point of
view. 

The event ended with the award distribution cere-
mony at the Grand Hotel on 13th January 2002. 

For more details, log on to www.compassindia.com

From left to right: Pawan Jajodia, V.K. Bhandari, Manabendra
Mukherjee, Ben Boyden, Arun KR Jalan.

IT Minister of West Bengal, Manabendra Mukherjee with an
opening address to the gathering at Compass 2002. 

■■ advertorial

C  MPASS 2002
The Emergence of the Digital East

The 
East India
IT Show
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Fun in the sun! We at JDM got a chance to stretch our cramped muscles with 
some cricket. So here are the scores

We came, We saw, 
We got bowled over!
Just cricket! The fag end of 2001 saw

more cricket fever than New Year
preparations in Digit. It was the time
for the ‘JDM Super Sixes’, our annu-

al in-house cricket tournament. All work
was ditched in favour of a day in the sun.

Held on December 28, it was a closely
fought battle between the various teams
that make up Digit and our sister publi-
cations. No guts, no glory, was the motto
as it was purely on a knock-out basis at
Vashi’s cricket ground. 

Seeing that everybody wanted to play,
and there was just one day to do it, spe-
cial rules were drafted. Each team had six
players and got five overs in which they
had to score the maximum. If a wicket
was lost, 5 runs were deducted from that
team’s score. Each team had to field for
the other teams as well even if they
weren’t playing. 

Our hard core techies who wouldn’t
even bat an eye lid when running all
those hard core benchmarks and tests
were at home in the field too. Especially

when facing all those bouncers and
googlies. While not exactly dressed in
cricket whites, they earned their own
place under the cricketing sun. 

The Digit team was headed by Shyam
Shirsekar, our Visualiser, who swears by
Sachin Tendulkar. The team was firing on
all cylinders and managed to make 26
runs. All of that went for a toss as 5 wick-
ets were lost, putting the team in a bad
position. But then, it’s a game afterall and
everyone played their best. 

The day had its own share of injuries
as the heat took its toll on the players. No
ambulances were called though! Adarsh
Kaul from the events team has reported-
ly been selected to the Indian team based
on the ‘leg cramps’, which mysteriously
vanished as soon as the tournament was
over. Special kudos to Shyam, who did the
fielding for other teams till the end of the
day even though his team didn’t make it
past the first round. Sportsman spirit at
it’s very best. 

However, the spotlight of the day was
the final. A fierce battle took place
between the people who give Digit its
cool look and those who provide our
technological backbone—the team of
Design & Media studio versus the Infor-
mation Technology and Finance team.
After much blood and gore, the IT and
Finance team headed by Prakash Fallor
won the tournament with a score of 60
plus. Sachin, our hardware engineer was
the man of the match. They proved they
were as good at scoring runs as they were
at maintaining our bandwidth and net-
work. Three cheers for the winners!

136

The bat is stronger
than the sword
too—if it connects!

A tree-top view of all the gripping action!
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Wild Wild Web
After many hours in front of a
computer monitor, we get bored
with the standard sites. Some-
times we end up at sites like
these while searching the vast
recesses of the Web. 
www.geocities.com/warrior-
sofdestruction: These guys look
pretty tough and their Web page
design is second to none. A
Quake II clan that knows how to
make lots of money. And they
want to share it with you. Ani-
mated gifs, MIDI music, and bad
design, this site has it all. 
Contributed by Andre

Highlight the lighter side of 
computing. Mail your contri-
butions to  Backbyte
Digit, Plot D-222/2, 
TTC Industrial Area, MIDC, 
Shirvane, Nerul, 
Navi Mumbai 400 706
or send e-mail to
backbyte@jasubhai.com

Your chance to
bite back!

A serious look at some com-
puter commands, the Pun-
jabi way!
Send: Sutto
Insert: Wich Paao
Attachment: Naal Laao 
Edit: Sidda Karo
View: Waikhee Jaao
Forward: Aggay Sutto
Inbox: Undar Da Daak
Khaana
Outbox: Baar Da Daak
Khana
Trash: Mitti Paao
Address Book: Patay Wali
Kaapy
Reply: Bejan Walay Nu
Jawab do
Reply All: Saareyaan Nu
Jawab do 
Delete: Daffa Karo
Download: Thallay Laao
Properties: Jaidaad
Connect: Naal Milaao 
Fonts: Likhaai
Accounts: Galla
Drafts: Chitheeyaan
Find: Labbo
Paste: Thook Naal Chipkaao
From: Bhejan Walaa Banda
Subject: Khaas Gall
Stationery: Pensal, Rubburd
Folders: Thailay
High Priority: Waddee Tak-
leef 
Ctrl+Alt+Delete: Sara Syapa
Mukao
Contributed by Manmohan
Dev Sharma

Punjabi
Commands

But the fact remains that Microsoft is much
bigger than any Titanic

(Taken from the Net)

Last thing you want is something
like this happening to a Logitech
Cordless Mouseman Wheel.
(Taken from the Net)

Can’t stop talking
about the charm of
the good ol’ days?

This one’s for the old
timers

(Taken from the Net)

If you thought The Blair Witch Project was scary, then
check this out. The plot is about the Bill Witch placing a
hex on three Linux programmers. This will be one loud
Linux crash. 
(Taken from: www.computerpranks.com)

Somebody’s machine! Not 
Dimebag Darrell’s
Contributed by Sriram

Hunk of a PCStaying afloat

Future Plot

A classic piece

Tabby’s new diet
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